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Chapter 1. Getting Started 

Welcome 

Welcome to Easy-PC, the Windows generation of the original award winning EASY-PC that 
was launched in 1988. At that time the product was revolutionary in its affordability and 
usability and many tens of thousands of licences have been sold to customers in over 100 
countries world-wide. 

All features provided make the task of designing Schematics and printed circuit boards 
(PCBs) easier than ever before. Transparent links to Spice simulators and PCB autorouters 
provide an integrated solution. Web-based library content is instantly available for simply 
dropping into your designs. 

The use of Technology Files, the equivalent of Style Sheets in a word processor, greatly 
reduce the set-up time for new projects and enable companies to standardise their operating 
procedures and design rules according to the type of product being designed or the 
manufacturing technology being used. Technology files also include company standard net 
names and the track widths and clearance rules to be applied to those nets. This will ensure 
that proven standards can be maintained over a range of similar products with the minimum 
of effort. 

In addition to this, all the expected professional output and manufacturing features are 
provided, including Photo plotting outputs to Gerber and Excellon NC drill, ODB++,  
IPC-2582, Windows printers, PDF and pen plotters. Mechanical CAD programs are supported 
using the DXF and IDF formats. Additional reports for assembly machine drivers are 
provided as part of the standard product to further aid productivity.  

About this Manual 

This manual has been created to guide you through a reasonable ‘normal’ design flow. 
Obviously, what might be normal for one person is not normal for another. Don’t be alarmed 
if you find that you have not used some of the options featured, you can skip a section without 
it being detrimental to the end result! 

The manual doesn’t take you through every small detail of the product but will guide you 
through the essentials to produce a design. It is directed at users who understand the 
fundamentals of designing PCBs, it is not intended as a course in designing PCBs. 
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Chapter 2. Installation 

Hardware Requirements 

The table below shows the hardware requirements. It shows both the minimum and the 
recommended specification. It should be said that this product will run pretty much on any 
off-the-shelf PC available in most computer stores.  

 Recommendation 

Processor i5 processor or better, such as i7 or i9 

RAM 4GB or more 

Hard disk space 1GB for product and all optional Libraries 

Operating System Windows 10 or 11 

Graphics Better than 1024x768 

Mouse Wheel Mouse 

* MAC O/S or Linux are not supported. All supported operating systems are supported in 
both 32 and 64-bit formats. Please visit our web site for the latest news on supported 
operating systems www.numberone.com/lifecycle.asp 

Installing the Product 

Regardless of whether you are installing a new system or updating your existing system, the 
procedure is the same. The setup program will automate as much of the process as it can for 
you with minimal input. 

You would have received your installation via as a download link that enables you to access 
product from our web site. Click on the link and download the self-extracting executable 
program. This is not a ghost installer; this is the whole program in one file. In the event that 
you require a backup copy of the installer, save this executable to a location on your system 
that gets backed up. It can then be recalled and used in future. It will be the current ‘base’ 
version at the time of download. To bring it up to date in the future, you would also need to 
apply any services patches that you would have also downloaded over the life time of this 
version. These should also be downloaded and saved in a backup location. 

Installation 

Double-click on the install program to run it. 

Follow the instructions on screen, you must accept the licensing terms and conditions in order 
to continue. 

You will be asked for your customer number, this would have been identified to you in the 
email with the download link. 

You will be asked for your Name and Company Name. If you don’t have a company, just 
type your name again. 

For each major version of the product, you would also need to have your 16-digit installation 
serial number to hand. This would have been provided to you when the product was 
purchased. This can be copied and pasted into the entry box or typed in. Care should be taken 
when typing in the Serial number sequence, as this causes many unnecessary support calls, 
especially regarding the I and 1, 0 and o keys!! Make sure you use the correct code for the 
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product that you are installing (another cause for support calls!). It is better to copy/paste if 
you can to save typing errors. Do not pass this number to anyone else, it does identify you and 
is traceable back to you. 

You will need to identify the installation location and documentation location. If unsure, 
the program will provide you with default entries. 

The Next button on each page will move you through each screen until you can finalise the 
installation. Once the install process has been completed an 'Installation Complete' message 
appears, the finish screen will allow you to press the Finish button to exit. The product is now 
ready to run. 

Moving Your Installation 

Your product can be installed onto any logical drive that is part of your computers’ 
environment. If you decide to relocate the installation once an initial install has been made, 
you may do this but you cannot simply move it. The product must be reinstalled using the 
downloaded executable file using the new location. As predefined Registry settings are used 
to set up many of the functions and to store data; the only way to restore these settings is to 
reinstall the product using the installer program. 

Updating Your Menus 

For existing users where the latest version of the software is installed along side the old 
version, the installer is designed to make minimal disruptions to the existing installation. It is 
assumed that you have created the menu and toolbar set required so this is not changed. 

To reset the menus and toolbars to the new set, go to the Settings menu and Customise. Use 
Reset on the Menu tab for the relevant menu type. 

Installing Cost Options 

Cost options are available to increase the capabilities of the product. Our web site also 
contains information about cost options.  

Some cost options are automatically installed during the installation of the main product. All 
cost option products except the Pro-Library, Micro Library, Connector Library and IPC 
SM Library options are installed. These libraries are installed using their own separate 
downloaded installations. 

Each of the cost options will require an additional serial number supplied when purchased - 
Trace-Router, Pro-Router, GenCAD Export etc. These cost options are preinstalled and 
must be activated for use. 

The main product must be installed and already running. Cost options are initialised through 
the Settings menu, Optional Features dialog. Each of the features can be selected for 
authorisation but the process of applying the code will be requested for each of the options 
required. The product serial number is supplied on the License Authorisation page or by 
email and are used for activation. 
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Select the relevant option from the list (you must have purchased this option first and been 
given the serial number to install it with). Click the Apply button. Type in the serial number 
provided to you (copy this carefully from the license page or copy/paste from the email). 

 

 With the correct serial number entered, a message will verify that the code number has been 
successful, click OK to accept it. 

You can license more than one option in this session, license each option required. 

You must restart the product to activate the options. Each cost option authorised is now 
available to run and will be indicated by the 'tick' in the product check box next to the product 
in the Optional Features list. 

Installing Cost Option Libraries 

Unlike other cost options, the Pro-Library, Micro Library, Connector Library and  

IPC SM Library are installed from separate install programs supplied to you as download 
links at the time of purchase. 

On double-click of the downloaded install executable, the installer will check and verify an 
existing library, once found, it will offer this folder to install the optional libraries into. Once 
installed, the library will be immediately ready for use.  

Running The Program 

The program can be started using a button on the Start menu under Programs and Number 

One Systems. When selected, this will start Easy-PC in its default location. This mechanism 
is perfectly adequate, but for more frequent users who wish to run the program from their own 
location, a more convenient way of running the program is via a desktop shortcut that has 
been setup for you to include a suitable working folder. 
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Chapter 3. Concept of Operation 

Introduction 

Please note that this chapter contains important information relating to the concepts behind 

this program. It is highly recommended that all first time users read this chapter first. 

This program has been designed to provide an integrated design environment for as many 
aspects of the design cycle as possible. Tools to assist this aim include project files, which co-
ordinate all aspects of the design; Technology files, which standardise design parameters; and 
libraries, which provide easily managed component resources. 

 

Creating Designs 

The design process usually involves the creation of the initial Schematic design (although it 
doesn’t have to be, you can create your design directly into the PCB design editor itself if you 
wish), the transfer of the schematic into the PCB design editor, and the layout of the PCB.  

During this process you may need to create library items, modify existing ones or download 
available libraries off the internet. 

A Glossary of Terms is available at the back of this manual to help you with electronics 
design terminology. 

Creating designs – the ‘basics’ 

As a very basic guide, this short section will help you understand the way some of the options 
are used. 
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‘True’ connectivity in Schematics are automatically transferred to the PCB design editor, this 
in-turn is transferred right through to a final plot or print thus retaining the original concept 
but in a physical layout. 

The first of these concerns the ability to maintain the connectivity of your circuit when you 
move from drawing its Schematic diagram to laying out its Printed Circuit Board (PCB). This 
facility ensures that, when you start to layout the PCB, the connections on your board are the 
same as those in the circuit diagram. Obviously, as you work on the board layout, you have 
the power to alter the connections, for example, by adding or deleting tracks. An ‘update’ 
facility is included to make sure that the Schematic and PCB stay in-step electrically at all 
times. This where the program extracts the connection information from the PCB layout and 
compares it with similar information extracted from the Schematic. A full report warns you of 
any discrepancies between the two and will automatically update your PCB to bring them in 
line. 

In the PCB design, the DRC (Design Rules Check) facility ensures that you have not violated 
the spacing rules defined, where tracks are crossed or they have been routed too close to other 
objects on the board for example. These methods of checking allow you to decide whether to 
make alterations to your circuit either on the Schematic or the PCB, and still ensure that the 
two parts of your design contain the same connective information. 

Projects (Overview) 

Projects can be optionally used to collate and present your design and associated files. You 
can decide to use them from the start, add them part way through a design or not use them at 
all. 

Projects are used to tie single or multiple Schematic sheets with a PCB design. Each sheet of a 
Schematic is effectively a single design file. Projects can also contain blocks of hierarchical 
circuitry within a design, they can also contain associated files, such as BOMS, reports etc. 

The use of a Project will enable net names and Component names to be tracked through each 
sheet so that duplicates are not produced. The Project file is also a neat way of grouping 
related design information in one file.  

 

Schematic Files 

Schematic files have the extension '.sch'. They represent the interconnections of the circuit in 
a logical way so that its operation becomes clear. The symbols used to represent components 
are highly stylised, rarely bearing any physical resemblance to the actual device. Single lines 
join these symbols, with the logical flow of information normally being from left to right. 
These signal lines may be named, and where several run together, they may be represented by 
a much thicker line known as a Bus. 

A Schematic may be broken into several sheets for clarity, with signals crossing between 
sheets. The schematic editor allows multiple sheets, which will translate to a common PCB, to 



 Concept of Operation   17 

co-exist in one working area. It is customary for each sheet to be surrounded by a drawing 
frame (or drawing blank or drawing border). This contains information such as the project 
name, design title, author, date, revision, and sheet number. If several Schematics are saved 
together as a project, they will merge together providing the Translate to PCB is performed 
within the project environment. 

A copy of every style used, and every component used is saved in the file. Any component 
already in the file will be used in preference to importing a new definition from a library. 

PCB Files 

PCB or layout files as they are sometimes known, have the extension '.pcb'. They represent 
the physical layout of the interconnections between components. Generally, a standard view 
of the board is taken from the top side. The actual component footprints are used with 
associated silkscreen legends to aid placement. A copy of every style used, and every 
component used is saved in the file. When a component is requested, a check box gives you 
the option of choosing from the design, or browsing the current library. If a definition already 
exists in the file, you will be asked if you wish to update the existing component from the 
library. 

Libraries 

The library structure must combine the necessary information for both Schematic and PCB 
use tied in together with a Component. Each component normally combines at least two 
symbols; for the Schematic, and for the PCB. As extra package types are added, the number 
of PCB symbols increases correspondingly. 

 

To support this structure, the symbols (which form the actual graphics seen in the design) are 
separate from the components (which are stored in a database handling labels, names etc., and 
specifies how the symbols should link). Every component is aware of each symbol it requires 
both by symbol name.  
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PCB Manufacturing Files for Plotting 

Plotting files for manufacturing are created using the Plotting and Printing mechanism. 
These consist or files exported to industry standard formats such as Gerber and Excellon but 
also include ODB++. Additional plotting and printing formats such as Windows and PDF are 
also exported so that all media requirements can be supported. 

Job Files for Plotting 

Job files can be created for use with the plotting mechanism. They provide you with a method 
of creating a set of plot options to plot your designs for manufacturing. These settings are 
stored in one Job file and can be loaded and applied to any design.  

Panel Files for Plotting 

Individual or multiple PCB designs can be added to a panel in the Panel Editor to create a 
single plot of different designs (or panelised designs of the same type). These panels can be 
saved to a file for reuse.  

 

Technology Files 

A technology file contains much the same information as other design files, with the 
exclusion of the actual design itself. It may perhaps best be viewed as a template, as standard 
design elements such as a Schematic drawing frame or board outline may also be included. 
One of the easiest ways of creating a technology file is to save a Schematic or PCB file as a 
technology file. The necessary information is automatically extracted. 

The styles saved within the files are discussed in detail in the menu reference section under 
Settings, Technology Files. It is sufficient to note here that styles may be copied between 
technology files and the currently loaded design. 
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Chapter 4. Using The Interface 

Overview 

You are provided with an intuitive user interface that can be used to produce designs and 
multi-layer PCBs. The user interface means it is easy to learn and pick-up even when it hasn’t 
been used for some time. Likewise, for the professional user, there are many shortcuts and 
context menus to assist and speed up the design process. 

As with most Windows programs, the functions in this product can usually be accessed in 
many different ways - through the main menu, toolbars, context menus and direct shortcut 
keys. In this guide only one method is usually mentioned. 

The User Interface 

The interface uses standard Windows features and shortcuts wherever possible. This makes 
the learning curve for infrequent users and regular users alike as easy as possible, there is an 
immediate familiar feel with it. This standard will make you feel at ease with the layout and 
controls of this design environment within no time at all.   

 

During its use, you are presented with terminology and commands that are as close to the 
Windows standard but with a PCB ‘flavour’. The image above highlights some of the major 
framework features. Each of the features will be discussed in the following chapters. 
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Menus 

The majority of the program is accessed through menus, toolbar buttons or context menus.  
Most of the features have been located on the menus in the approximate order that they would 
be used during the design process moving from left to right across the menu bar. For example, 
Open is on the File menu (as it would be for any Windows product) and the Undo option is 
on the Edit menu. 

 

Least-used menus 

You can hide the least-used options on the menus to simplify them. Items hidden can be 
revealed by selecting the small double-down arrows on the menus. 

 

If you wish to have the full menus, the switch for this option is available under Personalised 

Menus and Toolbars from the Settings menu, Customise and Options page. 
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The Online Help System 

Help is supplied in the form of a HTML-based online help system. This provides detail about 
the options within the product.  

 

Context sensitive help is available from all dialogs in the design by pressing the <F1> key on 
the keyboard, (you can redefine all the keys on the keyboard but it is recommended that you 
keep F1 as Help). 

The Index tab has a list of all topics available from which you can select the option required. 
The Search tab allows you to locate items in the help system by typing in the word required. 
Word strings can be found by using double quotes, for example “Add Component”. 

Status Bar 

The status bar at the bottom of the display gives you information about the current items 
selected, any prompts for input or messages and information about the cursor position. 

 

As the cursor moves around the active drawing area (within the square border), the co-
ordinate display at the bottom of the window changes. If you move the cursor from one side 
of the border to the opposite, you will see the co-ordinates go from 0.000 to approximately 
39.000 (with Imperial units and 3 decimal points set). This represents the largest board that 
can be handled, 39 inches square or the metric equivalent. The status bar will also show you 
the units (thou in the example below). Changing between Imperial and Metric units is 
covered later.  
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The status bar shows more than just the X, Y coordinates, it provides instant information 
about any selected item(s). This information is the most commonly required during use, more 
detailed information is also available if the item is selected and the Properties option selected 
using the context menu accessed from the right mouse button. 

During editing of items, the status bar is important. It continuously shows you information 
about the items you are editing and prompts you for action. If the operation fails, it will give 
you information as to why this has happened. 

The status bar is also active. You can double-click on fields within it to reveal additional 
information. For example, double-clicking on the Abs field will change it to Rel (Relative). 
Likewise, double-clicking on a Line or Pad style will display the styles dialog for that item. 

The status bar can be switched on and off from the View menu. You may switch it off to gain 
you valuable design space on your screen. 

Opening Multiple Documents 

You can operate in a number of different design modes and use the modes at the same time, 
depending on whether you are working on a PCB layout, a Schematic circuit diagram, a 
Project, a Technology file, or on a Component or Symbol. 

Windows menu 

These modes are controlled from the Windows menu and by using the Workbook tabs.  

 

Workbook Mode 

Using the workbook mode, you can switch between applications by simply selecting the tab 
required. The mode can be switched off using the View menu to maximise the design area. 
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Customising the User Interface 

Toolbars 

The toolbar is divided into ‘palettes’ of commonly used tools.  The toolbars can be moved and 
customised as you require. The example below shows the default set of toolbars in the docked 
position. 

 

As you move your cursor over each button, if you pause momentarily, a small label will 
appear. This is called a tooltip and will provide you with the function of each button when 
selected. 

 

Each of the toolbars can be individually switched on or off and can be docked against the 
furniture or left floating in ‘space’. 

In docked mode, a toolbar is fixed along any of the four borders of the main window 
framework in either a horizontal or vertical position and will have a Gripper bar across the 
top or down the left. You cannot modify the size of a toolbar when it is docked.  

 

The toolbar can be moved by selecting the window border and 'dragging' it away from its 
current location (by dragging the small dots on the left side of the toolbar). When dragging, it 
becomes detached from the framework. When the toolbar is then moved over another area of 
the framework to which it can be attached, it changes shape to indicate it can be docked there. 
You can also make it floating by double-clicking on the window gripper bar or in the toolbar 
area itself, but avoiding the buttons that will select an option. 

The toolbars can also be floating. This is a toolbar that has been moved into free space on the 
design and outside the framework. This toolbar can now be reshaped to make it fatter or 
thinner by dragging the outer edge in or out. The toolbar can be shaped to be one tool wide or 
long by as many tools as are loaded on the toolbar in the opposite direction. By selecting the 
outer framework edges of the toolbar, a small arrow 'handle' will appear to indicate that the 
toolbar can now be reshaped. Drag the handle until you have the shape you require. 

 

You can restore the toolbar to its last docked position by double-clicking on the name caption 
on the toolbar, in the example above, this would be the word Edit. 
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To move a floating toolbar, select and drag any part of the toolbar framework. The toolbar 
will move dynamically with the mouse movement. Release the mouse button to release the 
toolbar. 

Customising Toolbars 

Toolbars can be customised to contain the buttons (and underlying options) of your choice. 
You are provided with a default set of toolbars that cover different design types and some 
designs tasks, such as editing etc.  

You can create toolbars for any task that appears on the menu or context menus. 

To edit or create your own toolbars you must use the Customise option on the Settings menu. 
Once in this dialog you can move tools on existing toolbars or add/create your own. Other 
than in this dialog, you cannot add or remove tools from toolbars. Buttons can be moved by 
pressing the <Alt> key and dragging the button from one toolbar to another. This technique 
can also be used to remove the button from the toolbar. Press the <Alt> key and drag the 
button into free space away from a toolbar. 

 

Commands and Shortcut Keys 

As well as the toolbars, you have the ability to program your keyboard for commonly used 
options or commands. This means that once programmed, you can press a key or key 
combination to enter a function. For experienced users, this makes the program's operation far 
more efficient (and quicker).  

When the program is first installed, you will find a set of shortcuts already defined for you. 
This is only a default set and can be modified to your own preference through the Customise 
dialog. Almost all of the keys on a standard keyboard can be utilised giving you extensive 
coverage of shortcuts. 

���� To define shortcuts 

1. From the Settings menu, select Customise 

2. Select the Keyboard tab. 
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3. Each of the currently assigned shortcuts are displayed when the command of the same 
name is selected. You may assign more than one shortcut to a command if required. 

4. Select the Command that you wish to create a shortcut key for. The Category selection 
will help you choose the command. These are categorised by menu option with an <All 
Commands> option also available. 

5. Click the shortcut key(s) that you wish to use. 

6. The dialog will display any command that already uses this by name and the shortcut 
will be displayed in the Press New Shortcut Key box. 

7. Click the Assign button to assign it. 

8. Click Close to exit this dialog. 

For a report of all shortcut keys defined, run the Shortcut Keys Report from the Settings 
menu, Customise and Shortcut Keys Report. The dialog will allow you to choose the 
sorting order and the shortcuts to report.  

 

Rulers 

You can choose to have vertical and horizontal rulers displayed along the left and top margins 
of the design window. Rulers can be useful for sizing or aligning design items in terms of 
physical units such as millimetres, inches or thou.  
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Rule Stop settings 

The ruler lines and snapping to the ruler lines is controlled through the Ruler Stops Settings 
dialog. To display the Ruler settings dialog, select Rulers from the View menu, or right click 
on a ruler bar to use Ruler Settings from the shortcut menu, or alternatively, you can use a 
defined shortcut key or toolbar button. 

You can right click on the ruler bars and use a context menu to access the dialogs and also to 
perform some other operations on ruler stops.  

 

• Use Delete All Ruler Stops to quickly remove all the stop positions from both axis.  

• Use Snap To Ruler Stops to toggle interactive snapping of design items to stop 
positions.  

• Use Add Ruler Stops at Selection Origin to add a horizontal and vertical stop position 
at the origin of the selected items. This command is available to put on a shortcut key, 
and is useful for displaying a line through particular items to use to line up other items.  

If a ruler stop existed at the point that you right clicked on the ruler bar and one or more items 
of the same type are selected in the design, two Align To Ruler Stop options will be 
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available. These allow you to align either the lower or upper side of each selected item to the 
picked ruler stop position.  

If a ruler stop existed at the point that you right clicked on the ruler bar the Edit Ruler Stop 
and Delete Ruler Stop will be available to allow you to change the value of, or delete, the 
picked ruler stop. If no ruler stop was underneath the picked position, the Add Ruler Stop 
option is available. Use this to add a new stop at the position picked on the bar.  

A new ruler stop can also be added by double-clicking on the ruler bar.  

You can reposition a ruler stop by dragging it along the ruler by pressing and holding the left 
mouse button, release the button at the new location.  

Dockable Windows 

There are a number of dockable windows available for use. These will speed up your design 
work and provide you with convenient access to features: Component Bin, Add Component 
bar, Layers bar, Colour Files bar, World View and Goto bar. Each of these may be 
displayed, hidden, docked, floated, auto-hidden (so they can ‘slide’) or combined together in a 
tabbed bar.     

To view any of these menus, either select Dockable Bars > from the View menu or right 
click on the menu bar or the framework to access the shortcut menu. 

 

When docked, these bars can automatically hide when they go out of context and re-display 
when they come back into context. They come into context by hovering the mouse over the 
relevant option tab. 
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The three small icons (shown circled) on the top of the sliding bar indicate additional 
functionality. Moving left to right; these reveal the context menu, a pin to enable the dialog to 
be sliding to conceal it or docked to be permanently displayed. A cross indicates the Close 
option to dismiss the dialog altogether. 

Component Bin 

The Component Bin itself consists of the Component Bin Preview (showing both 
Schematic and PCB symbols) and the Component Bin. The component bin is provided to 
store and view unplaced components in the PCB design editor, and unused gates in the 
Schematic design editor. 

 

The Component Bin Preview window shows the component currently selected in the bin, 
along with its pad numbers and names. This updates automatically as each component within 
the bin is selected.  

 

The Component Bin window lists the components currently in the bin by Component Name. 
This shows the component name and component type and is sorted alphabetically on the 
component name. For a Schematic design and for multi-gated components, the gate name and 
symbol name are listed for each gate of the component. The components (or gates) are 
selected by clicking in this list.  
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To use the component bin, select and drag the component required into the design. You will 
see the component on the end of your cursor in the design ready for placement. 

Add Component Bar 

The Add Component dockable bar is effectively an ‘always-accessible’ modeless dialog for 
adding components. This is available for a Schematic or PCB design.  

 

It allows a component to be 
‘dragged’ from the selected library 
directly into the current design view. 
Alternatively, double-clicking 
activates the normal ‘button-up’ add 
component mode and allows multiple 
instances of the component to be 
added. The component package name 
is also displayed allowing an 
alternative package to be chosen. 

This window is more basic than the 
Add Component dialog as there is 
no name filtering or Find option. 
However, because this uses the 
sliding bar, then it is accessible very 
quickly. 

 

Colour Files Bar 

The Colour Files bar will display a list of previously saved colour files in the colour files 
folder. The folder is predefined and named in the Preferences dialog on the Settings menu. 
Clicking on any of the files by name from the list will load that file and change the current 
display.   
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A basic selection of colours files is installed by default but the list can be added to and 
modified to your own requirements. Colour files are defined and saved from the Colours 
dialog. 

Goto Bar 

Different design items can be located by using the Goto Bar. You can go to Components and 
Nets in both the Schematic and PCB design editors, as well as Errors in the PCB design 
editor. Additional Goto options include Goto Pad/Line/Track, Text and Text Styles. The 
Goto X,Y, Relative Origin, Selection Origin, System Origin and Previous/Next Error 
options are available from the View menu.   

 

The Goto Error selection will show all the design rule errors in the design once the online 
DRC or batch Design Rules Checking options have been run. Clicking on any of the errors 
will ‘pan’ the display to the selected error. Errors can be sorted by Type of error and Layer of 
the error using the context menu in the window.  
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Design – Lists the names of all open designs, projects and library items. Also lists all 
schematic and PCB designs in a project even if they are not open.  

Select an entry from the list to switch to that design.  

 

Goto Filter 

You can filter found items in the list by using the filter on the Goto dialog. 

Check the Use Filter box to activate the filter. A dialog will be displayed into which you can 
type the name you wish to find. You can use standard wildcards (* and ?) in this field. 
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Layers Bar 

The Layers Bar is used for switching named layers on and off. This is only available from 
within the PCB design editor and PCB symbol editor. This will list all the layers in the design 
(created in the Layers dialog on the Settings menu). 

 

Each layer is shown with a check box. Clicking the check box toggles that layer’s visibility on 
or off. A single click on the layer name highlights that layer in the list, whereas double-click 
will make just that layer visible and all other layers invisible. There are also context menu 
entries available to switch All Layers On and All Layers Off. 

Defining Current Electrical and Documentation Layers 

The colour squares next to the layer name have a black square outline to denote both the 
default electrical and documentation layers. Left click on the square to set that layer as the 
default. The black ring will appear next to that layer to indicate this. If there is no common 
default (i.e. all categories do not have their default set to the same layer) the black square is 
not drawn. 

 

When starting a new track or adding a new doc shape, the default layer will be used. 
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Showing and Hiding Powerplane Layers 

On the Layers Bar, power plane layers are indicated by a small thermal pad icon to the right 
of the coloured square. Powerplane layers are defined in the Technology file under Layers. 
These are layers that have a Layer Bias as Power Plane. 

 

If the power plane is being displayed in the design the icon is in negative. Left click on the 
icon to toggle the display to show/hide the power plane. 

 

Note, this option is a quick way to access the View Powerplane functionality. View 
Powerplane is still available from the View menu. 

Categories 

Within the Layers bar, you also have the details pane showing additional design categories. 
This is revealed using the More>> button. It can be closed using the <<Hide button. This 
allows you to Show items in the design as well as making them Pickable or not. 

 

World View 

The World View provides you with a view of the whole design and working area. 

For fast zoom and unzoom, the frame option can be used inside the World View window. To 
use this simply click and drag in the World View (like a Frame Select). The area drawn will 
define the zoom region. The design will automatically redraw at this size.  
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Shape Information Bar 

The Shape Information Bar is available as a dockable bar to allow viewing and editing of the 
currently selected shape in your design. Shape coordinates, offsets and lengths can be edited 
for easy shape creation.  

 

If the selected shape is edited interactively, the Shape bar will dynamically update to reflect 
the changing co-ordinate information for the shape being modified. 

The Rel check box allows you to display the coordinates in either Absolute or Relative units. 

When the Auto option is checked, this will cause the Shape bar to automatically switch to the 
most appropriate mode to display a selected shape, i.e. if a circle is selected it will be 
displayed in Circle mode. Polygon shapes will be shown in the most recently used of the 
possible modes. 

The Closed option will be automatically set to indicate whether the selected shape is Closed 
(unchecked means the shape is Open). The check box allows the state of the shape to be 
toggled between the two states.  

More information about the Shape Information Bar is available in the online help. 

Design Notes Bar 

PCB and Schematic designs can contain Notes organised within subject categories. Use notes 
to jot down questions, ideas, reminders, and anything you would write on paper. For example, 
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to document the designs progress, highlight problem areas, document any design constraints, 
serve as reminders of how to do things, highlight where a workaround has been applied, and 
many more reasons.   

Notes can be synchronised between a schematic and its corresponding PCB design and so can 
be used to pass instructions from the schematic engineer about things to consider when laying 
out the PCB. Also notes about problems can be back annotated to the schematic from the PCB 
design.  

 

Unlike free text and callouts, notes cannot be displayed in the design, but can have associated 
markers placed in the design to show their area of interest.  

There is a dockable Notes Bar containing a browser listing all the notes in the current design, 
sorted and filtered in various ways, and an edit window that can be used to view, edit and 
print the contents of each note.  

What is a Note 

A note contains a single line subject or title, and a multi-line text message. Each character in 
the text message can have its own colour, size and text font. The text message can be created 
in a text editor window by directly typing the text, or by pasting unformatted or Rich Text 
Format (RTF) text from another application. Each note is saved in the design it was created 
in.  

All notes belong to named note categories to help you organise and manage them. As well as 
a name, these categories contain information about the note markers. Each note can optionally 
have an associated marker placed in the design. By default, the marker appears as a yellow 
square. You can change the appearance of note markers, including the symbol, colour and 
size, by editing the note category. 

Additional help on adding and using Design Notes is available in the online Help. 

Properties Bar 

The dockable Properties bar allows you to see the properties of an item or multiple items 
using a modeless window. Many of the features available to you from within the Properties 
dialog are available in this dockable option, helping you to view and edit values for items 
without accessing a different dialog. Note that not all the properties are available in the 
Properties bar. It is purely a faster, more convenient mechanism for accessing Properties on 
the fly.  

The dockable Properties bar also provides the ability to show only the properties common to 
all the items in the selection. 
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To enable the Properties Bar, click on the View menu, Dockable Bars, and click Properties 

Bar. Alternatively, right click on the right-hand bar and select Properties as shown in the 
illustration to the right. 

Because this is a floating bar, it can be undocked once selected for use. 

Viewing the Design 

Mouse Operation 

The mouse can be used for many operations, not only for menu and option selection but also 
for interaction within the design. A single left button click can be for selection. Once selected, 
an additional operation can be performed on that item. By selecting an item (with the left 
button) and then right clicking, you can get access to the context menus. You can actually just 
use a right click on an item to get to the context menu, this has the same effect as left click 
then right click. 

Functionality is also available through the use of the mouse wheel button. The wheel can be 
used in two ways, by rolling it backwards (and forwards), and by clicking it. 

By rolling it forwards you can activate a zoom out on the design, the same as using the <U> 
key on the keyboard. 

By rolling it backwards you can activate a zoom in on the design, the same as using the <Z> 
key on the keyboard. 

By using a single click of the wheel, you can pan to the current cursor position. If you keep 
the wheel mouse pressed down and moving the cursor, a dynamic pan will be obtained. This 
has the same effect as using the <P> key on the keyboard. 

All the Zoom commands are available on the View menu although you will find that you will 
use the mouse wheel or remember the keyboard commands more frequently.  

As an alternative, you also have commands for Zoom In/Out At Centre. Instead of zooming 
in and recentring the selected zoomed item, the window will remain in its current position and 
zoom the item out. 
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Numeric Keys to Zoom In and Out 

The numeric keys <1> to <9> and <0> along the top of the keyboard will give you predefined 
zoom levels. These keys change the zoom level immediately to correspond with the key 
pressed. For example, at zoom level 8, you will see the entire drawing area; at zoom level 1 
the screen corresponds to an area of the drawing about half an inch (~15mm) across but will 
depend on another factor, the size of the defined working area.   

Frame View 

A Frame option is also provided to selectively zoom around the design into specific areas, the 
shortcut key for this is <Ctrl-F>. Click and drag a box around items within the design, it will 
then fill the screen with the selection.  

A note to mention here is that quite often you will drag a box on the design and get a selection 

but no zoom, this will be because you have not selected the Frame function first. 

Frame can also be used in the World View by simply drawing a box in the World View 
window. You don’t need to be in Frame ‘mode’ to do this. 

Viewing all of the design 

At any time, you can press the <A> key to zoom to show all of the design. The 'design' means 
anything on the screen within the design area, e.g. board outline and/or drawing blank (if 
used), or the extremities of any entity regardless of where it is in the design area.  

The View All option is also available on the View toolbar and the View menu. 

 

Pan 

You can use the zoom options to move around the design by successively zooming out and 
then zooming in on different areas. A Pan option is also provided to navigate your way 
around a design without having to zoom in and out. This can be done using the <P> key on 
the keyboard (this assumes you haven't yet switched on the Autopan feature which is 
discussed below). You will see that the screen pans to the previous position of your cursor.  

By keeping the <P> key pressed down and moving the cursor, you can achieve a dynamic pan 
on the design. 

By pressing the middle mouse wheel button on the mouse, you can also do a Pan. Keeping the 
wheel mouse pressed will enable you to move the mouse and dynamically pan around the 
design. 

Pan can also be used in the World View. With the cursor in the World View press the <P> 
key on the keyboard, the design will pan in the direction at each key press. 

As well as the Pan option, you can also use the scroll bars on the window to move from side 
to side or top to bottom.  
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Auto Pan 

A smooth Auto Pan option is also provided. This operates when you move the cursor to 
within approx. 1/4 inch (0.7 cm) of the current design window edge (this value is approximate 
for a full screen design on a 15" monitor). The design pans until the cursor is moved outside 
the panning tolerance. Panning works with and without design items selected ensuring an 
optimum user defined view of the design at all times.  

The switch enabling the Auto Pan control is selected through the Preferences dialog, 
Display tab on the Settings menu. 

 

The delay before the pan is started can be also 
controlled on this dialog using the Delay Before 

Starting slider. Moving the slider to the right 
makes the autopan work sooner, whereas moving it 
to the left makes it less sensitive that means you 
have to leave it at the edge longer before it pans. 

The Default Delay button setting will apply a 
built-in setting that will be a compromise between 
being usable and speed of operation.  

Design Item Selection 

Standard Selection Operations 

There are a number of ways that items can be selected in your design and libraries.  

• Single select 

• <Ctrl> select (modify selection) 

• <Shift> select (extended selection) 

• <Ctrl-Shift> select 

 

The diagram above shows how using the different combinations will allow you to select the 
entities of the design item. 
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Single select 

A single click of the left mouse button will make a single selection of any item. By selecting 
another item, the first item will be deselected. Once an item is selected, you can add to that 
selection or remove the item from the selection (see the <Ctrl> and <Shift> selection sections 
below).  

Control (Ctrl) select 

Using the <Ctrl> key while clicking the mouse button will enable you to modify the 
selection. In other words, if you already have an item selected, you can add another item to 
the selection. It also allows you to remove items from a selection. This is a very useful option 
for making a selection of multiple items in the design.  

Shift select 

Using the <Shift> key while clicking the mouse button will extend the selection to the whole 
item. This could be used for selecting a complete track path between two pads on the same net 
for example. If the Shift-Select operation was executed twice on the same track, it would 
select and extend the selection to the first track path, then extend it further to include the 
whole net outside of the point-to-point connection path.  

You can also use <Shift-Select> to select a whole shape, a copper shape for example. 

Ctrl Shift select 

By using the <Ctrl-Shift-Select> keys together you can extend the selection to the whole 
entity but then use this combination again to add to the selection. For example, for selecting a 
whole track path but then adding another whole track path to the selection of a different net.  

Other Selection Mechanisms 

There are also other modes of operation that can be accessed using the mouse: Double-click 
editing and Frame select. 

Double-click editing 

By using a Double-click of the mouse on an item, such as a connection in PCB, you will 
automatically be entered into Edit mode. This means that the connection is converted to a 
copper track and you can ‘draw’ in its electrical path using corners and changing layers.  

Frame Select 

By dragging a box when in free space, if any items are enclosed within that area, they will 
become selected. This is called a Frame-select. Any item inside this selection will be drawn 
in the Selection: colour taken from the Colours dialog. 

This type of selection is of use for making a selection of a group of items that could then be 
moved for example. You may also use this selection to delete sections of the design. 

To deselect the selection, click the mouse in free space on the design or right click and choose 
Deselect from the context menu.  

Polygon Select 

From the context menu, you can choose the Polygon Select mode. In this mode you define a 
polygon by clicking at its corners. Use backspace to delete a corner and double-click to 
finish. Any item crossing the polygon will be selected.  
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You can also use this mode as a single line for selection by dragging the cursor. This is useful 
for selecting angled tracks for example. This option ignores the Select If Completely 

Framed setting. 

To do this, enter the Polygon Select mode, drag a line (not a polygon) across items you wish 
to select: 

 

The items under the line are then selected once the cursor is released. 

 

Like Frame Select, Shift key down means select whole items, and if the Ctrl key is down 
nothing is deselected before selecting the items with the shape. 

Controlling the Selection 

Cyclic Picking 

Having selected a design item, it is possible to select the next nearest item within picking 
distance. This may be done either by using the Select Next option on the context menu, or by 
pressing the shortcut key <N>. Repeating Select Next will cycle through all items that are 
within close proximity. Once the required item is selected you can then execute another 
command on it.  

This is especially useful for selecting design items in a dense area. You can also use this 
effectively when the display of particular items is set to be non-selectable. 



 Using The Interface   41 

Colour selection flags 

As well as the ability to select Next and Previous using the cyclic selection mechanism you 
can also make design items selectable and non-selectable from within the Colours dialog.  

 

Within the Layered Items dialog, you can make an item not selectable by unchecking the 
Selectable check box. With this box unchecked, if you try to select that type of item, it will 
not be selected. Likewise, if you make a frame selection and the selection contains this item, 
again it will not be selected. 

 

On the Settings & Highlights dialog you can also make non-layered items non-selectable by 
using the tri-state check boxes. The tri-states are unchecked (Not Visible but Selectable), 
checked (Visible and Selectable) and checked/greyed (Visible but not Selectable), these are 
shown on this dialog under Key. 
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Selecting from a list 

As an alternative to using the <N> key to cycle through the picking list, if you press the <Alt> 
key while selecting the required item, anything within the picking tolerance will be displayed 
on a small context menu. From this list pick the required item and it will be selected.  

 

User Defined Preferences 

There are many aspects that can be tailored to suit your own needs. These options are defined 
in the Preferences dialog on the Settings menu.  

 

Each tab on the dialog contains logical groups of functionality for different purposes. The 
General tab (shown above) is used to set general system information for example. 

More complete detail for each of the options on these tabs is discussed during their use 
throughout this manual. 

There is also a Design Options option on the Settings menu.  
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This has one option on it for setting an automatic text adjustment during text rotation so that it 
is readable from the bottom or right-hand side of a page. 

Properties Dialog 

Additional information can be obtained for any item using the item Properties option.  You 
can get to the item Properties by selecting the item and using the shortcut key <Alt-Enter>, 
or selecting it from the context menu.  

 

The Properties dialog shown above is an example for a Component in the Schematic design 
editor, it shows more detailed information about its Position, Angle and Component etc. 

Much of the information within Properties can also be edited, a components’ physical 
Position or Angle for example. 

Multi-item Properties 

The Properties dialog can be used for changing multiple selected items, components for 
example. When two or more similar items are selected and the Properties option entered, 
various fields will show that there are differences. 

 

Using the above design example, the component Properties dialog looks like this: 
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If the Component Position in the X axis is different to the Y axis, this will be indicated in the 
dialog by the word [Different] in the coordinate field. Obviously, the component Name will 
also different and is greyed out. 

From here you could also apply the same Rotation (Angle) to all the selected components or 
Mirror them for example. 

If you are currently using Relative Coordinates in the design, you can use the Rel button to 
switch between showing (and accepting) relative coordinates or absolute co-ordinates. 

Values 

From the Properties dialog you can also add Values to design items.  

 

When a value is added, the name of the value and actual value is shown, in the example 
above, C is the value name and 100nF is its value. You can display the value on the item in 
the design by clicking the check box next to the value. 

To add values to a component, use the Value Positions option from the Add menu. For more 
information, see the next chapter under Working With Values. 

The Key shows the colour code for the entries in the list. So, a value just defined on the 
selected component instance is drawn in black, and a value inherited from the library 
component is drawn in light blue. 
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Chapter 5. General Utilities 

Undo and Redo 

Multi-level undo and redo facilities are provided for all major design items and Projects to a 
maximum of 50 levels. System memory (RAM and Virtual Memory) will have an impact on 
the larger undo levels available. The memory used for undo depends on the items and number 
of items preserved by the system. 

 

The number of undo levels are set on the Preferences dialog on the Settings menu. Standard 
Windows functions for Undo and Redo are used as shortcuts, <Ctrl-Z> and <Ctrl-Y>, 
respectively, as well as the inclusion of menu options on the Edit menu for each item.  

The use of undo and redo in design practice are invaluable. They allow you the flexibility of 
being able to try different iterations of design and restore the previous attempts if the effect 
isn't what you require, or if you, by any remote chance, make a mistake, undo allows you to 
recover the situation without incidence. 

One last point about undo and redo, if you set your undo levels to 3, for instance, when level 4 
is required by the system it will remove and overwrite level 1 and so-forth overwriting each 
previous level in turn and continually cycling through this sequence. If you rely on undo (as 
most of us do) set the levels to 50 and forget it! Check your memory and adjust to a level 
suitable for your system. 

Be aware though, once Save or Save As have been used, the undo buffer is reset to zero (0) 

levels available. This means after saving the design you cannot undo an iteration made before 

the save. From this point forward the undo buffer would start saving again. 

Do not rely on Undo or Redo as a substitute for regularly saving your work. 

Interactive Operations 

During the normal usage of the product you will need to make interactive operations to design 
items in order to manipulate them to where you require. The following sections outline the 
major interactive features of the product and explain their use. 
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Moving and Placing Items 

There are two interactive methods of moving items in your designs (don’t forget you can also 
use Properties and Position to type in a location). 

The first is using the standard Windows drag and drop, where an item is selected and with 
the mouse button still pressed, is dragged into its location and dropped. This is very fast and is 
modeless, it does not require that you are in any ‘mode’ of operation to perform this. When 
using drag, the amount of item that is moved will depend on how much of it is selected. A 
track segment for example can be ‘stretched’ until released. Where the stretching takes place 
from depends on how many segments were selected (you may have used the Ctrl or Shift 
keys to extend the selection). If a whole shape is selected, the shape will be moved rather than 
stretched. Selection of any part of a component (other than its name or values) will move that 
item. A component is effectively a small group created by the symbol or footprint library item 
and will act as a complete ‘unit’.  

The second method is by selecting the item and using the Place option from the context 
menu.  

During both drag and Place, options available to you through the shortcut keys and context 
menus are the same. While moving an item, if you decide that it was the wrong item or the 
move is no longer required, press the <Esc> key to exit the mode. 

When placing items, the grid used will be determined by the interactive grid setting. During 
move, use the shortcut key <H> to display the menu. Select the grid setting required.  

 

The grids are taken as fractions of the current grid selected; this is set up in the Grids dialog 
on the Settings menu. You may create your own named grids, these will be displayed on the 
Grid Snap context menu when using Place. Grids are discussed later on in this chapter under 
the heading Grids. 

Line segments that are mitred or fillets can also be moved but will retain their size and make 
the adjoining segments each side dynamic. If you wish to resize a mitre or fillet, use the edit 
facility (using double-click) and drag the corner to a new position. 

On straight line segments, you can pick the end of the line and drag it to a new position. The 
pick and drag must be continuous and must be accurate on the end of the line. If it isn’t, you 
will move the whole line. 
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Mirror (Flip) 

Mirroring of items is done using the Flip command. This can be performed on most design 
items. The command is available when placing or editing an item, or from the context menu. 
It can also be used by selecting the shortcut key <F>, and is available on some Properties 
dialogs, Components for example. It is not available for all design items.  

Flip in Schematics 

The Flip option on components in Schematics works by mirroring the symbol about its 
symbol origin. 

     

  Before    After 

In the above illustration, you can see that the gate U1a has been flipped about its origin axis 
(origin is on Pin 19 [top left pin]). You can see the effect in the Before and After pictures. 

Flip components in PCB 

In PCB, Flip still works by mirroring the symbol about its symbol origin, but because PCBs 
are layer based the Flip command moves the item from one layer to its opposite outside layer. 
For example, a surface mounted pad on the Top layer would be Flipped to the Bottom layer, 
and vice-versa. 

  

Before After 

In the PCB example above using a surface mounted device (SMD), you can see that the axis 
point will be the centre of the device. By convention, all SMDs in the library have their origin 
defined in the footprint centre. Where text exists on the Top layer, this will also be 
automatically mirrored to the Bottom layer and will appear backwards.  
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Rotate 

Rotate can be used on most items in the design. From selection or during Place or Edit, it is 
available on the context menu and by using the shortcut key <R>. Rotate is also available 
from the item Properties dialog. You can type the Angle of rotation into the box provided.  

 

 

Rotation Steps are defined in the Preferences dialog and Interaction tab on the Settings 
menu. These are defined for the use in the Schematic and PCB applications. Rotation steps 
can be defined down to 1/100 of a degree (2 decimal places). 

In the PCB design you should always bear in-mind your final manufacturing process, a 
rotation step of 32.75 degrees may cause unnecessary problems and costs! 

As well as rotational steps, you can also use the Rotate> option on the context menu for 
predefined rotation steps. 

 

Rotation can be applied to multiple selected items using all the rotation methods above. This 
is useful if you wish to rotate all the resistors in your PCB design by 45 degrees for example.  

You can rotate one step back by using the shortcut key <Alt-R>. 
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Fix & Unfix Items 

Design items can be fixed using the Fix Item command on the context menu. You must select 
the item first, then use Fix Item from the context menu. 

 

You can also use the Properties dialog and the Fixed check box. The one shown below is for 
Components. 

 

If you try and delete or move fixed items, the program warns you. You can override this by 
selecting Yes, or cancel with No. If you use Yes, once you have finished with that item the fix 
status is reapplied. 

 

Multiple components can be fixed by making the selection using the <Shift> and <Ctrl> key 
option, and with the Properties dialog. 

Fixed components cannot be interactively moved, flipped, rotated, changed or moved to the 
component bin without confirming the warning dialog. 

Fixed tracks 

Tracks can be fixed for when using the router. For the selected track or track segments, use 
the Properties dialog and Track Segments tab has a Fixed for Router check box.  
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Using the Fix and Unfix Dialog 

In addition to the interactive ‘one shot’ Fix and Unfix options, there is also a dialog-driven 
method of doing this too. Available within a PCB design on the Edit menu. 

This allows you to fix or unfix multiple items by layer, on only visible layers or on selection 
of an item. The selection is then applied to an item category selected from the list. This can be 
items of different types, for example, Areas, Components and Pads. 

 

With an item is fixed, a warning dialog will be displayed if you try to move, edit or delete it. 

Cut, Copy, Paste and Duplicate 

You can use Cut, Copy and Paste on design items to ‘cut’ (remove) and move them, or copy 
and paste as an additional copy into the design. The design items Cut or Copied are added to 
the Clipboard ready to be pasted into the design. They are also saved into the clipboard as 
bitmaps to be pasted into other applications. 

Paste is used to retrieve design items from the clipboard and add them into the design. Only 
text cut or copied from another application can be pasted back in.  

Duplicate is used to copy selected design items and paste them back into the design in one 
process. This works exactly the same as Copy/Paste but on one command.  

These options are available on the Edit menu and use standard Windows shortcut keys that 
have been preassigned but which can be changed if you require. 

Cut <Ctrl-X> 

Copy <Ctrl-C> 

Paste <Ctrl-V> 

Duplicate <D> 

These options can be used on any selected items regardless of whether they are the same type 
of design item or not. 
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When pasting design items that contain net names, these must be resolved when being added 
to the design. As duplicate net names are introduced, you will be requested to either connect 
them to existing nets of the same name, or allow it to make them unique. Net names like 
GND, V- and +5v would normally be connected to each other, whereas net names like CLK 
or RESET may be renamed to be unique. 

The Paste Nets dialog helps in the process of resolving these names.  

 

The options on this dialog allow you different choices for the nets in the paste group. 

Replicate 

The Replicate option will duplicate an item and then make a number of copies into an array. 
This is available for all design items, includes shapes and components. 

From a selected item, a component or shape, from the context menu, select Replicate. 
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The Replicate dialog is displayed. 

 

From this dialog set your required parameters and click OK. 

The pattern now looks like this: 

 

Delete 

Delete is available for almost every design item. It can be used by selecting the item then 
clicking the Del (or Delete) key on the keyboard, by selecting Delete from the Edit menu or 
by right clicking and selecting Delete from the context menu. Delete is also available on the 
Edit toolbar as an icon. 

There is no confirmation for delete if an Undo level is set (in Preferences option under 
General tab) but deletions can be recovered by using the Undo option. If the Undo levels are 
set to None, a delete confirmation dialog is displayed from which to make absolutely sure you 
want to delete the item. It is recommended not to use this setting, keep Undo levels to at least 
1 level! 

 

Special cases of delete in Schematics 

If deleting multi-gate components from the design, when a single gate is selected, the whole 
component is deleted not just the selected gate. Gates from the same component that are in the 
Component Bin are also deleted. 
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Special cases of delete in PCB 

There are no special cases in PCB, you should be aware that when using delete on a track in 
PCB, the track and its connection path will be deleted from the design. This is a setting that 
can be switched in the Preferences option and Interaction. Select the Delete Removed 

Attached in, the underlying net path is still retained even when delete is used. 

If you wish to delete the connection path as well you must make the deletion first then use 
Nets> Change Net and rename the other side of the net but ensure that the check box Change 

Name Of Sub-Nets Only is checked. 

Adding Text 

Text is added using Add Text from the Add menu or from the toolbar.  

 

Type your text into the text field. If you wish to add multi-line text, click the small down 
arrow next to the text, this now allows you to use <Enter> to add multiple lines. Choose the 
text Style required and the Alignment. For a PCB design, you are also able to choose the 
Layer. 

Once a text string has been entered click the OK button. The text will now be on the end of 
your cursor ready for placing within the design.  

Once the text is in the design it can be edited or changed by selecting it. Right clicking now 
displays the context menu to change Style (text height, style and line thickness), to Rotate, 
change Layer, Flip (Mirror) or Cancel.  

Rotate offers a choice of each of the four principal axes, or a rotation anticlockwise by the 
default step. This default rotation is defined using the Preferences option from the Settings 
menu.  

Once released using a single click, the Add Text dialog is displayed again ready for the next 
text string, Cancel from the context menu ends the operation, you can also use the <Esc> 
button to cancel. 

If you wish to edit existing text, double-click on the text and edit it in the edit box provided. 

Text sizes are defined from the Setting menu under Design Technology and Text Styles. On 
the Text tab you can add text styles that will be required in the design or technology. 
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Within this tab there are a number of 'system' text styles which cannot be renamed but can be 
edited for different values. These are shown in square brackets, e.g. [Net Names]. Text style 
names should be reflective of a useable name for speed of recognition during use. 

True type fonts are used as well as the original stroked font. These can be used by selecting 
the drop-down list box under Font on the main Text dialog, or by using the Add Style or Edit 
buttons. These will display the Text Style dialog. 

 

From this dialog you can also make the style Underline when displayed by selecting the 
check box.  

True type fonts can be used in both Schematic and PCB designs. When using these fonts in 
the PCB design, consideration must be made to how the boards will be manufactured.  

If you wish to use the ‘stroke’ (or stick) font,  you should select the <System Stroke Font> 

entry from the list of available Fonts in the drop-down list. This is shown in chevrons < > to 
indicate that it is the built-in font rather than a Windows system font. 



 General Utilities   55 

 

Additional parameters on the edit dialog allows you to change the proportions of the Stroke 
Font. It can be Proportional Width to specify the text is to be spaced proportionally to close 
up the amount of white space between characters or you can change the Character Width or 
Line Step. 

Adding Barred Text 

To add text that is barred, add text as normal using the Add Text option but precede the 
characters you wish to be barred with the barred text delimiting characters which by default is 
the double underscore character (_ _).  

As an example, if you wish to have the word barred of This is barred text barred, you 
would define the text string as This is _ _barred_ _ text, (a space has been used in this 
example to show that two underscore characters have been used). This would then be written 
to the screen as.  

 

If you wish to have barred text and use the underscore character you can either set the default 
delimiter character to another character or use an additional underscore character within the 
text string. 

It is possible to change the barred text delimiting character via the General tab on the 
Preference dialog using the Text Barring Character. 

The character specified as the Text Barred Character will cause all doubled occurrences of 
that character to enable or disable the barring of subsequent characters in that text. 

 

Note that this facility is provided mainly for use when importing other designs that already 

use other text barring delimiters and that changing the specified character will not convert 

existing barred text to the new delimiting characters. 

Adding Barcodes 

You can define a barcode using a text style but only named barcode styles are allowed using 
the Technology dialog.  

To enable barcodes, you must use the Barcode Interleaved 2 of 5 text font. Once this is 
selected, you can then define the bars and gaps used for your barcode. 



56   General Utilities 

 

In the design, use the Add Text to add the numbers that will define the barcode, i.e. 
05505223. Then change the text style of the barcode to your barcode font and the design will 
now display a barcode.  

 

Until this special barcode font is used, the text will still appear as normal readable text. 
Detailed information about setting up bar widths and gaps can be found in the online Help. 
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Mitres, Fillets and Arcs 

Mitres (45-degree corners) and Fillets (curved corners) can be added to any shape item in the 
design, this includes connections in Schematics and PCB tracks. Mitres can only be added to 
90-degree corners on straight line segments. Mitres and Curves both behave in the same way 
and are added and edited the same. 

The principle for editing corners to make them mitred (or filleted) is straightforward: you 
double-click on a corner and drag it into the position required. With the grid switched on, you 
can snap the diagonal corner to a grid point at varying mitre lengths. An Edit Mitre/Fillet 
option is available on the context menu as well for use. 

 

You can use the Fillet command from the context menu option to switch between Mitres and 
Fillets. You can also enter the radius using the Enter Radius command from the context 
menu for a selected Mitre. 

Mitre Tracks 

Mitred tracks can easily be inserted into the design using the Mitre segment mode. During 
addition of tracks or the editing of existing tracks, if you right click you can select Segment 

Mode> and then Mitre.  

When adding or editing tracks, you will now be using orthogonal tracks in the X and Y bias 
but will use a Mitred corner on the direction change. 

 

Curved Corners 

When adding and editing corners, it is also possible to insert arcs and curves. While editing 
items you can switch the segment mode into Fillet (toggled using the <M> shortcut key). This 
will insert corners now as Fillets (Curves) instead of Mitres or 90 degree angles. The example 
below shows how a track segment might look using a filleted corner. 
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Adding Curves/Arcs 

For an existing selected segment (Track or Shape), Arc> is available from the context menu. 

  

The menu provides you with fixed angles but also Angle Free. During the Angle Free mode, 
the bottom status bar shows the Angle and Radius.  

You can drag the arc out to the size required.   

 

To use this, select a straight line segment and from the context menu, select Arc>. Using one 
of the edit arc options, create the arc or edit it using Angle Free and move the arc to required 
radius. 
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Chapter 6. Setting Up The Design 

Projects 

Projects are an optional feature; you can decide to use them from the start or not use them at 
all. If you decide you want them after the design has been started, then they can also be used. 

Projects are used to tie single or multiple Schematic sheets with a PCB design. Each sheet of a 
Schematic is effectively a single design file. The use of a Project will enable net names and 
Component names to be tracked through each sheet so that duplicates are not produced. The 
Project file is also used to group related design information in one file.  

 

���� To add files to a Project 

Multiple Schematic designs can be added to the Project. 

1. You can add files to a Projects with or without any design files open. 

2. From the Project menu, select the Add Files To Project option. Or: 

3. Right click with the cursor over the Project document tab at the bottom of the design 
window and select Add Files from the context menu: 

 

4. From the browser, select a design file to add to the Project. Other types of files, reports 
or Parts lists etc. can be associated with the Project as well using this option. 

���� To maintain a Project 

You can do maintenance activities to a Project by using the options available on the context 
menu for a selected design file with that Project: 
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1. Open the Project. 

2. Right click on a design. 

 

3. From the context menu, you can select Open, Remove From Project, Rename, 
Duplicate or Sort Project Files in the list. 

���� To save a Project to a Zip file 

You can save the contents of a Project to a Zip file. This is useful if you wish to send the 
whole Project to another party: 

1. Within the Project, from the File menu, select, Save to Zip. 

 

2. From the Save As dialog, type the name and location you will save the file to. 

File Operations 

There are some basic commands available from the File menu that will help with the general 
upkeep of your designs: 

Save/Save All allows you to quickly save all currently open designs and library items.  

Close/Close All allows all open designs to be quickly closed. If a design has not been saved, 
you will be warned.  

Reload is used to discard the current edit and reload the design from the previously saved 
version on disk.  

Open From Backup is used to open a design from a backup file if required. The backup file 
will be auto-named starting with a ~, i.e. ~design1.pcb 
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Folders 

You can predefine where Technology Files, Libraries and Colours Files will be saved and 
loaded from. The Folders dialog is used to manage these from the Settings menu.  

 

Saving Your Files 

During usage you should regularly save your designs. You can use Save or Save As to do 
this. In addition to these features, you can also switch on the automatic security copies feature 
(see Security Copies below).   

To 'force' a save or to save the design to a new name, you can use the Save command from 
the File menu, or the Save As command from the same menu. 

The file extensions will automatically default to the type used for that application. e.g. .sch for 
Schematics and .pcb for a PCB design.  

Save Technology on the File menu allows you to save the Technology within a design. This 
can be used again on a new design or applied to a different design to give it the same 
parameters.  

The Load button on the Colours dialog will allow you to save Colour files, these can be 
applied to different designs. 

Saving Libraries 

When creating a Symbol (Schematic or PCB), you have the Save To Library option on the 
File menu as well. Once your new symbol is ready to save to the library, you should use the 
Save To Library option and not the Save or Save As options. This is covered later on. 

Security Copies  

Making regular backups is a basic necessity when working with computers. A requirement, 
unfortunately, more honoured in the breach than in the observance. Hence, an automatic 
security backup service is provided. This can be switched on or off and set to specific 
intervals for use as required. 
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During use, the design is held in memory, if you make any mistakes the undo and redo 
functionality can save the situation by allowing you to recover commands previously 
executed (but only up to the number of undo levels set in the Preferences dialog). Major 
faults, like someone pulling the mains lead out of the computer will normally mean that you 
have lost any work back to the last save or security save, depending on which was the last 
used. Obviously, the more save is used the less design work is lost in one of these situations. 
Saving your work really is an essential part of the design process as well. 

The status bar at the bottom of the screen will inform you that the application is making a 
security copy, this happens automatically at the time interval set. There is no user interaction, 
the security copies just happen. 

An automatic security back-up facility is provided. This can be pre-defined for regular 
intervals. Back-up copies are automatically created of your design when the security interval 
is activated. The control you have for updating the security copy at intervals is determined by 
the Security Copy Level selection on the General tab of the Preferences dialog. 

 

By making an entry of 0 (zero) minutes, the security copy is switched off. Any value greater 
than zero will activate the security copy. 

The location of the security files can also be defined. By selecting the Location button, a 
dialog allows you to set the location to be the same folder as the design or one defined by 
you (In this folder:). The Browse button allows you to browse to a location to be used. 

 

Security copy files are designated using the tilde ( ~ ) character. For example, opening 
'Div.sch' will automatically produce a security file ‘~Div.sch’ when the security interval is 
activated. You should not use these files but instead, copy them to a new name (removing the 
~) and continue with the design. If you load a security file, you will be warned. 

When using the product, you should not open files which start with the ~ character, this 

means you are opening your back-up which could be out-of-date with the design you intended 

editing. If you open the back-up file, you will notice that a back-up of the back-up will be 

made e.g. ‘~Design66.sch’ will become ‘~~Design66.sch’ 

Units and Co-ordinates 

It is possible to change the display from Imperial units to Metric units and vice versa. This is 
done with the Units entry on the Settings menu. The database precision used is 1/10th Micron, 
this means there are true Imperial / Metric conversions at all times, with no rounding errors. 
This accuracy is essential in modern designs where mixed Imperial and Metric components 
are created and placed. You can also use the shortcut key <Shift-I> to toggle between 
Imperial and Metric units. 
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Changing the units does not affect the pitch of the grid but simply changes it to be the same 
size in both imperial and metric units. 

 

Imperial (Thou) (or Mils) units would normally be defined to 0 (Zero) decimal places, while 
Metric (mm) units would be defined to 2 or 3 decimal places. This is because of the rounding 
and accuracy required when using Metric units, this is especially important for the definition 
of drill sizes. 

The Units used and Coordinates are shown on the status bar at the bottom of the design. 
You’ll note that Abs (or Rel) are shown to indicate that you are working in Absolute or 
Relative modes. With the active status bar, double-clicking on these fields will display the 
relevant options. 
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Grids 

 

Grids are used for both defining the 
points or steps that items will snap to 
when they are placed and for visible 
references in the design. For this, use 
the Grids dialog on the Settings menu. 
You can add and use your own named 
grids each with its own display settings, 
add and use polar (radial) grids, and 
have your own grids displayed in the 
Grid Snap context menu.  

 

Grids 

The first section of the dialog shows you a list of all the Grids currently defined in the design. 
From here you can carry out actions such as adding new grids or changing the name of an 
existing grid. Apart from adding a new grid, all other actions on this dialog will act upon the 
grid that is currently selected in this list. 

Add : add a new grid to the list. You will be prompted to supply a new name for the grid, 
which must be different from the names of any grids that exist already. 

Rename : change the name of the selected grid. 

Copy : make a copy of the selected grid under a new name, copying across all the settings 
from the selected grid. 

Delete : remove the selected grid from the design. Note that there always needs to be at least 
one grid, so the application will not let you delete the last grid from the list. 

Make Current : sets the selected grid as the current working grid to use for placing items. 
The 'current' grid is marked in the list with an asterisk. As a shortcut to changing the current 
grid you can simply double-click on the required grid in the list. This will make that grid the 
current grid, and close the dialog. 

Make Comp: sets the selected grid as the preferred grid to use for placing any selection 
containing one or more components. The 'component' grid is marked in the list with a letter 
'C'. 

Grids Visible : this is a global switch that toggles the display of grids on and off. This is the 
same as using the Toggle Screen Grid toolbar button or command. Note that each grid also 
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has a Visible check box, so that you can choose which of your grids should be drawn when 
grids are set as Visible. 

Only Draw Current Grid : when drawing grids, normally all grids which have their Visible 
check box ticked are drawn. By checking the Only Draw Current Grid box, you can choose to 
draw only one grid, the grid that is set as the current working grid. Using it this way will 
mean that as you flip from one grid to another, the display changes to draw only the grid that 
is current (active). 

Step 

The first box is used to define the working grid step. Type the required size in the current 
design units. 

 

Different Y : check this box to use different grid step in X and Y axes. By default, the X and 
Y steps are the same.  

Polar Grid : check this box to define a polar (radial) grid. When you check this box, some 
different settings appear on the dialog: 

 

Concentric Step : this is the distance between each 'ring' of the grid. 

Divide Circle Into : this is how many 'slices' the grid should be divided into. 

Here you can see an example of a Polar grid, in this case divided into 8 segments: 

 

Origin 

This section of the dialog allows you to specify the origin or 'starting point' of the grid.  
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A Polar grid will be centred at the origin position, and a normal 'step' grid will have its first 
point on the origin and step outwards from there in each direction. 

Follows Design Coordinate Origin : check this box to have the grid start from wherever the 
design System Coordinate Origin is placed.  

Origin X and Y : here you can specify a particular location for the grid origin when it is not 
following the coordinate origin. 

Snap 

 

Snap Mode is used to further define the grid step that is actually used in interactive 
operations such as Place. Choose a value from the drop down list as follows: 

 

If you choose a setting other than 'Grid', each step of the grid is divided according to the 
setting you select. Snap Mode is not available for Polar grids. 

Display 

This section allows you to control how each grid is displayed. As with the other settings, each 
grid has its own display values. 

 

Visible : check this box to make this grid visible. Note that it will still only be drawn if the 
main Grids Visible check box is also checked. 

Draw Grid First : check this box to draw the grid before drawing actual design items. This 
has the effect of drawing the grid 'underneath' everything else. 

Draw Crosses : use this to draw small crosses instead of ‘dots’ or lines. 

Primary Colour is used for every 10th grid point of a step grid, or for the radial 'arms' of a 
Polar grid. Check the Lines box to have the grid drawn as lines. 

Secondary Colour is used for all other grid step points. As you use Unzoom to increase the 
amount of the design that is displayed you will reach a level where the secondary grid points 
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are too close together and they will no longer be displayed. The same is true for the Primary 
points for a step grid if you carry on with zoom out. 

For a Polar grid, if you uncheck Primary Lines, the grid is drawn with a single dot at each 
place where the rings and the radial arms intersect. 

Change to the Grid Snap context menu 

 

The Grid Snap Mode shortcut can be displayed during 
editing by selecting the direct command <H>. By selecting 
the snap mode setting you to choose current grid, and 
access Grids dialog. These can be changed interactively 
when editing or placing items in the design. The default 
shortcut for this is the <H> key. A small menu will be 
displayed which allows you to select the Snap Mode (for a 
step grid), to change the current working grid to a different 
grid (if more than one grid is defined), or to access the 
Grids dialog.  

 

Shortcut for toggling grids 

The Visible check box enables the grids to be displayed on or off, this can be set at any time 
in the design using the shortcut key <G>. 

Changing the Working Area 

The Working Area option can be used to control the size of the design ‘desktop’ that your 
design is working in. By setting the working area to be slightly larger than your actual design 
it will enable you to zoom in closer and to use all of the Zoom shortcut keys on the keyboard. 
If the working area is set too large for a design, some of the shortcut keys will have no effect. 
When this is the case, select the Working Area option from the Settings menu. Unless you are 
familiar with the program use the Best Fit option.   

 

This will set the design area to make the best use of its size relative to the actual design or 
design items (this is the maximum area of design items, board outline or drawing blank). 

Changing the System Coordinate Origin 

You can change the system coordinate origin to be any other position within the design, the 
lower left corner of the board outline or design centre for example. By default, the coordinate 
system is defined as the lower most left corner of the working area (0,0). These are changed 
or set from within the Relative Coords option on the Settings menu.  
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The system coordinates can be changed using the Relative Coords dialog on the Settings 
menu, or by using the option Set System Origin from the context menu (with nothing 
selected in the design). This option is also available for some selected items, such as pads or 
terminals.  

 

Working in Absolute and Relative Modes 

Two origins are maintained for the coordinate system, these are displayed at the bottom of the 
screen on the status bar. The status bar shows the mode as Abs or Rel for Absolute and 
Relative, the Coordinates and the Units (as previous discussed). 

 

The Absolute (Abs) origin is fixed at the bottom left hand corner of the drawing area defined 
by the design area or border. All coordinates reported are positive in both X and Y directions. 

The Relative (Rel) origin can be set to any point within the design. The co-ordinates reported 
will always be relative to this position. 

The Relative origin is very useful when it is necessary to position a pad or track accurately 
with reference to another pad or track in, for example, the case of component fixing holes. It 
is also an ideal tool for the measurement of distances and clearances. 

Switching between Abs and Rel mode can also be done using the Settings menu and Switch 
Rel/Abs Coords option. This will be shown with a tick next to Relative Coords when in 
Relative mode. 
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Setting the Relative Origin 

To use the Relative co-ordinate system, select the Relative Coords option from the Settings 
menu. From the dialog you have to select the Use Relative Coordinates check box to toggle 
to the Relative mode. You can enter the Origin position as an X and Y co-ordinate. You can 
also define the system origin, the relative origin is taken from this location. 

 

This will toggle the co-ordinate display on the status bar between the Relative and Absolute 
origins, shown as Abs and Rel as the origin mode changes. 

As well as selecting the Use Relative Coordinates check box to select the Relative mode you 
can also use the <Shift-R> shortcut key to toggle between the Abs and Rel modes. Once in 
Rel mode, to use this option, move the cursor to the origin point required and then click <O>.  

You can also set the Relative Origin using the options from the context menu for a selected 
item: 

 

Any mouse movement will now be shown relative to this position. 

Using Rel mode 

When using the Relative origin mode, you can go to the origin by using the Goto> and 
Relative Origin option from the View menu or by selecting the shortcut key <Shift-O>. 
There is also an option on the context menu with nothing else selected. 

Mostly, you will use the co-ordinate system in Absolute mode which shows the cursor 
position relative to the Absolute Origin, but there are times when it would be more useful to 
be able to see the cursor position in relation to the Relative Origin, for example when we are 
laying down related pads, tracks or connectors. 
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Using Technology Files 

Overview of Technology Files 

Technology files are like the start-up files used by word processors, such as Word. These files 
contain groups of predefined styles that can be applied to design items, items such as tracks or 
connections or text for example. 

These can be used on successive designs to greatly speed up the setting up for new designs of 
different types. The setup required for a four-layer, fine line surface mount device board with 
internal power and ground planes is totally different to how a low cost double-sided board 
might be. Technology files can also help standardise company standards or practices.   

Technology files provide a means of setting most of the important parameters. They are read 
once when starting a new design and the design then inherits the contents of the technology 
file. The technology within the design can be edited and modified or added to. If you wish 
you can save the then edited technology back out to a new Technology file or overwrite an 
existing one. Having started a new Schematic or PCB, those designs will not be affected by 
subsequent changes to the technology files. There is no danger that subsequently modifying 
Technology files will affect previous good designs. 

Existing Technology files can be applied to existing designs using the Technology Files 
option from the Settings menu. This is discussed later on. 

Technology Files minimise errors and produce faster results, it is highly recommended that 
you use them. 

Using Technology Files 

Technology Files are design application specific, for example, you cannot use a Schematic 
Technology files in a PCB design vice-versa. However, you can use and should use a 
Schematic Technology File when creating Schematic Symbols. The Technology File that you 
expect to use for the design should be the same one used when creating the Symbols, this will 
help synchronise the names and values used for styles etc. 

How to create and save Technology Files 

Technology Files can be created as a specific non-design related task in their own editors, or 
created/modified from a design using a new or existing Technology File as the starting point. 

If starting from new, you can use the New option from the File menu. On this dialog you can 
use the Technology tab. This will allow you to access the Technology editor application. This 
is like a design editor application but you can only edit Technology related information, such 
as Styles or Net Classes etc. 

Once the Technology has been created (by editing the various entities of the Technology), use 
the Save option from the File menu. This will request a name for the Technology File and its 
location. By default, the location will be that previously defined in the Preferences dialog 
under Directories and Technology Files. 

When saving a Technology file from within an existing design use the Save Technology File 
from the File menu. This will extract all the necessary entities from the design and save them 
to the Technology File. 
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Styles in Technology Files 

One of the most important entities of the Technology is Styles. Styles are used to define the 
shape and size of items, such as Pads and Text. When design items have styles, it means that 
you can modify all the pads in a design or example by editing one value in the Pad Styles 
table. Obviously, local styles can be applied to one or more selected items in the design if 
required. All styles are defined in the Design Technology dialog under their respective styles. 

Pads 

The Pad styles are used to define the style of Pads and Vias in a PCB design and Pin or 
Terminal styles in a Schematic design. The main difference between these two types of styles 
is that the Schematic pad style only defines the Shape, Width and Length of the pin, whereas 
the PCB pad style has a Layer and Drill Hole information as well.  

 

The Add Style or Edit buttons provide you with a Pad Style dialog: 

 

When defining pad styles in PCB, the style is assumed to be on all layers (shown by default as 
Layer [All]), this is the default pad ‘stack’. The only time this setting changes is when a pad 
exception has been added to a particular pad style. 
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Pad Exceptions 

In the PCB Pad style dialog, it is also possible to give a pad a different style on a given layer 
using the Add Exception button. 

Once the pad exception has been applied, the grid then displays a layer exception for the pad 
style changed, in the example below, this is shown on the pad style Pad. A layer exception for 
the Bottom Electrical has been added to increase the pad size and pad shape. 

 

Slotted Pads 

You can create slotted pads using the Pad Styles dialog, you can specify a Hole as being a 
non-round shape, a Rounded Rectangle for example. Using the non-round shape will create a 
slotted pad.  
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Text 

As with Pad styles, Text styles can be created and edited from the Design Technology dialog. 
Within the grid, predefined system names are shown in brackets, [Errors] and [Pin Names] for 
example. These can be edited but cannot be renamed or removed.  

 

Text styles can be given a Font as well. The fonts will be selected from any Windows fonts 
that are installed and available in the drop-down list. If no font is selected then the Font box 
will show an empty grid box or <System Stroke font>, these are the same. The System 
Stroke Font is a built-in font made up of very simple lines.  

Lines 

Line styles are used for line items within the design, items such as Symbol outlines, 
Silkscreen outlines, Bus lines and Connections. As well as the Name of the Line style, the 
Width of the line is defined. In a PCB design, Line styles will also be used for Dimension 

Lines and Board Outline as well.  

 

Lines are not used for Connections or Tracks, these have their own style definitions. 

Connections in Schematic Technology Files 

There are no Track styles in a Schematic design so the Connection style is defined. This 
style is used when adding connection to the design. By changing the style and thickness you 
could show different connections that are more or less significant than others.  
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Tracks in PCB Technology Files 

The Track styles dialog in PCB Technology files is used for defining the thickness of tracks. 
These can be used locally on specific nets or as part of a Net Class that defines the track 
width limits (and via style) when autorouting or manual routing.   

 

With a nominated net class on a net, from then on, it will automatically pick up all of the 
parameters of that net class. What is more, changing the net class in a design will 
automatically change all of the elements that have been given that net class. (Net Classes are 
discussed in more detail below). 

Merging Styles 

There is a Merge button on the Styles pages of the Design Technology dialog.  

 

This allows you to select two or more rows in the table and merge them together. This will 
update the design to replace all instances of the ‘merged’ styles with the one style you have 
elected to retain.   
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From the dialog, choose the style name that you wish to keep and click OK. All the other 
styles will then be merged with the selected style, including updating all references to that 
style in the current design. Note that you cannot remove built-in styles (those with names 
enclosed by square brackets), so if you select any of those you may not be able to perform the 
Merge action. 

You may find the Merge facility useful if you have combined sections of data (components, 
connections, etc.) together from several different sources, where the styles used in those 
sections may not be consistent. Note that merging styles will only affect the current design, it 
does not go back to the library and rationalise style settings there. 

Note: The ability to select multiple rows required for Merge means that you can also use 

Delete on several entries at once. 

The relationship between Net Names and Net Classes 

A Schematic design and PCB design would have the same Net Name for the equivalent 
design (in theory!). When designing a Schematic, you can assign a net a Net Class name. Net 

Names are stored on the Design Technology dialog under Nets.  

 

When a Schematic is translated to the PCB, the matching net class is found (matched by 
name, the net has the net class assigned to it) and the PCB net properties applied to that net 
class. The Net Class in the PCB design has inherent properties that give the net more 
intelligence. For example, the Net Class will also contain track thicknesses and via styles that 
will be used once routing is started. The diagram below illustrates the relationship between 
the Schematic and PCB designs.  
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Net Names in Technology Files 

Two types of naming are supported: the first is a default system supplied net name (an auto-

named net), such as $1, $22, N0011 etc., the second is a user defined name, such as Gnd, 
Vcc, Sig1, Clock, Reset etc. 

Once a net name is used in the design it then appears in the Nets dialog. The Nets dialog for 
Schematic and PCB Designs are slightly different. The Schematic Nets dialog shows the Net 
Name, the Net Class and a Colour for that net. 

Net Names can be edited within this dialog and the new name applied to the design. Where a 
net name is shown as used (by a small X next to the name) it cannot be deleted from the 
design. 

 

You have a check box at the right of the dialog for Showing Auto-Named Nets in this grid, 
this helps clarify user defined and system named nets. 

The colour can be edited by double-clicking on the colour box and selecting a colour from the 
drop-down list. 

The colour shown in this dialog overrides the colour used for Connections in the Colours 
dialog but only if it is different. 

The PCB Nets dialog shows the Guard Spacing and not the Colour. Guard spacings are used 
to add extra spacing to a net. 

Net Classes 

The Net Class is used to define a ‘group’ or collection of net names which have the same 
characteristics, i.e. track thickness or Via style. 

In the Design Technology, on the Nets dialog, the Net Class name can be selected from the 
list. Only names that have been previously defined in the Net Class dialog are available in 
this list. 
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The Edit Net Class dialog enables you to make your selections: 

 

Net Classes in the Schematic Design 

In the Schematic design, Net Classes are defined as simply a name, there is no physical 
attributes at this point. The physical attributes of the Net Class are assigned in the PCB design 
Net Class dialog and are passed through when using Translate to PCB. 

It is the Net Class name that is important, this is the name matched in the PCB design. From 
this Net Class name the physical information is assigned. 

Net Classes in the PCB Design 

The Net Class dialog in the PCB design contains the physical attributes of the net as well as 
its name. It is the Net Class name that makes the association between the Schematic and PCB 
design. The attributes defined will be used when the net is converted to a track using a manual 
or automatic routing process.  

 

By selecting the Edit button on this dialog, you can change the track and via styles used by 
that net class. You can also edit the grid directly by double-clicking on the name in the grid. 

The styles used are taken from the Track and Pad Styles dialogs on the Design Technology 
dialog. 

The Net Class page is also used to define Diff Pairs and Tented Vias, more about these later. 
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Net Class to Class Spacing Rules 

You can define spacing rules which match by Net or Net Class name and Layer Name. These 
are used to produce extra clearances between items on different Net Classes, to allow for 
creepage for example.   

 

Press the Add button to add a rule. You need to define three wildcard strings which will 
match two sets of nets (or net classes) and layers. (Note: if they are not wildcard strings 
(containing '*' or '?'), then they will explicitly match a single net or layer). You can match a 
set of net class names (instead of net names) by enclosing the Match Net string in [square 
brackets].  

The Bi-Directional flag indicates that the rule applies to the design types of either net (so the 
Pads to Tracks spacing will always be the same as the Tracks to Pads spacing). This does not 
have to be the case. For example [Power] nets might need a large Pads spacing against Tracks 
on all other nets (*), but a smaller value is needed for the reciprocal Tracks on [Power] to 
Pads on the other nets. 

Once a rule has been defined, it is added to the Net Match grid. You can move a rule Up or 
Down the list. The rules are applied strictly in the order that they are defined in the grid, until 
the first one which matches. So if you define the first rule as * to * on layer *, which matches 
everything, then none of the subsequent rules would ever be applied. 

If you select a row in the Net Match grid, then the spacing grid above will show the values 
which apply. Initially, all values are inherited from the design level (indicated by grey text). 
Typing values into the grid will set an override value for this rule (indicated by blue text). 
You can also delete an override value to turn it back to the inherited value. 

If you have defined the rule as Bi-Directional, then the top right half of the grid is greyed, 
because those values are the same as in the lower half of the grid. In the case when Bi-

Directional is disabled and the Match Net criteria would match either way round, then the 
larger value is used. Note that the net string * also matches with items not on a net. If you use 
this string, then the Text and Board values become available. So, for example, you can define 
a specific value between net Gnd and the Board. 
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PCB Specific Items in the PCB Technology File 

Layers 

The Layers dialog (on the Settings menu) is where the ‘structure’ of the board is defined. 
This will define electrical, non-electrical and documentation layers as well as construction 
layers. 

Spacings and Clearances 

The Spacings dialog (on the Settings menu) is used to define the clearances used for design 
rules checking. These clearances will be required by your PCB Manufacturer, they are a set of 
rules or tolerances to which they can make your board.  

How layers and Spacings are used is discussed in the PCB Design section later on. 

Changing Styles Globally and Locally 

Styles can be changed in several ways:  

For new designs, changing the style in the Technology File will affect all subsequent designs. 

For existing designs, a style can be changed either by editing the style using the Style dialog 
from the Settings menu, or directly on an object. Editing a style on an item is done using the 
Properties option from the context menu or by using Change Style from the context menu. 
Alternatively, double-clicking on a component or text will automatically open the Properties 
dialog. 

If you edit a style using Properties and give the changes a style name you are given the 
option of adding that named style to the design it will not be added to the Technology File, 
you must use the Save To Technology File option from the File menu to do this. If you 
change a style using the Styles dialog it will affect all objects in the design that use that style, 
i.e. the changes will apply globally to that design. 

Track Length Rules on Net Classes 

For advanced rules, you can add extra values on a net class:   

• length difference value 

• min length value 

• max length value 

You can optionally enable the Maximum Track Length Difference and Min and Max 
Track Lengths options within the net class. 
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By adding these values and using the appropriate net class in your design, you can define a 
minimum and maximum length that the routed track must finish with. By adding a length 
difference value to the net class, you can then check that all the tracks using that net class will 
finish with their length within that tolerance. 

These values are used by a DRC check (Net, Track Lengths), and a Track Length Rules 
report available from the Output menu and Reports. 

Headup Display 

There is an interactive PCB tooltip based headup display to show track and net lengths as you 
add and edit track segments to the design.  

This is available from the shortcut menu when using Edit Track, Mitre Corner and Move 
on track segments. 

The display will also include rules from the Net Class if they are set up. The values in the 
headup display will change to red when the rule has not been met. There is also an option on 
the shortcut menu to reposition the headup display relative to the moving cursor. 

There are some options in the Preferences dialog and Display page to control how unrouted 
connections are treated when working out the track length of a net. 
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Using the Headup Display 

Check the Show Headup Display box to show a tooltip based headup display of track and net 
length information when adding, moving or editing tracks (including Differential Pairs).  

If the track being edited lies on a single path between two component pads, the names of the 
pads are included at the top of the headup display. 

 

If minimum and maximum track length rules are defined on the net class of the track being 
edited, their values will be included in the display and will be drawn green if the net track 
length is within the defined limits. If the net track length is outside one of the limits it will be 
drawn with red text as well as the rule that failed.  

If the net being edited belongs to the same net class as other nets, and the net class has a 
Maximum Track Length Difference rule defined, the shortest and longest net lengths will 
be shown. If they are different, the difference between them will also be included along with 
the maximum rule limit. If the actual difference in net track lengths is greater than the limit it 
will be drawn with red text as well as the rule value.  

Check the Include Unrouted Lengths box to include unrouted connections in the overall net 
track length. Choose the Method to be used when calculating the estimated track length for 
each unrouted connection. Manhattan is the minimum distance from one end of the 
connection to the other using just horizontal and vertical lines. Mitre is the minimum distance 
from one end of the connection to the other using horizontal, vertical and 45 degree lines. 
Point to Point is the length of the single straight line between the two ends.  

You can also specify an offset here, which is the distance between your current cursor 
position and where the headup display is drawn. You can change the value here to anything 
between 0 (no offset) and 4000 (4 inches). 
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DRC Option 

Within the DRC option, the Track 

Length check calculates length of all 
tracks in the class, finds the median 
value, then shows you any net that is too 
far either side of this value. The same 
check box enables the Min/Max check 
to simply verifies track length of each 
net against specified values, either value 
can be set to zero to ‘ignore’ that length. 
Nets with no tracks are always flagged 
as errors. 

 

 

DRC Report 

When the DRC option reports Track Length Diffs errors, the report typically might look like 
this: 

Design Rule Check Report 

------------------------ 

Report File    : c:\temp\ProDesign.txt 

Report Written : Thursday, July 04, 2022 

Design Path    : c:\design\Job77Design_A.pcb 

Design Title   : PSU Board 

Created        : 22/04/2021 1:28:41 PM 

Last Saved     : 04/07/2022 10:47:57 AM 

Editing Time   : 6470 min 

Units          : thou (precision 4) 

 

Results 

------- 

Track length differs from other nets of same class : Net SIG009 

too long, length is 602.7795 thou but needs to be no more than 

600.0000 thou from rules in net class HS1 

 

Net SIG009 too long, length is 602.7795 thou but needs to be no 

more than 600.0000 thou from rules in net class HS1. 

 

Number of errors found : 1 

Track Length Rules 

When run from the Output menu and Report option, an example Track Length report might 
look like this: 

Track Length Rules 

------------------ 

Report File    : c:\temp\ProDesign.txt 

Report Written : Thursday, July 04, 2022 
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Design Path    : c:\temp\ProDesign.pcb 

Design Title   : PSU Board 

Created        : 22/04/2021 1:28:41 PM 

Last Saved     : 04/07/2022 10:47:57 AM 

Editing Time   : 473 min 

Units          : thou (precision 0) 

 

Net Class Net Length Range from to Diff Min Max 

-------------------------------------------------------------- 

HS1  FS1 602 590  605 15 580 600  

  FS2 592 590  605 15 580 600  

-------------------------------------------------------------- 

Power  - - -  - - - -  

-------------------------------------------------------------- 

Signal - - -  - - - -  

-------------------------------------------------------------- 

Defaults 

The Defaults entry on the Settings menu allows you to set up styles that will be used when 
first starting a design and when using design items such as text or tracks.  

For example, after loading a few components to the Schematic and starting to add 
connections between them, the initial default connection width of those connections will be 
defined by the entry under Defaults and Net Class and Defaults and Connection. A new Pad 
added would only use the Defaults and Pad entry. 

 

It will not be necessary if you normally translate from a Schematic. In this instance, the track 
styles used will be from the Default Net Classes. They can be changed after translation if 
required. 

Loading and Reusing Technology Files 

If a style has been added to a design and it is required for use in another Technology File for 
subsequent use in other designs - or if a Technology File contains a style that is required in a 
design, the Technology Files option on the Settings dialog provides a method of bi-
directional transfer.  
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���� To transfer Technology items 

1. Select the required Technology file from the drop-down list next to Name: 

 

2. Select the tab containing the required style type. 

3. The main box on the left is the style in the Current Design and the box on the right is 
the contents of the Technology File. 

 

4. Highlight the style or group of styles to be transferred by selecting them, then press the 
<<Copy All or Copy Selected>> buttons, depending on your selection. 
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5. The style(s) will be copied and shown in the other box. 

6. If the Technology file has been changed you will be asked to confirm that the changes 
should be saved. 

Exporting & Importing CSV Files 

All tabs of the Design Technology dialog (except for Wires and Rules) have buttons to 
Export To/Import From CSV format files. The exported files can be easily edited in Excel 
for example, then imported back in with the new values. 

During import, checks are made to ensure the right number of fields are imported and values 
are legal.   

 

Once exported into Excel, the file looks like this:  

 

All values are written in design units. If you change the Units in the CSV file for one of the 
values, to 1mm say, the imported value will be converted to the current design units. 

The CSV file can also be edited in a text editor but care must be taken to retain the correct file 
formatting. 

Changing Colours 

Using the Colours dialog, you can customise the colours of almost all the design items. 
Although the PCB dialog is shown below, the Schematic one is more simplified as it has no 
layer structure to it.  
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To change the colour, double-click on the colour cell in the grid and pick a colour from the 
list. Each of the colour drop-down lists has a More… entry at the bottom. When selected this 
displays the standard Windows Colour selection dialog to allow a custom colour to be 
defined. 

Multiple custom colours may be defined and will be retained in the Windows colours dialog. 

Save & Load Colour Files 

Colour settings can be saved to disk and later re-loaded, allowing you to set up commonly 
used groups of settings that you can then use to switch quickly between different ‘views’ of 
the design.  

You might, for example, set up two colour files that only show top and bottom layers 
respectively, and use these to switch between a top and bottom view of your board.  

You may also use the Colour Files bar to quickly switch between colour files. 

To save the colour settings from the Colours dialog, click the Save button. When the file 
browser dialog opens, enter a name for the colour file and press Save. 

To load a previously saved colour file, click the Load button and use the file browser choose 
the correct file. When the file is loaded, the design will be redrawn using the new colour 
settings, and the colours and visibility shown on the dialog will be updated to match. 

Selectable Items 

For most design items you can set how selectable items are. This is useful for restricting what 
may be picked to the particular type of items being worked on while still displaying other 
relevant parts of the design. It is available in PCB, Schematics, PCB Symbol and Schematics 
Symbol designs.  
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On the Layered and Layer Spans tab, an additional Selectable row and column allow 
selectability to be set for each item type or entire layers respectively. Each entry in these, like 
the existing ‘Visible’ row and column may be toggled between Yes and No as shown below:  

 

True Width display status in PCB 

To aid the de-cluttering of PCB designs, you can switch on and off the true width of 
individual items. When switched off, the item is shown as a centreline object. The exception 
to this are Pads and Vias which are displayed as their outer edge (as an outline) and the pad 
diameter inside.   

There are two extra fields next to Display and Selected named True Width. You can switch 
the true width of items on and off in columns for each layer or in rows for each item. For 
example, you could switch the true width off of all items on the top layer to make the lower 
layers more prominent. Likewise, you could switch the true width off of all pads in the 
design, making the tracks more prominent while routing. 

 

With True Width switched off in the Colours dialog, you can also display items as ‘hollow’ 
rather than centre line. To enable this feature, check the Hollow Tracks when True Width 

off box in Preferences and Display.  
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Tracks appear as ‘hollow’ when enabled: 

 

 

 

In comparison, without this option selected, tracks appear as centre-line: 
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You can also switch the True width on/off quickly by pressing the Ctrl key and selecting the 
layer name in the Layers Bar. 

 

Force All Colours On 

Switches are available in the Colours dialog, under Settings & Highlights: 

• Force Everything on 

• Force All Value Positions on 

These switches work at a high level so they override all other switches in the Colours dialog. 
However, once used and set unchecked again, the previous colour settings are totally restored. 

 

 

Use the Force Everything check box to force everything on so that it is visible, true size and 
selectable. This will be everything except Values which has it own check box. 

Use the Force All Value Positions check box to force all Values in the design to be 
displayed. 

Working with Values 

What are Values? 

A value is an attribute that can be attached to a component to enhance the information that 
this item contains. The value is a Name that contains a text string (a piece of information).   

You can use values on components for example, the value name could be Height with a value 
of 2mm, or Tolerance with a value of 1%. 

Adding or Editing Values 

Values can be added or edited using the Properties dialog of the component found on the 
context menu and the main Edit menu, the Values dialog of a component on the context 
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menu, and from the Component Values editor on the Settings menu. For a library, the dialog 
is accessed by clicking on the Values button on the Components page o the Libraries dialog. 

 

Using the Properties dialog 

The Component Properties dialog has a tab for adding and editing Component Values.  

Once a value has been added using the Add dialog, the window will indicate three pieces of 
information. The check box (selected by you) will indicate whether that value is displayed in 
the design or not (a value can be added but not displayed). The next item is the Value name, 
for example Height, followed by the value itself, in this example 3.2mm 

 

When you click the OK button, the values in this dialog are applied to the component(s) in 
the design. 

The Values dialog is much the same as the Properties dialog but without the extra 
Component tab. When displayed in the design the values would look something like this: 

 

The position of the values is initially relative to the 
component name but these can be moved 
independently as required. 

 

���� To position and add values 

1. Select the component to add the Value to.  

 

2. Values must already exist on the selected Component. Use Properties or Component 
Values editor first or add them to components in the component library. 

3. Select the Value Position option from the Add menu. 
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4. Position the default name – Design1 (Design1 will be the design name before it has been 
saved). 

 

5. Once positioned, select the value name and right click (you can also double-click on the 
name). 

6. From the context menu, select Properties. 

7. From the Values tab, switch on and off the values you require to view in your design. 

 

8. To switch all Values on or off, you can select Values to display from the Text tab. 

 

9. Click OK to exit. The result might look something like this. 
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10. Use the Add Value Positions option to show more values on the component. 

Tooltips Displaying Values 

If you prefer not to show Values names in the design, Design Tooltips can display user-
specified Values (Attributes) when hovering over components. The Value Names to display 
are configured on the Display page of the Preferences dialog.  

 

A Values check box and button appear on the Preferences dialog: 

 

From the Values button, you can select the Value Names to display on the tooltip. 

 

The Up and Down buttons will allow you to choose the order in which the values appear on 
the tooltip. 

 

Pressing the Sort button will sort the list in alphabetical name order if required. 
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Using the Add button, choose the value required from the drop down list or type the value 
name you wish to use. 

 

Drag and Drop Values 

You can drag-and-drop one or more text files, or a block of text from a text application such 
as Word or Notepad2 to add Values to Components. This feature can be used from the Values 
tab on the Properties dialog for Components and the Values page in the Component Editor 

(available from Libraries).  

 

It is hard-wired to expect the attribute text in name=value form, using = as the separator. Any 
line of text that does not fit with this form will be ignored. Any name that already exists, will 
have the value replaced without prompt or warning. The syntax will accept the name=value 
format with or without spaces but nothing else. 

Using Drag & Drop Values onto a component 

There are two methods to drag and drop Values onto a Component: 

1. Using the Windows Explorer, you can select a text file containing legally formatted 
values text and drop it onto the Values tab of either the Component edit dialog or the 
Component Properties dialog, or; 
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2. Select portions of the required text from the file, again, formatted using the expected 
syntax, and drag it out of the text file and onto the Values page for the desired item, such 
as this below: 

Note: Copy Paste does not work for this function, the text must first be selected, then 
dragged to the appropriate dialog.  

Also note that the standard Windows Notepad program will not allow you to drag and drop 
individual text items due to the technical limitation of this basic program. Other enhanced text 
programs such as MS Word or Notepad2 etc. do however allow this functionality.  

Using the Component Values Editor 

The Component Values editor on the Settings menu displays a list of the components, and a 
table or ‘grid’ of all the values on those components. For a design, the name shown on each 
row is the reference name of the component; for a library, it is the component name itself.  

As well as the grid, there are a set of buttons down the right-hand side of the dialog that allow 
you to modify the values. 

 

The cells in the table are colour-coded to show you the status of each value type. Four 
different colours are used, described below. The default colour of each is also shown, 
although you can change the colours used by clicking the Colours button on the dialog. 

• Undefined (cream) - this value is not present on this component  

• Empty (pale green) - this value is defined, but has no text  

• Hidden (pale blue) - the value is defined, and has text, but is not displayed in the 
design  

• Visible (white) - this value is defined, and has text, and is visible in the design 
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As well as changing the colours, you can also resize the dialog by dragging the corners or 
sides. The new size is remembered so the dialog comes back the same size next time you open 
it 

To change the actual component values, you can use the buttons down the side of the dialog, 
click the right mouse button in the table and use the pop-up menu, or use the keyboard to type 
text directly into the grid cells. 

Any changes are done to the selected part of the table, you will need to select the required 
value or values first and then click the appropriate button. For example, to set all the values 
for a given component to be visible, click the left mouse button in the first 'cell' of the row for 
that component, then drag across to the last cell and release the mouse button. 

 

Then click the Show button to set all those values visible. 

 

The cells will change colour accordingly. 
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Chapter 7. Creating Schematic Designs 

Overview and Getting Started  

Before we get started, you should be aware that a PCB design can be created straight into 
PCB design editor without creating the Schematic design first. You can also use a netlist from 
some other system and load this into the PCB design editor. 

The working concept of the Schematic design editor and the PCB design editor are 
fundamentally the same. There are some small technical differences in the two editors; 
Schematic components are connected together by lines known as connections, rather than 
connections/copper tracks as they are in PCB, and there are no equivalents to PCB pad stacks 
in Schematics. Obviously, the PCB design contains ‘layered’ items whereas the Schematic is 
‘flat’. 

The difference between Tracks and Connections is that Tracks are physical connections made 

in copper and used in the PCB design editor, whereas connections are logical connections 

between items only. The confusing part is that tracks also have underlying connections (the 

'rats nest') until converted to copper tracking. 

Starting a New Schematic Design 

To use a Project file or not? 

When starting a new Schematic, you may need to think about whether you need to use a 
Project or not. The decision for using a Project is governed mainly by how many Schematic 
sheets you intend creating and whether it has hierarchical blocks or not. If there is more than 
one sheet, then create a Project first and add all the design sheets to this Project. If there is one 
sheet, and only ever will be one sheet, you probably won’t need a Project. A Project file 
enables you to maintain unique component and net names throughout all of the Schematic 
sheets without any duplications or errors. 
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The Project file may contain many Schematic sheets but only one PCB design. Technology 
files are independent of the Project file and are used with the design files. A schematic design 
may also contain hierarchical blocks of ‘lower’ level functionality, these would also be 
contained within a Project file. 

Starting the design 

You can start your design using one of two methods; using the New, Schematic Design 
dialog or New, Wizard, Schematic Design. The New dialog for both options is located on 
the File menu. 

Using the New dialog 

The New, Schematic Design dialog will start a new Schematic design using just the 
Technology File. You can also elect to use no Technology File, [None], but we don’t 
recommend this. 

 

There are two Technology files supplied for Schematic designs, Default.stf that uses a white 
background and Default (Black).stf that uses a black background. You can of course, change 
the colours as required from within the Schematic editor. 

You can also elect to add the new design to the Project file using the Add To Project check 
box and choosing its name. 

If the design is new and no Project file exists, use the Browse button and locate the folder 
required. Now type a Project name and a new file will be created when you click OK. If one 
exists, select it by name. 

Click the OK button to start the Schematic design editor. 

Design Options for Schematics 

If you start a new Schematic design using the standard settings and one of the supplied 
Technology files, there isn’t anything else essential to set up in order to get started. However, 
you can edit the user defined options in the Preferences dialog, the Defaults, the Units dialog 
and the Folders dialog. These are discussed in detail as used throughout this guide. 
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Setting Up a Schematic Technology 

Styles 

The diagram below shows the relationship between the major design items Styles. 

The styles used in this dialog should be as required for your drawings and for any company 
standards that may exist. When choosing styles, consider how the drawing may be finally 
printed or plotted. The thicknesses used will have an impact on the look of the drawing. 

 

Pads styles are used to define look of component terminals and junctions, where two 
connections are truly connected. Connections may overlap each other but will not be 
electrically connected.  

Text is used to contain the styles of text items within the design.  

Lines styles are used for the shapes and outlines of the symbols. They can also be used to 
define any detail within the drawing such as the drawing border.   

Connections styles are used to define the thickness of ‘real’ connections within the design. 
These are not the same as Line Styles and should not be confused. 

Net Names and Net Classes 

When creating a new design, you should ensure that each Net Name on the Nets dialog has a 
Net Class associated with it. It is this association that will give you your track thickness in the 
PCB design. The Net Class dialog in the PCB design also has track and via styles associated 
with it. 

When translating from the Schematic to the PCB design (using the Translate To PCB 
option), the Net Class name used on a net is also transferred, this then picks up the physical 
characteristics defined in the PCB Net Class section. 
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Without a net class name, the net class used will be that of the Defaults, Net Class dialog. 

Net Names and Net Class names are described in more detail in the previous chapter. 

Drawing Borders 

As well as Styles and Colours, Technology files can also contain drawing blank information 
and text. These are added as shapes and text from the Add menu. Drawing blanks that are 
created using a component cannot be saved in the Technology file. See below. 

Changing the Colours of the Schematic 

All of the colours within a Schematic design can be changed using the Colours dialog. This 
dialog has been discussed in the previous chapter. 

The diagram below shows how the design is constructed using different colours for different 
design items.  

 

Use the small arrow on the right side of the list box to drop down a colour palette when a 
colour change is required. 
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Some of the switches are slightly less obvious that others. 

Connected Pins - Use the Connected Pins option to control display on component pins. 
Normally you would have the Symbol Terminals switch on and the Connected Pins switch 
off so that you only see the cross on unconnected pins. This makes it easier when adding 
connections to the schematic to see which pins are left to be connected.  

The Dangling Connections option allows you to highlight unfinished connections. With the 
Show All Dangling Connections option checked, any connection which is not connected at 
one end is considered dangling. With the option unchecked, only such connections which are 
the only instance of that net on the current sheet are considered dangling.  

Adding Drawing Borders  

There are two methods of adding drawing borders to your Schematic design; using a 
component, or by drawing in the border using the shape drawing tools.  

 

You will find a number of standard drawing borders in the component library, schema.  
See the next section in this chapter on how to add components to the design. 

If you wish to add a drawing border using shapes, add the shapes to the design using the Add 
Shape options from the Add menu. The drawing border can be further enhanced by using free 
text from the Add Text option on the Add menu. Both Add Shape and Add Text are covered 
later on in more detail in this chapter. 

Adding Components  

Once components have been created in the appropriate library, they can be added to the 
design using the Add Component option from the Add menu or by using the Add 
Component icon on the Schematic Design toolbar. 

During the Add Component process, you may decide to use the Component Bin, you don’t 
have to but it does help simplify the design area by keeping components out of the way until 
needed. 

Using the Component Bin 

The Component Bin bar has been described in detail in the previous chapter. 
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The component bin provides you with an off-screen location for holding components before 
placing them on the design, it is also used for holding unused gates on components that have 
more than one gate (called heterogeneous components).  

Schematic components can be added directly to the component bin using Add Component and 
interactively by dragging components from the design into the bin. 

When using the component bin, if you have components that are connected, if you drag them 
into the bin the connectivity will be lost when you bring them back out again. Of course, if 
you do this by mistake, you can use Undo to recover them. 

 

Components placed in the bin will also be transferred to the PCB design during Translate To 

PCB. 

Using the Add Component dialog 

Once the design preferences have been set and the drawing border added, the Schematic 
editor is ready for the design to be created.  

One of the first major processes is the addition of components into the design; you are 
provided with the Add Component option for this purpose. 

Components and Symbol contents are created and saved into corresponding libraries. The 

component entry contains a Component name, a PCB Symbol (Footprint) (optional if 

translate to PCB isn’t required) and a corresponding Schematic Symbol or multiple symbols 

if the component represents a multi-gated component. 

The Add Component dialog allows you to find and select components from your component 
libraries. 
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The dialog allows you to choose the library, find a component, chose the component, to 
preview it and to add it to the design or component bin. 

The Library list allows you to choose the library to select components from. From the drop 
down list, you can also choose [All Libraries]. This will display the components from all of 
the libraries found in the search path defined in the Library Manager under Folders. The 
[Recent] list will display all component names that have been recently added to your design. 

Once a library has been selected the Component list will update with all the components in 
the selected library. You can locate specific components by using the Find button and the 
options within this. The Find dialog allows you to search libraries and enter names based on 
wildcard names. This dialog is described in more detail. 

The Add button will place it on the end of your cursor ready for positioning in the design. 
You will notice it will snap to the screen grid while placing. You can adjust the snap mode 
using the <H> key and by selecting one of the snap modes from the context menu. 
Alternatively, you can use the Add to Component Bin check box to send the selected 
component directly to the component bin. The Count entry will allow you to specify multiple 
copies of the selected component. 

The Preview button can be used to show you the component before it is placed on the design, 
it also shows you a preview of the PCB Symbol. Once you create your own library you will 
probably not use this unless you need a reminder of what they look like. 

 

Using the Find dialog 

When selected, Find displays a dialog that allows an item name to be found in the libraries. It 
then searches the libraries for the given Component/Symbol and selects the appropriate 
library and item. It searches the current library first, then all the libraries in the library 
directory. This has been specified in the Preferences dialog under Directories. 
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Matching on the library item Name can be done in three different ways:  

• Is Exactly: only matches items with exactly the name specified  

• Starts With: only matches items that start with the given text  

• Contains: only matches items that have the given text anywhere in their name  

The Number of terminals/pads field allows you to limit the search to match only those 
library items with the specified number of pins. 

For the Value field, when searching for components, you can also choose to search for items 
that have a particular value. Leave the 'is' field blank to match all items that have this value 
regardless of its actual setting, or enter the desired setting to search for a specific value.  

On pressing Find, there may be a delay whilst any library index files are updated. Having 
done this, the libraries are searched for matching items. Any matches found are listed on the 
dialog, showing their name and library file and for components their 'package' as well.  

To select the desired item, simply click on it in the list. As you select the item, the 
corresponding 'master' dialog (Libraries, Add Component, etc.) will update its details and 
preview to show you the selected item. To close the Find dialog, either click on Close or 
double-click the required library item in the list. 

Value 

When searching for components, you can also choose to search for items that have a 
particular value or values. If you specify more than one value, only those components that 
match all the value criteria will be displayed. In other words, the value checks are combined 
with 'and' and not 'or'.  

If you want to match items that have a particular value regardless of its actual text setting, set 
the 'operator' to 'Contains' and leave the value text field (the last field on the line) blank. 

Interactively positioning components 

Once the first component is positioned in the design, press the Esc key to cancel the addition 
of the next Component. Each time you add a component, notice that the component reference 
Name has incremented by one to the next number available automatically. You can overwrite 
this name and name stem if you wish but you will not be allowed duplicate component names 
on the same design, you will be prompted with a message box informing you of this. 
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While adding the component you can use the context menu to manipulate the component.   

 

From this dialog you can Flip and Rotate the component to give it a more precise position. 
These options are also available by using shortcut keys. 

The Styles used 

The values in the styles used for text, pads, terminals and shapes in the symbols from the 
library are retained when adding an instance of the component to a design. In this way the 
component will look exactly like it does in the library. This is managed by copying the styles 
from the symbol into the design. If the style name is already in the design, but contains 
different values, a new style name will be used. 

Introduction to manipulating Components in the design 

A component may be selected by clicking on any part of the outline or by pressing <Shift> 
and clicking on any part of the component. If a placement reference or any pin names or 
numbers are inadvertently selected, an attempt to drag the component will move the text 
instead. If this is a problem, use <Shift>-click to select the whole item.  

Moving is done by dragging and dropping. Snap modes are adhered to at all times but can be 
changed by using the snap mode shortcut <H>.  

Once a component is selected, there are several entries available on the context menu: 
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To rotate the component, either right click and select Rotate, or use the shortcut key <R>. 
From this menu you can also choose an alternative angle for rotation other than the default 
angle set for the single step rotation command.  

Flip (shortcut <F>) will mirror the component. On the odd occasion that this is required in a 
Schematic design it will work by mirroring around the component origin. This has been 
discussed in detail in the previous chapter.  

Each component in the design of the same type is referenced from the first one added. This is 
a copy of the item in the library that makes it independent of any changes to the source 
library. The Update Component function is provided to force a new definition into a design 
from the library. This intelligently replaces the component in the design with the new one 
from the library without affecting the connectivity.  

With connected components, you may also wish to ‘unconnect’ them, to change the 
component perhaps. For this you can use the Disconnect From Net option. This will keep the 
component in the same location but will disconnect all connections attached to it. 

The values associated with a component have a variety of uses. Firstly, they can obviously be 
used to associate a supplementary label with the placement reference. As this is most 
commonly a value, it gives the function its name. Secondly, it provides a convenient way of 
specifying entries for export to parts lists, etc. These can be accessed through the Properties 
dialog or the Values option, both on the context menu. 

 

Using Decoupling Capacitors  

Decoupling capacitors, or by-pass capacitors as they are also known are usually used adjacent 
to ICs to ‘decouple’ the voltage rails to that device. These are usually shown as a ‘string’ of 
capacitors between the corresponding voltage rails without being shown in the proximity to 
the device they are intended for. In most cases the relationship between decoupling capacitors 
and the ICs is only that each IC is required to have a value (10pf for example) capacitor. In 
instances where there is a close relationship between the two, you should position the 
capacitor next to the device.  
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The picture above shows how the Schematic might look. This example shows positive, 
negative and 0V power rails. 

Adding Connectors 

Connectors are created as ‘normal’ components with associated Schematic Symbols and PCB 
Symbols, there are no special additional items to create.  

Your only consideration for connectors is whether you have one multi-pin Schematic symbol 
representing a PCB footprint, or whether you have multiple single pin Schematic symbols 
representing a PCB footprint. The decision is based on whether you want to position the 
different Schematic Symbols across the design or have them clustered in one place as you 
would with a single Schematic symbol. 

 

The Add Component dialog above shows an example of a single Schematic symbol. Where a 
connector Component is defined with multiple Schematic Symbols, each pin of the connector 
is added to the design individually. The creation of connectors is covered in a later Chapter on 
Creating Components. 

Reloading Components 

Once components have been added to the design, you may need to change the Schematic 
symbol or the component definition and then reload it into the design.  

You can reload components individually, or the whole design or by browsing and selecting 
the ones to update. There are three commands on the Tools menu under Update Components 
to do this. 

You can also select a component or multiple components in the design then select the Update 
Components option from the context menu if you wish. 

The dialog you are presented with allows a number of key functions to be performed.  
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You are presented with a list of all the components in the design, or across all sheets in the 
design if invoked from a Schematic within a Project.  

This list shows you the timestamp on each component in the design as an initial guide to 
which library items are currently in use.  

You can toggle the 'selected' state of each component, or use the All/None/Selected buttons to 
toggle all the states, as a quick way of choosing the components to be updated.  

All components that use the same Component or Symbol will be reloaded, even if only one 
item was selected. You cannot have two different versions of the same Component or Symbol 
in the design. 

Adding Connections to the Design 

Connections are added to a Schematic design to make electrical connectivity between 
component pins. You can also add connections to other connections forming junctions or tie 
dots as they are sometimes called.  

You are also allows you to add connections that don’t connect to anything. These are called 
Unfished or dangling Connections and are useful during the design process but should be 
resolved before the translation to the PCB design. You may wish to start a connection path 
from one device without knowing where it connects to. Leaving it dangling will allow the 
path to be created ready for connection late on. 
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The Undo option can be used at any time to undo connection. While editing a connection, you 
can also use the <Backspace> key to unto the last connection segment. 

Properties of a Connection 

When you first start adding connections you can predefine the connection Width using a style 
Name (the physical size that will appear on the plot), and the Net Class. The Net Class is 
used to create a relationship between the logical Schematic connection, and the physical track 
thickness that is used in the PCB design once translated (see below). 

There are two items to define in order to use the connection width that you require. The first is 
the style of the connection, the Name and the Width. These are edited in the Design 

Technology dialog under Connections. You can assign a sensible name for a connection 
style and a real width. A value between 5 and 8 thou is normally acceptable for most modern 
laser printers but you may decide that you want the connection on the paper thicker or fainter. 

 

The next items to define are the defaults for the Connection and the Net Class. These are 
used to give the new connection a thickness (Connection) and a Net Class name for use 
when translated into the PCB design. Both of these items can be found on the Settings menu 
under Defaults. 

As previously discussed in this chapter under Setting Up A Schematic Technology, the 
connection also carries a Net Class. This is used when the design is translated to a PCB 
design where it then picks up the PCB connection’s physical properties. With the Nets 

selection, you choose a Net Class name from the drop-down list. 

 

The Connections dialog is a list of Connection style Names with a given Width. The name 
chosen from this list will be the one first used when adding connections to the design. 
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When a connection is added to the design, it now has a drawn (and plotted) thickness, a Net 
Class Name and a Net Name (defined by you or a default net name). 

Properties dialog 

You can view and edit the connection’s characteristics using the Properties dialog.  

  

Changing the Connection style 

During the addition of a connection you can change its style very easily.  To do this just right 
mouse click and select Style from the context menu. You can also do this by using the 
shortcut key <S>. 

Adding Connections 

Connections can only be made by using the Add Connection option from the Add menu or 
from the Add connection button on the Schematic Design toolbar, or by double-clicking the 
mouse on an electrical terminal and then moving the mouse to draw the connection. 

Double-click and move methods of adding connections are ‘one-shot’ modeless operations. It 
is fast but once the connection is completed, you are automatically put back into Select mode 
again. The Add Connection option allows you to continue ‘stitching’ in multiple connections 
until you exit this mode. 
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Connections cannot be added by adding a line item or bus item, they have to be proper 
connection items (using Add Connection). Likewise, just placing Components so that the 
connection points touch will not form a connection. Components must also have electrical 
terminals on them to connect to.  

To check that a connection really is a connection, select it in the design and view the status 

bar at the bottom of the window. If you have used a connection the status bar will say 

Connection. 

However, once a real connection has been made, moving that component will move the 
connections with it, a truly connective design structure is used throughout. You will see and 
understand the power of this as you design with the product. 

When adding connections, each click of the mouse will add a corner, from this you may make 
a direction change. 

You will also find useful a switch in the Colours dialog which allows you to show 
Connected Pins only. When selected, only pins that are not connected to will show their X 
terminal position. 

In Schematics, it is usually easier to add the connections if the Segment Mode is set to 
Orthogonal. This is set in the Preferences dialog Interaction tab on the Settings menu. The 
Segment Mode can also be changed while in Add Connection mode using the Segment 

Mode> option on the context menu.  

 

From this menu you can choose various options. In Schematics the Orthogonal mode is 
mostly used but other modes are available. 

 

 

When adding connections, you can use the Grid Snap 
mode. While the connection is dynamic on the end of your 
cursor, click the <H> key. From the context menu you can 
select any of the grid settings and named grids. 

Make sure that the connection begins and ends exactly on the electrical pins/terminals (using 
the Grid Snap mode makes this easier).  
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Adding Net Names to the connections 

All connections are allocated a  default net name and net class. It is a good idea to give 
significant signals a net name instead of the allocated name in the form a of number, such as 
N0022. It may also be desirable to reallocate the net class, by default each new connection 
acquires the same net class as the previous one. 

Multi-sheet Schematic projects use common net names for the links that join them together. 
All net names are automatically associated with the Project and after first use can be selected 
from the drop-down list on each sheet rather than being remembered and re-typed. Predefined 
net names can also be picked from the external technology file associated with the design. It is 
worth the slight extra effort using meaningful net names rather than numbers. 

Once a connection has been started (or once it is added to the design), you can give it a net 
name. It you don’t give it a ‘user defined’ net name at the start, an ‘auto-named’ net name will 
be assigned for you. These will be sequential and unique, and will start with N, (N0010, 
N0008 etc.). They can still be renamed afterwards using the Change Net option. 

The Net name does not appear automatically on the drawing, but it does always appear in the 
Status line at the bottom of the screen and can be viewed when the connection is selected. If 
you need to change the name of the net itself there are a number of methods for doing this.  

You can use the Properties dialog from the context menu and Net page for a selected net, or 
you can use the Change Net option, also on the context menu.  

 

The net name can also be changed from the Nets page of the Design Technology dialog on 
the Settings menu. This lists all the nets in the design and is shown below: 
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Displaying Net Names on the design 

To display the net names on the design you should select the net. From the context menu 
select the Display Net Names option. You will notice the net names appear on the Symbol 
terminal on one end of the connection. The terminal used for the name to be displayed is the 
closest terminal to the point on the selected net. 

If you select a Component, you can also display all the Net Names associated with that 
component for connected pins. Use the Display Net Names command from the context menu 
with the component selected to do this. 

Dangling Connections 

Dangling connections are connections that start on an electrical point in the design but finish 
in ‘free space’. You may do this naturally as you design so that the aesthetics are worked out 
as you design. 

If you wish to add a connection and leave it dangling, double-click to end it in free space. To 
continue using that connection, double-click on the end of it and continue drawing in the 
connection path. You can also continue using it by using the Add Connection option and 
select the end of the dangling connection as the start point. 

There are two features that will help you when using dangling connections, the first is the 
Unfinished Connections colour setting found on the View menu that can be chosen these 
connections, and the second is the Unfinished Connections Report which is located on the 
Output menu under the Reports option. 

Starting a connection on a bus 

To start a connection on a Bus (Busses are described in more detail later on in this chapter) 
you must use the Add Connection option. You may however end on a bus using the 
modeless method. 

Disconnecting connections from terminals 

If you make a connection between two terminals and you decide that one end should have 
been connected to a different terminal, you can move it using the Disconnect End Con 
option.  

To use this, edit the end which you wish to move (double-click on the connection). Once in 
edit mode, right click and select the Disconnect End Con option from the context menu. The 
connection will now be on the end of your cursor ready to connect to the new end point.  
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The context menu shows the Disconnect End Con option: 

 

Showing Junctions over terminals 

If two connections are attached to a component pin, a junction is only drawn if the Display 
Implied Junctions on Pads switch is on in the Preferences dialog under Schematic 
Interaction. By default, this is switched on. This only affects junctions on pins and not 
normal connection junctions.  

 

The picture below shows how (on pin 1) the junction is shown on the component pin. 

 

Inserting components to split a connection 

Once a connection has been added to the design, it is possible move or add a component over 
this connection and to split the net. This is useful if adding components such as resistors or 
capacitors to the design.  

The situation can only occur with 2 pin components and where the connection is orthogonal 
horizontally or vertically. 

First the component is selected or added, and moved over the connection. 

 

Once the component has been moved over the connection and released, a warning dialog is 
displayed. This will warn you that two nets will be created and the name of the split net. 
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The finished result looks like this. 

 

Dragging off Pins to Start Connections 

An easier way to add connections is by ‘dragging’ the connection off the pin to start it. When 
enabled in the Preferences, Schematics Interaction tab, dragging from an unconnected 
component pin in schematics will start a new connection from that pin.  

 

To aid the display of a legal landing site, finish markers can be enabled through the Colours 
dialog. 

 

To use this mode, set the Finish Markers to on.  
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Drag off a source pin to start a connection or track, draw your corners and then move the 
cursor over the target pad. The Finish Markers will highlight to show that the connection can 
be finished there and the connection will finish.  

 

Adding Nets that aren’t shown on the design (Implied Nets) 

When creating connectivity in the Schematic design you may not wish to show all the 
connections. Like the concept of a bus, or a power and ground nets, by using net names on the 
terminals of components, implied connections can be made. There must obviously be two or 
more net names of the same name in the design to make the connectivity. 

 

The design above shows how the connectivity might look by using Net Names and implied 
connections, and physical connections. On the net marked A1, the net name has been applied 
directly to the pin using the context menu option Add To Net. For the A2 net name, a small 
dangling connection has been shown. This might be used to clear the component to make the 
connection clearer without drawing in the whole connection across the design. The dotted 
lines show the implied connections on this picture only, they wouldn’t appear on the real 
design.  

When the design is translated to PCB, any nets with the same name (even though there isn’t a 
physical connection drawn) will be connected together. This helps keep the Schematic free 
from connections that don’t need to appear. Likewise, this would happen also if two nets had 
the same name on different locations of the Schematic but weren’t actually supposed to be 
joined. You can use the Highlight Net option to view the entire net. 

If you really wanted, you could create the whole design using this connectivity style. 
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Naming and Renaming Nets 

At any point nets can be named using a user defined name or renamed from an existing name. 
When a connection is added to the design it will be assigned a ‘system’ name, such as N0009, 
N0001 etc. These names are unique but can be changed to one of your own during the add 
connection process or afterwards as you wish.  

Renaming a net 

A net name can be changed by picking the connection and selecting the Change Name option 
from the context menu. 

 

From the Change Net dialog, you can choose an existing net name to use or type in your own 
name into the Net Name box. 

Connecting nets together 

If two connections with different net names are connected together, the resulting single net 
will retain one of the original names. In this situation you should check the net name on the 
Status line at the bottom of the screen and change it if required. Use the Change Net option to 
do this. 

Joining Nets 

Where named connections are connected together, the Join Nets dialog will be displayed.  
This will inform you of the changes that will take place and to the name of the merged net. If 
the net name is not to your liking, use the Change Nets option to rename it.  

 

For connections where one or both of the nets uses a default net name, no warning dialog will 
be displayed. 
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Power and Ground Symbols in Schematics 

Power and ground supplies can be shown in various ways; they can be shown by adding 
connections or by using power symbols, or by simply naming the terminals using implied 
connections.  

 

The most normal way is to use small power and ground symbols that use named nets to give 
implied connectivity. 

Where there is a requirement to show power connections a symbol can be used. The symbol 
has no electrical significance and is not translated to PCB, so it is purely there as cosmetic 
representation on the final Schematic drawing. The importance in the symbol will be the net 
name used in the terminal of the symbol or the net attached to it. 

These symbols are created as Schematic only components in the library. The supplied 
libraries contain a selection of basic power and ground symbols as well as generic symbols 
that can be copied and adapted for other power symbol representation. Because these symbols 
have a Schematic symbol and component representation but have no PCB symbol assigned to 
them, this means they will not be translated to PCB. 

Alternatively, where terminals require power connections, these can be named with a 
nominated power name (using Add To Net from context menu) and all nets of that name will 
be connected together during Translate To PCB.  

Component Editor 

Within the component editor you can use the Net Class Name field for the signal pin to define 
the name of the net that will be pre-assigned when the component is added to the design. This 
is used to auto-connect this pin to the given net / net class when the component is added to a 
design. 

Cross Sheet References  

As with power and ground symbols, cross sheet signal references are purely cosmetic. They 
are created as Schematics only components that have a Schematic symbol and component 
representation but not PCB symbol assigned to them.  

When this type of symbol is used on a sheet, it is the net name that carries the significance not 
the symbol. The same net names used will be connected together when the Schematic design 
is translated to the PCB design. 



118   Creating Schematics 

 

For the example above, all nets called A2 will be connected together regardless of which 
sheet they are on. The cross sheet reference is a neat symbol that denotes the connection. 

Page Links 

You can use any piece of text which names another sheet in the Project as a page link. The 
text must be the schematic design name and must have the .sch file extension, for example 
PSU.sch. The referenced design also must exist in the current Project. The name format can 
also contain a comma to create a list of sheets, for example, PSU.sch,Memory.sch,FPGA.sch 
You could add a Value, such as PageLink, to an item and reference the sheet(s) as the value. 

 

The value must be displayed in order to select it to use the Open Sheet option from the 
context menu. 
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Where the net appears on multiple sheets, a dialog will be displayed from which you can 
select the sheet to browse to. 

 

Page Link Components 

This can be used in conjunction with the Nets where sheets are used attribute (see above) to 
create page link components. Add the Nets where sheets are used attribute to the Schematic 
Symbol to provide the link reference. 

 

Using Busses 

A bus is a shape that represents a collection of signals on the Schematic design. Instead of 
drawing all the connections across the design and connecting them to every pin required, you 
can make the design less cluttered by using busses. You can add connections from an 
electrical pin to the bus that carries the signal.  

 

Open/Closed Busses in Schematics 

There are Open and Closed busses. 

An open bus means that it can carry any net names. You simply attach the connection to the 
bus and the bus inherits that connection’s net name. A closed bus is where all the net names 
are predefined in the bus (using Properties). When you add a connection to the bus, you are 
prompted with a dialog requesting the net name selected from a list.  

Closed Busses 

This is the process for defining a 'Closed' bus with the net names pre-defined.  
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���� To define a Closed bus 

1. Using the Add Bus option from the Add menu, draw the shape of the bus. The Add Bus 
uses an open polygon shape. 

2. You should use the Segment Mode of Mitre to add the mitred corner to any corners of 
the bus shape. 

3. Exit Add Bus by double-clicking the mouse. 

4. Select the bus and select Properties from the context menu. 

5. Select the Add Net button. 

 

6. At the bottom of the dialog in the New Nets boxes, enter the net name range required in 
Name and to. 

 

7. You can add a name range by entering the first and last numbers in the sequence, or a 
single name in the Name box and then selecting Add to List. This is the only place you 
can add bus net names for use with this bus (now a closed bus). 

8. You must use Add to List to add the name to the list so that it can be selected and added 
to the bus. 
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9. Select the names required from the list for the bus and click OK. 

10. If you have missed a net name or wish to add others, enter the Add Net to Bus dialog 
and select or add the net name as before.  

11. Press OK to exit the Properties dialog once all the net names are visible in the display 
window. 

12. The dialog below shows the net names A0 to A15 entered. 

 

Adding Connections to busses 

���� To add a connection to a closed bus 

1. You have defined a closed bus (in the above description), now when you add a 
connection from a terminal and click on the bus to finish, the system will give you the 
choice of which net name to choose (taken from the bus net names list just entered). 

2. Select one of the names and press OK or double-click to add it. 
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3. Any connection can be added to the bus but only one of the names from the list, no other 
name can be used without adding to the Bus Properties dialog first. 

4. If two connections are added and both use the net name ADD1, for example, the 
Translate to PCB option will connect them both together, in other words the connection 
is implied by the name of the net. 

Bus Net Names 

When connecting to a bus you can choose to display the net name or leave it not shown. There 
is a check box in the Preferences dialog under Schematic Interaction that sets this, by 
default it is switched on.  

 

The picture below shows the net name on and off for the three connections. 
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In summary: 

• Busses are cosmetic and have limited intelligence. 

• Busses can be open or closed - closed is where the net names are predefined and internal 
to that bus. 

• Connections are made by clicking on the bus which inserts a 45-degree bus terminal. 

• Connectivity is made though implied net names, e.g. net names that are the same. 

• Busses can be named, the name displayed and busses located using the Goto bar. 

Adding more Sheets to the Project 

If more than one person is working on a design, you may split the schematic into a number of 
design sheets. When the sheets need to be combined you can add them to a Project. For 
multiple sheets you’ll need to have them all in a Project so that they can be translated into the 
PCB design.  

���� To add a schematic design to a Project 

1. You should be on the Project page (if a Project has been defined). If a Project hasn’t 
been defined you should create one. 

2. An existing Project might look like this: 

 

3. To add an extra sheet to it you must be showing the Project view (as above). 

4. Click on the Project menu and select Add Files To Project. This dialog is displayed: 
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5. You can add Schematic sheets (designs) or a PCB design to the Project. You can only 
add one PCB design though, whereas you can add multiple Schematic designs. 

6. Select the required design and select the Open button. 

7. Your Project will now look like this. The extra Schematic design sheet – Div2.sch has 
been added. 

 

8. Now when this Project is translated into a PCB design, Div and Div2.sch will become a 
single PCB. 

���� Alternative method to add a schematic design to a Project 

1. As an alternative, you can also right click with the cursor over the Project document tab 
at the bottom of the design window and select Add Files from the context menu: 

 

2. From the browser, select a design file to add to the Project. Other types of files, reports 
or Parts lists etc. can be associated with the Project as well using this option. 

Splitting components across Schematic Sheets 

If you wish to split multiple gated components across more than one schematic sheet then this 
is possible. As this is an infrequent operation, it is fully documented in the online help 
provided and installed with the product. 

Adding Circuitry from Other Designs 

Where previous designs already exist, you may find it more practical to copy a section of 
circuit and add it to your current Schematic design. Where proven circuits can be used this is 
highly desirable. This process is straightforward.  

���� To copy existing circuitry 

1. Open the Schematic design containing the circuit to copy from. 

2. Open the current Schematic. 
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3. In the existing circuit, drag a box to make the selection, or use the <Ctrl> and <Shift> 
key combinations to select parts of the circuit required. 

4. Use the Copy command to copy the circuit. 
Copy is available on the shortcut keys <Ctrl-C>, or on the Edit toolbar or on the Edit 
menu. 

5. Now go back to the current design (use the Windows menu and select the design from 
the list, or use <Ctrl-tab> keys to toggle through the open active windows). 

6. Use the Paste command to add the circuit to the design. 
Paste is available on the shortcut keys <Ctrl-V>, or on the Edit toolbar or on the Edit 
menu. 

7. During the addition of new circuitry to a design you may be asked to resolve duplicate 
net names. This process is described below. 

Resolving Net Names  

When using the Paste (or Duplicate) option to paste a copied circuit into your current design, 
if net names already exist in the design, you will be requested to resolve these. Component 
names will automatically be resolved by being incremented to the next unique name. Net 
names however need to be resolved.  

The Paste Net dialog allows you to see and control how duplicate net names are resolved. 

 

Once a net name is detected, you are prompted with the question - Merge net with existing 

net? Using the options on the dialog, you can elect to add the net name to the existing net or 
to automatically allocate a new name to it, therefore not connecting it into the existing net. 

Hierarchical Designs 

Overview 

You can add multiple hierarchical schematic sheets to a project. This is different to multiple 
sheets in a Project in that you can add a block on a schematic sheet and ‘push’ into that block 
to reveal another page. For example, this could be detail that can be covered by an overview 
block, say PSU or MEMORY etc. but for which you can show the lower level detail on a 
separate sheet.  

To use hierarchy, the designs must be contained within a Project file. 
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Hierarchical Building Blocks 

The diagram above illustrates how various scenarios are possible when using hierarchy, all 
within the same Project file. A design sheet can contain multiple blocks (2) and multiple 
hierarchical sheets. In (3) an existing block can be copied and effectively used again, it is 
renamed though. Schematic (4) shows multiple blocks and a block inside a block (a nested 
block).  

Overview 

Schematic design sheets in a project can have a hierarchical structure. This is different to 
using multiple sheets in a project at the same level in that you can add a block on a schematic 
sheet and push into that block to reveal the block contents on another schematic design. For 
example, this could be detail that can be covered by an overview block, say PSU or 
MEMORY etc. but for which you can show the lower level detail on a separate sheet. To use 
hierarchy, the designs must be contained within a Project file. 
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The above shows a top level schematic design with two blocks. Under this, each block’s 
contents is a separate schematic design within the Project. 

There are two reasons for using a hierarchical schematic design structure.  

• To allow a schematic design to be structured, so that it can be broken down into its 
functional elements. This promotes "Top Down" design; break down a problem into 
functional elements, then define the detail of each element.  

• To facilitate the re-use of commonly used circuit elements. This promotes "Bottom Up" 
design; use predefined elements to build a solution.  

In practice, you may want to use a combination of both "Top Down" and "Bottom Up" design.  

What is a block? 

A block consists of two parts. The first part is a block symbol, inserted into a schematic 
design to represent the block at the higher level. The second part is a complete schematic 
design containing the design elements that define the contents of the block, and this represents 
the implementation of the block at the lower level.  

The two halves of the block can be defined separately, but are eventually linked within a 
project by using a common block name. The block symbol has a name, and a schematic 
design representing a blocks contents can be allocated a name using the Design Properties 
dialog.  

The block symbol can contain block pins that can have schematic connections attached to 
them to pass signals to a corresponding block ports in the blocks contents design. The block 
ports are single pin symbols that can be separately placed anywhere in the lower level design.  

The link between a block symbol pin and its corresponding block port is set by both having 
the same port name.  

Blocks are not copied to the PCB design, but exist to place a hierarchical structure on the 
schematic representation of the design. When translating the schematic into a PCB design a 
check will be made to ensure each block symbol pin and its corresponding block port are on 
the same net.  

A hierarchical design is easier to navigate, because you can Push into the design representing 
the block contents, from its block symbol, and Pop out of the block design, back to the block 
symbol.  
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In a project tree view, schematic designs that represent the contents of blocks will have a blue 
icon and display their block name. If their block symbol is also defined, they are shown as an 
indented branch below the design that contains the block symbol. This way the hierarchical 
structure of the design is clearly shown.  

Adding Blocks 

There are three ways of adding a block into a design.  

1. Add Block 
Use this option from the Add menu to insert a new block into the design. A dialog 
will be displayed for you to define the block name, set the number of block ports, 
choose the block symbol and supply the name of the block contents design. 
Define what the block symbol will look like by either using a schematic symbol 
from the library, or generating a standard rectangular shape using user specified 
parameters. 
The block contents design can be a new design or you can hook up to an existing 
design either already in the project or a design file in the project folder.  
The block symbol can be placed in the current design and the block design will be 
automatically added to the current project. Block ports will not be initially added to 
a new block design, but you can add them when editing the design by using Add 

Block Port when the port is needed.  

 

2. Cut To Block 
Use this if you want to take an existing schematic design and cut a section of it into 
a block. This option prompts you to draw an outline around the items to be pushed 
into a block, and across any connections that are to be passed down into the block. 
The connections are cut at the outline and terminated on a block symbol pin. The 
other half is pushed to the new block design and terminated on a corresponding 
block port.  
The drawn outline and new block pins become the block symbol, and all data 
within it is moved into the new block design. The block symbol can now be 
replaced with a more suitable shaped symbol using Change Block Symbol.  
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The new block design will take a default file name based on a name stem defined 
with the Block Defaults dialog. You can change this name in the project view by 
selecting the schematic design and using the Rename option from the context menu.  

3. Duplicate Block  
Once you have added a block using one of the two methods above, you can create 
multiple copies of it using the Duplicate command. This will allow you to copy the 
block symbol and the designs that it uses to define its block contents.  
All component and block names used in the original block will be incremented in 
the duplicated block designs. User named nets will be merged with the original nets 
if they are used a higher level outside of the cut block, or will become new nets 
with incremented names if they are used just within the cut block.  

Navigating a Hierarchical Design 

To navigate the hierarchy of a project, you can either use the project view to switch to the 
design representing a block, or you can use the Push and Pop commands within a design.  

To Push into a block, select any part of the block symbol and use the Push Into Block 
command from the context menu. The blocks design will be opened and if you had selected a 
block symbol pin the corresponding block port will be selected. You can use double-click on 
the block symbol outline, or on a connected block symbol pin to quickly perform the same 
operation.  

To Pop out of a block contents design, back to its block symbol, select the Pop Out Of Block 
option from the context menu. You do not need to select anything in the block design to do 
this, but if you select a block port the corresponding block symbol pin will be selected instead 
of the whole block symbol. You can use double-click on the block port outline to quickly 
perform the same operation.  

Hierarchical Nets 

The span of nets in a project containing blocks is no different to a project with separate 
schematic sheets in it. If the net in a block design has a user defined name, it may also be used 
anywhere in the entire design. The user named net can be used inside and outside of a block, 
and all items on the net in both designs will be connected together when a PCB design is 
created. Therefore, all user defined net names are always global in a project. Auto named nets 
are only unique within a single schematic sheet, and so these cannot be used to connect from a 
block symbol pin in one design to its corresponding block port in another design, as they 
would end up as different nets in the PCB design.  

Each block symbol pin and its corresponding block port must therefore be on the same user 
defined net. If two different named nets are used, an error will be given when running the 
hierarchy report, or when attempting to create a PCB design or adding forward design 
changes to a PCB design.  

To help keep these nets the same, when you start a new connection from a block port, its 
corresponding block symbol pin from the higher level design will be accessed to retrieve the 
name of the net attached to it. This net will then be automatically used for the new connection. 
Thereafter, though, the nets will not be kept in line automatically, but can be checked at any 
stage using Design Rule Check or the Hierarchy Check Report.  
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Creating Commonly Used Blocks 

You may want to create a set of separate schematic designs representing commonly used 
blocks, such as power supplies or signal converters. These designs can contain block ports to 
terminate signals to be passed in and out of the block. It is then possible to copy these existing 
block designs into a project and link them to block symbols added to a higher level design in 
the project. This is done by using Design Properties (View menu, Properties with nothing 
selected in the design) to change the block name for the design. The block port names will 
have to be resolved at this stage to ensure the correct ports are linked to their corresponding 
block symbol pins. You must be pushed into the block to be able to do this. 

 

Editing Block Symbols 

Blocks and block ports resemble schematic symbols, but are implemented as an internal 
"group" of shapes, text and pins representing the symbol. This enables them to be easily 
altered within the design, for example to have extra pins, a wider box, or descriptive text 
added. You can use Edit Block Symbol on a selected block symbol or block port symbol to 
open a new window to edit its contents, add shapes, pins and text etc. After edit, use Save to 
replace it in the design and it will again act like a single item. Edit Block Symbol is available 
on the context menu for a selected block outline.  

When adding block symbols or block ports to a design, you can choose to auto generate them 
using some simple parameters, or use a schematic symbol from a library. The symbol from 
the library itself will not be used, but a copy of its elements will from the block symbol or 
port. This enables you to predefine standard block and block port symbols in your libraries to 
ensure a consistent interface. For example, you could define separate input and output block 
port symbols.  
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A block port created from a library symbol will remember its symbol name and can be 
replaced by a changed symbol from the library at a later stage using the Change Block 

Symbol function from the context menu, this is available for a selected block outline.  

 

You can set up a highlight colour to force all Block Symbols and Block Ports to be the same 
colour, thus differentiating them from components in the design. Block symbols can also be 
individually changed to have their own colour using the Properties dialog.  

Adding A New Connection To A Block 

If you have a new signal that you wish to physically take down to an existing block design, 
you can start or end the connection directly on a block symbol outline. A new block symbol 
pin will be added to the outline to terminate the connection on, taking an automatically 
generated port name. You can then double-click on the block symbol to push down into the 
block design and use Add Block Port to add the port, from which you can start a connection 
to continue the signal in the block design. The net will be automatically set to the net used in 
the upper level.  

Checking the Hierarchy 

You can use the Design Rule Check option to check the consistency of the two halves of 
each block in a design or project. An error marker will be placed on a block symbol pin if it 
has no corresponding block port, or if its block port is connected to a different net.  
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Alternatively, if you don't want to produce error markers, you can run the Hierarchy Check 

Report from the Reports dialog to get a report of any problems in the hierarchy. You can run 
this report on the whole project (from the project view), on a specific schematic design, or just 
on the selected block symbols from the context menu.  

Hierarchical problems can be serious and difficult to fix once the PCB design has been 
created, so the Translate To PCB, Integrity Check and Forward Design Changes options 
will run the Hierarchy Checker prior to their operations and will not continue if there are 
problems.  

Finding Blocks 

You can use the Goto Bar to find any block symbols and block ports in the entire project.  

   

Deleting Blocks 

When block symbols are included in a selection that is being deleted you will be asked if you 
want to delete entire hierarchical blocks by removing all of their block designs from the 
project. At this stage you can also decide to just delete the block symbols and leave the block 
designs in the project. These designs can be re-introduced into the hierarchy at a later stage by 
linking by name to free block symbols, or can be deleted from the project using the project 
view. 

Removal of entire blocks, including their contents, with the Delete option does not delete the 
actual design files from disc. The files can be restored to the project at a later stage or moved 
to another folder to be used in a different project.  

Block Default Settings 

The Defaults dialog has sections for setting the parameters that define what a generated 
Block Symbol and Block Port will look like. Here you can also set up the default name stems 
for block names, block design names, port names and default block net names.  



 Creating Schematics   133 

 

Using Hierarchy 

Starting with Top Down Design 

���� To create a top-down hierarchical design 

1. Start with an open schematic from within a Project file. 

2. We will first use a new block with no circuitry, we will assume the circuit will be added 
afterwards. 

3. Select Add Block from the Add menu. 
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4. The dialog is split into three sections; Block Name and Description, Block Details for 
the block ‘outline’ and the number of ‘ports’, and the bottom box containing the block 
schematic contents.  

5. For Block Name: this identifies the block. It can be a system allocated name, like B1, or 
a user defined name, like MEMORY. A name to reference the actual contents of the 
block would be more useful. 

6. For Block Details: we will select Auto-Generate. Once you have established some 
block shapes, you can save these to the library and reuse them using the From Library: 
option. The definition of the auto-generated block shape can be altered by selecting the 
Specify box. A dialog will allow you to create the auto-generated block using your own 
criteria. 

7. For this example, make the Number of Block Ports: 4 

8. We will create a new schematic design for the Block Contents. 

9. Select the Generate New Schematic Design: radio button. 

10. A default name is entered for you (Block1), change this to be more meaningful, we’ve 
typed Memory. This will be the new name for your lower level schematic design. It also 
matches the Block name but this isn’t essential. 

11. Click the Add button. This will add your new block symbol to the current design. Don’t 
forget, it will also add you a new lower level schematic design named Memory. 

 

12. Once added, the Add Block dialog is displayed again to allow you to add another. 

13. Click the Cancel button on the dialog to close it, we only need one block. 

14. In the design, double-click on the block outline to push down into it. You could also 
select the outline and then select Push Into Block from the context menu. If you have a 
shortcut key allocated to this option, selecting the block and pressing the shortcut key is 
also a quick way to push into the block. 

15. You’ll notice the design name appears on a workbook tab at the bottom of the design 
area: 

 

16. The lower level schematic will now come to the front and be editable. 

You now need to add corresponding Block Ports (pins) to the schematic. 
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���� To add Block Ports to the lower level schematic 

1. From the Add menu, select Add Block Port. 

 

2. A list of Port Names: is shown in a drop down list. This will be a list relating to the 
number of block ports shown on the top level block symbol. 

3. You’ll see that the list contains the same number of Block Ports plus one extra, shown as 
<New>. The list knows how many should be added to match the top level block. 

 

4. The Block Port Appearance is the shape of the block port itself. This can be a symbol 
from the symbol library or an Auto-Generated one. 

5. If using an Auto-Generated symbol, the Port Style and Port Outline can be defined 
using the Specify button and dialog box. 

6. For now, we will keep things simple and leave the default Auto-Generated values. 

7. Press the Add button to add a block port to the design. 

 

8. Each block port is added to the design in sequence. Once one port has been released, you 
are returned to the Add Block Port dialog to add the next.  
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9. When the option gets to the first new port (the one marked as e <New> in our example, 
and the fifth port to be added, a warning dialog is displayed to inform you that there is a 
mismatch in numbers of ports between the top and lower levels. 

10. Press the Cancel button to close the dialog. 

11. Your block is complete with both upper and lower levels. 

Cutting your design to block 

If you have an existing non-hierarchical design, you may wish to divide the design into 
blocks. The Cut To Block command allows you to select a piece of circuitry and create a 
block from it. Cutting a piece of circuitry to a block does not change the connectivity of the 
design.  

���� To cut a design to block 

1. Select the Cut To Block option from the Edit menu.  

 

2. Draw around the circuitry you wish to cut into a block. By default, this is a rectangular 
frame, you can also use a polygon by selecting Polygon Select from the context menu. 

 

3. Once the selection is completed, a block is created which contains all the items that were 
fully selected. 

4. Each of the connections and busses are cut at the point they cross the selection shape. 
Connections are terminated on the upper level at a block symbol pin, and on the lower 
level by a block port.  
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5. If a cut connection does not have a user defined net name, its net is changed to a name 
generated using the name stem taken from the block defaults. 

6. The block symbol outline on the upper level is created using the selection shape. The 
symbol line style and block pin style for this symbol are taken from the Block Defaults. 

7. You can later edit this block symbol shape using Edit Block Symbol from the context 
menu, or generate a standard box shape, or use an existing schematic symbol, by using 
the Change Block Symbol option from the context menu. 

8. Pushing into the block by double-clicking on its outline will reveal all the items removed 
from the upper level. 

 

9. Connections which were cut will end on corresponding Block Ports.  

Adding Shapes  

When creating a Schematic design, you may need to add extra shapes to the circuit for 
annotation purposes. These shapes have no electrical significance but may be used for 
documentation purposes or suchlike.  

To add shapes, you can use the Add shape options from the Add menu, or use the Add shape 
buttons on the Schematic Design toolbar. When a shape is added, it uses the Line Style 
defined in Defaults and Lines dialog under the Settings menu. 
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Once a shape has been added, its style can be modified by using the Properties option on the 
context menu. 

Schematic Design Rules Checking 

From the menu option Design Rule Check on the Tools menu you can check using the 
electrical rules available. From the dialog, you can check across a Project, or on the current 
design using the options available.  

 

All rules in this dialog are described in detail in the online help under the Index heading, 
Design Rule Check (Schematic). 
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Transferring Schematics into PCB Layouts 

In creating the Schematic, the names of all the components and the connections between them 
have been defined. The final process is the translation of the Schematic design into the PCB 
design environment. 

With the checking and procedures that are used, you should find that there are very few errors 
when translating to the PCB design. All errors must be resolved before proceeding; otherwise 
you may find your PCB design has errors. Warnings should be checked and action taken if 
required. 

Before using the Translate To PCB option you should save your current work by selecting 
the Save or Save As option from the File menu. 

Running the Translate To PCB option 

���� To translate to PCB 

1. Select the Tools menu and select Translate To PCB, the option will automatically cross 
reference the Schematic symbols to PCB symbols and will resolve the correct pin 
numbers for all the component pin names. 

2. This process automatically collates the netlist and resolves nets to create the netlist. 

 

3. You must give the PCB Design a name. This is normally the same name as the 
Schematic design but not necessarily. 

4. You can use a PCB Technology file to start the PCB with. This is recommended as it 
ensures that layers and styles are setup for you.  
The file chosen here will contain your design requirements matching the type of design 
being generated e.g. SMT, double sided, single sided etc. 

5. The check box to Use Component Bin may be selected. All components will then be 
sent to the Component Bin. This will make the start of the design process easier. 

 

6. The alternative is to allow the components to be added directly to the design. These 
would be positioned in a stack near the bottom left hand corner of the design. 

7. Once the OK button is pressed, the translate process will begin. 

8. During this, any warnings and errors are displayed and saved to a report. You should 
correct any errors and observe and correct any warnings. The possible errors and 
warnings are described below along with detail of how to resolve them. 

9. Once an error-free translation has taken place, you must remember to switch on the 
component bin in the PCB Design editor, use the shortcut key <Ctrl-F9>. 
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Resolving Warnings and Errors 

A report is generated if there were any problems with the translation. This includes details of 
any connections made to only one terminal of a device, and any component for which a PCB 
symbol could not be found. The latter would be fatal and would need to be corrected. 

Any problems reported following translation should be sorted out depending upon the 
severity. 

"Net NNNN contains a single pin" 

• This suggests a Schematic error where a connection should have been taken to a device 
pin, but failed to connect. 

"Could not load component XXXXX / package YYYYYY into PCB design" 

• This suggests that a Schematic component has no corresponding PCB symbol allocated 
(at least for the chosen package type). 

It is best to sort out any problems and re-translate, as it is less work to correct errors now. 

Exporting Netlists 

You can export a netlist in various neutral formats. 

From the Output menu you can use the Reports option and select Generic Netlist. There is a 
limited amount of customisation that can be achieved using this option. The netlist style is 
fixed with the Generic format but you can include items by selecting or deselecting them.  

 

The netlist generated will also include any components in the component bin and nets that 
have been defined in the Nets dialog but not used in the design. 

As well as the Generic Netlist output option, there is also the Netlist option that appears on 
the Output menu, this produces a native format netlist (this format is detailed in the online 
help). 

Reverse Engineer 

The Reverse Engineer tool is designed for use where there is no corresponding Schematic 
design for the existing PCB design. It is not intended for use where a PCB design is modified 
and the changes are to be reflected in the Schematic (the Schematic is always considered the 
‘master’ design in this situation). This option is only available in the PCB design editor under 
the Tools menu and Reverse Engineer. 
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Where a PCB design has been created, and if the PCB design is used to create ‘local’ libraries 
with the Schematic symbols added to the components in the new library, you must update the 
components into the PCB design first before using the Reverse Engineer option. Use the 
Update Component option from the Tools menu. 

If you opt to use PCB only components, the Schematic Symbols/Components will be auto-
generated for you when the Reverse Engineer option is selected. This method will work fine 
but will create dummy Symbols only, symbols that are shown as boxes with a representative 
number of terminals. 

Using the Reverse Engineer dialog will enable you to select the new Schematic name, which 
library folder to use and the Schematic Technology File name. You can also elect to Route 
the Design automatically once autoplaced. Once back in the Schematic design, all Symbols 
are automatically placed. 

Autorouting selected Symbols 

If you choose not to autoroute the design, you can selectively route them afterwards by using 
options on selected pins or components. These are available on the main menus and context 
menu. 

It does 90% of the work in creating a Schematic. A bit of tidying-up up is required of course 
but it is a big time-saver for those who choose to work this way. 

Printing the Schematics 

When you wish to print the design there are a number of options to choose from. The Plotting 

& Printing option on the Output menu gives you access to all printing options. This option 
allows you accurately scale and position the different plot types to the plotting media.  

In the setup, you can choose from Windows printers, HP pen plotter, direct PDF and 
Gerber device drivers. (Note: The DXF output option is not part of this output mechanism 
and is located on the Output menu under DXF Output).  
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The dialog is split into two main areas; the top half allows plot ‘jobs’ to be created and saved. 
By saving a job file, you can apply the same parameters to a different design saving the setup 
time for each design. The bottom half of the dialog is used to create the contents of the plot. 

Starting the Printing option 

The process of setting up and using this dialog is much simpler than if creating a set of PCB 
design plot files, Schematics is usually only one sheet and not layer based. 

By default, when you first open the Printing and Plotting dialog, a single Windows plot 
scaled to fit the default print page size will be created for you. In theory, you simply click the 
Run button and a print will appear on your Windows printer. You don’t need to create a job 
file or adjust any of the settings at to obtain this plot. 

The creation of plot Jobs is detailed later on in the chapter headed Output for Manufacture as 
this is more relevant for PCB design plots. 

Setting up the dialog 

There are three sub-pages to the dialog; Output, Settings and Position. 

The Output page is used to define the device type and the plot type. It will also inform you of 
the device where a Windows printer type has been selected. This confirms that you are using 
the correct printer. 
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The Settings page provides you with general plot settings used when outputting the plot. 
Settings that can be used such as, using All Colours Black even when printing to a colour 
printer, plotting the Pins/Terminals and Pin Names/Numbers. 

 

The Position page enables you to define how the plot will be positioned on the plot media. 

 

For a Schematic design, clicking the Centre Plot and Fit Plot buttons will be sufficient. A 
plot will be generated that fits the page and is automatically scaled. If more precise prints are 
required, use the controls on this page. 

The Preview check box can be used to display a preview of the selected plot. 
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Chapter 8. Creating PCB Designs 

Getting Started with a PCB Design 

There are a number of ways to start a new PCB design. The way in which you start will 
depend on whether you have a Schematic design, a netlist or a piece of paper with a schematic 
scribbled on it. 

You can: 

• Use the built in Schematic design editor to create the schematic and automatically 
translate it into the PCB design editor using the integrated libraries and translate 
mechanism. 

• Use a netlist derived from another source, or even hand typed into a text file created 
following our netlist ASCII format. 

• Use the PCB design editor interactively and create your PCB without using a schematic 
or netlist. The program is quite happy to allow you to do this; you cannot automatically 
create the equivalent schematic design from the PCB though. 

The PCB design environment will allow you to take a ‘logical’ schematic design (we’ll 
assume that under normal practice, the schematic is created first), translate it into the PCB 
editor, place the components, route it in order to get the 'logical' connectivity into a physically 
and electrically correct design and onto manufacture with the confidence that the design is 
correct. 

In this chapter, we will also look at some of the interactive processes that may not be always 
applicable to the design process presented. For example, a Schematic to PCB design flow will 
not normally require the addition of component from within the PCB editor. This would be 
handled by the addition of new components in the Schematic design and forward annotated 
PCB. The process of adding components directly to the design will be covered to explain the 
process involved. 

Starting the Design 

Regardless of where you start the PCB design from, you are required to provide basic 
information at the start point. This would normally be the Technology filename but this is 
optional. The Technology file is used to give you a fast-start of the design using predefined 
parameters, styles and settings. 

Obviously, how you start the design is determined by the source of the component and net 
lists. 

We will start with a new PCB design. 
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���� To start a new PCB design 

1. From the File menu select New 

 

2. In the Using Technology File box, select a file from the drop-down list. Hovering your 
cursor over the name will reveal the full name. 

3. There are a number of Technology files supplied, you can also create your own that can 
be added to this list. You may also choose [None] from this list. 

If you are unfamiliar with this style of drop-down list, select the small black ‘down’ arrow on 

the right hand side of the box. This will ‘drop down’ a list of available files from which to 

select from. 

4. Click the OK button to start the new design. 

The PCB design editor is now ready with a Technology file loaded ready for use. From here 
you may add a netlist or you may choose to start entering the design by hand on-the-fly by 
adding components and nets etc. We will look at starting the PCB design using the Translate 

To PCB option and from netlists later on in this chapter. 

Alternatively, you can also start a new design by using the New, Wizard, PCB Design. This 
will guide you through each stage of the process. 

���� To start a new PCB design using the PCB Design Wizard 

1. From File menu select New, Wizard, PCB Design 

 

2. This will start the Wizard 

3. The Technology page enables you to choose the Technology file required and the Units. 
Your Units would be set in the technology file anyway. 
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4. Use the Next > button to move onto the next page. 

 

5. From the Layers page, either use the layers defined in your Technology file (selected on 
the previous page) or Define the Layers on this page (you may use a technology to set 
up styles only for example). 

 

6. The Board page enables you to define the board outline that you require: 
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7. Define a basic Rectangle, Square or Circular board in your chosen units. You may also 
select the board outline from your Technology file if it had one defined or Copy a board 
outline from another design. 

8. The Board Preview window verifies your selection. 

9. The Finish page enables you to type a Design name and to Save it to your hard drive. 

10. Once OK is pressed, your design will open using your selections. 

Design Setup for PCB layout 

There are a small number of design settings that can be set before the design is started. 

Many of the characteristics of the design items are set up in the Preferences dialog. You 
check settings in the General, Interaction and PCB Interaction pages.  
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Default Styles 

The Defaults have been discussed previously but in brief, this dialog allows you to define 
how items with in the design will be added for the first time. Now is a good time to check and 
adjust them before starting your new design. They can be found on the Settings menu.  

 

Setting up a PCB Technology 

The concept of Technology files has already been discussed in previous chapters. This section 
details specific items for the PCB Technology file. 

Pad Styles 

Pad styles, regardless of their type, can be defined from the Settings menu, Design 
Technology under Pad Styles. It is recommended that the Sizes, Shapes and Drill Holes are 
defined as a style so that they can be reused for other Pads or Vias where the same pad sizes 
are required. 

 

The names used for these pad styles should be something recognisable to you so they can be 
recalled and used without having to think what size etc. has been defined. For example, Vias 
could be called something like, Via 45, for a 45 thou diameter via, Pad Round 35, Free Pad 

60, etc. 
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Where the layer is shown as [All] this means that the default pad 'stack' is shown for all layers 
except where an 'exception' is shown for the same pad. 

Where pads are defined, you define the pad as it appears on all layers – called the pad ‘stack’.  
You may change part of the entity for that pad for a given layer, for example you want a pad 
stack of 60 thou, Round with a drill of 35 - this might have a pad size for the GND power 
plane layer defined as 80 thou instead of the 60 'default'.  

The exception can be any of the shapes allowed and the size but not the drill size. The drill is 
always defined for the layer stack regardless of exceptions. The exception can contain zero 
sized pads on layers but will still be drilled (if a drill has been defined). 

The pad length can only be adjusted for asymmetrical shapes, otherwise it is defined as zero 
size, shapes such as rectangle. 

Track Styles 

Track styles are defined from the Settings menu, Design Technology option and Track 
Style. However, track styles are used as part of Net Classes that are assigned to connections 
and tracks. 

 

Track styles can be changed at any time during editing or on selection by selecting Style from 
the context menu or by using the shortcut key <S>. It is more organised to retain net classes 
and track styles rather than creating track styles on-the-fly but for expedience this can also be 
done. Any local track style added can be added to the Styles table anyway automatically. This 
is done when the track style is edited using the confirmation prompt. 

Track style widths can be set to any value but it is better to use standard widths for the 
designs in hand, and also with the manufacturing rules and requirements in mind at all times. 

Track styles and Net Classes 

By default, the net class used for tracks and connections is taken from the Settings menu, 
Defaults option and Net entry. This means when a track or connection is added to the design, 
the Remembered Style for Net Class is used, which in-turn has a Track style defined within it. 

Connections that are translated from the Schematic will generally (should) have a Net Class 
assigned to them, when they don’t, the Default for Net is used.  

Spacing Rules 

Spacings rules on the Design Technology define how close one type of item is allowed to be 
to another item. For example, Tracks to Pads or Vias to Pads. These are used by both the 
Online Design Rules checking (Online DRC) and (batch) Design Rules Checking (DRC) 
options.  

They relate to the distance between objects in the design, a Track to a Pad for example. These 
rules relate to the possible tolerances used when actually manufacturing the PCB. If changing 
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these, it is highly recommended that you consult with the person manufacturing the PCB for 
you. If you change these clearances, you may not be able to get the board made!  

 

Practical Use 

When creating designs, 10 thou (0.254 mm) is a good relatively low cost clearance for all 
conductor patterns for photographically produced boards. For boards produced using more 
basic methods you may need to look at higher clearances, around 15-20 thou perhaps to 
ensure that copper is sufficiently clear. Allow at least 20 thou clearance to the board edge for 
tracks and 100 thou for component pads (which allows a margin for holding equipment in the 
assembly and flow soldering processes).  

Design Rules 

In addition to Spacing rules, you also have design Rules. These are available on the Rules tab 
under the Design Technology. Design rules are additional rules that need to be considered 
when manufacturing a PCB. They also relate to general design rules for use when actually 
design the PCB. 
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Layers 

An unlimited number of layers is supported in a PCB design. This limit is regardless of 
whether the layers are construction, documentation, electrical or non-electrical or any 
combination of these. Layers are normally defined to detail the physical make-up of the PCB, 
the board that will eventually be manufactured.  

As a flexible system, you can add or remove layers from a design as you require, but remove 
can only be used on unused layers. Generally speaking, the loading of your technology files 
will pre-load your layer choice, the number of layers that will be used. You can always add to 
this afterwards but it gives you a good starting position. 

Layer construction 

The picture below shows a 4 layer PCB showing the 4 electrical layers (Top Copper, Gnd, 
Vcc and Bottom Copper), plus the basic non-electrical layers. Non-electrical layers are used 
to define layer information for solder paste masks, or solder resist masks for example. 
Additional non-electrical layers can also be used for documentation purposes. 

 

Layers that are defined as non-electrical can be defined as being on the Top side, Bottom side 
or Inner layer. 

Any number of electrical layers can be contained within a design and it is not restricted. The 
number and type of layers that the PCB design editor uses is controlled by the use of either a 
technology file or by starting with (no technology file) loaded [None] and creating layers, 
styles, colours etc. from scratch. We have supplied a range of default technology files to aid 
you with the starting process. 

If we take the most basic technology file (Default.ptf), this contains two electrical layers (Top 
and Bottom Electrical) and two non-electrical Silk Screen layers (Top and Bottom Silk 
Screen). This example is shown below: 

 

Layers can be named anything you like but it is better to give layers a sensible name, 
something meaningful and reflective of its function or its physical layer topology, e.g. Top 
Electrical, Top Silkscreen etc. 

The example below shows a 4 signal and 2 power plane layer setup (6 electrical layers in 
total): 
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Layers are not numbered but are instead named using a name. It is normal to assign these with 
logical layer names. They should appear in the Layers dialog in the physical order in which 
they are manufactured. This logical approach will make it easier for you to quickly see and 
locate layers by name and sequence. Because many of the options that use layer names are 
drop-down lists or selections of lists, the names and length of names are unimportant; you do 
not need to remember their names!! 

Creating Layers  

Before any design item (other than a board outline) can be added to a PCB design, there must 
be at least one layer available on which to place it. If a technology file is in use, this will 
normally define the necessary layers for you, otherwise they must be added to the design. 

���� To create new layers 

1. From the Settings menu select Layers. 

2. Select the Add button. 

 

3. Type in a layer Name. Usually this will be a name to define the layers functional in the 
final design, Ground, Solder Mask etc. 

4. All the other options on the dialog use drop-down menus. They will reveal a list of 
options from which to select. To access this selection, click on the small ‘down’ arrow 
on the right side of the list box.  

5. From the drop-down menu, select the Layer Type. The layer types offered will be as 
defined in the Layer Types dialog. A standard set will be offered if using one of the 
supplied technology files. 
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6. Choose the layer type from the list. 

7. From the Side list, you must choose the side that this layer will be related to. You can 
only choose Top, Inner or Bottom. 

8. The bias setting is principally used to describe layer properties for autorouting and for 
power planes.  

9. From the Bias list, choose from Minimum Tracks, No Tracks, None, Power Plane, X or 
Y. For the layer to behave correctly as an intended power plane, the layer bias must be 
defined as Power Plane. 

 

10. When a layer is defined as a power plane, it will be necessary at some point to define the 
net name associated with the plane.  

11. The Colour selection is used for the new layer default (for all items on that layer), it can 
be changed afterwards in the Colours dialog. 

12. Usage will be pre-defined from the Layer Type selection made previously. This box is 
simply a display of the setting and is not editable in this dialog. 

13. Net is used to define a net name associated with the layer. This is only required where 
the layer Bias is defined as Power Plane. 

14. When complete, the new layer is added to the list and other layers shuffled around it so 
that it slots in into its logical physical order within that category, but not outside it. 

15. Click the OK button to save the Layer changes. 

Remember that most designs will need at least one Electrical and one Silk Screen layer as a 

minimum design requirement. 

Layer Types 

The Layer Types page is accessed from the Design Technology dialog on the Settings 
menu. This allows you to define a type of layer and its usage for down-stream processes, e.g. 
colour display or manufacturing output selections etc. 
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The Name used for the layer type is the one that appears in the Layers dialog under Type, it 
is not the one used for the layer name, although they can be the same if required. Layers 
names are unique whereas Layer Type names can be used for many layers. 

The Layer Types can be Added, Edited or Deleted using the three buttons on the dialog. 

From the Add or Edit button you can make the changes: 

 

The Name: field is the name of the Layer Type and 
denotes its usage, not the plot name. 

The Usage of the type can be Electrical, Non-

Electrical, Wire or Special Effect. Electrical is only 
used for a physical electrical layer, for example Top 
Copper or Inner Layer 2 etc. Non-Electrical is used 
for layers such as Silk Screen or Solder Resist. Wire 
is used for displaying wires that are used for jumpers 
when the Wire option is used (these are not 
connections or nets). Drawing will be used when the 
Real Life PCB view is used.    

The selections below Name and Usage define the 
display and output of pad types within the design and 
their eventual usage. These switches have an effect 
on the design view. They control what is viewed and 
in conjunction with the Colours option will provide 
control and views of the specified layer with the 
pads/vias showing on or off depending on the 
selections made. 

When used with the Output menu option Plotting & Printing, the Oversize settings will 
affect the pads/vias output to printer or plotter. These settings for the specified layer override 
the Plot Pads Only switch settings in the Output options regardless of the switch settings. 

Layer Types for placement areas 

Any shape on the top or bottom layer can be defined as Placement using the Layer Types 
dialog. A check box under Layer Types for Placement Shapes should be checked to enable 
this feature.  
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Once checked, when the DRC option for Spacing and Components is selected, the shapes 
defined on that specific layer will then be checked. If a component does not have a placement 
area defined on one of the checked layers (top or bottom), the bounding box of the component 
extents will be used. 

In the example above, we have created a new layer called Placement which will have shapes 
that will be added to the footprint and which will be used to check the placement rules. You 
could simply nominate the Silkscreen layers as Placement Shapes if you wish to use existing 
shapes. 

Layer Spans 

Blind and buried via technology is supported. This technology support allows two additional 
layer spans to be defined as well as the ‘normal’ through-hole span. 

Blind vias are vias that span an external layer to an inner layer, for example Top 
Electrical to Inner Ground.  

A Buried via is a via which spans two internal layers, for example Inner 2 to Inner 3.  

Both, blind and buried vias are considered more advanced technology and should only be 
used after consulting your manufacturer as there may be cost implications when being 
produced.  

To add and modify layer spans, use the Layer Spans dialog, this is available from the 
Settings menu. 

 

When the Add or Edit buttons are pressed, the Layer Span dialog is displayed: 

 

If you enter an illegal or un-manufacturable layer span, the program warns you with a 
message: 
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When using this dialog, the <Through Hole> span is automatically added. 

Via Properties allow the changing of layer span and finding the best fit span. 

 

When editing a track, the interactive change of track layer will use the best via span. 

Layer stack Preview 

The Preview button on the Layer Spans dialog displays a graphical representation of the 
layers defined in the design.  

 

The Print button can be used to send this picture to a printer. You can also add this picture to 
the design using the Add Layer Stack option from the Add menu. 

Changing Colours in PCB 

Like Layers, the colours of items within a design should be assigned before commencing the 
design process. The colours can be edited from the View menu and Colours dialog.  

This dialog is split into sections; the first, Layer and Layer Spans is for defining the colours 
of items that are layer specific, i.e. Pads, Tracks etc. 



 Creating PCB Designs   157 

 

You can change the colours of each cell by double-clicking in the cell and selecting the colour 
from the drop-down list. 

Colours should be created that contrast between different electrical layers, e.g. Top and 
Bottom electrical layers should be distinctive against each other. This contrast will make it 
easier to identify layer changes and electrical differences. 

You can also specify that items are Selectable as well as being displayed. This means you can 
make items displayed but when you try to pick them they are not pickable. This could be 
useful if editing tracks and you don’t want to pick pads for instance or text. 

The second page, Setting and Highlights, is used to define non-layered items and generic 
design items, such as the board outline, connections, pin names etc. 
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The Merged Colours items will help you contact the layered items that ‘cross’ each other in 
the display. Obviously, they don’t physically cross because they are on different layers.  

Colours files can be saved and loaded from this dialog. These are saved with the .ECS 
extension and when saved to the colour files path can also be recalled to the design using the 
Colour Files dockable Preview bar. 

The Nets tab is used to define net settings. A net can be drawn in its own colour and 
selectively displayed using Show Connection. 

 

The Net Classes tab is used to set the colour individual Net Classes within the design. 

 

The Comp Colors tab allows you to set up 'rule based' colours for the components in your 
design that will override the colours specified by the shapes, text or layers in the symbol 
definition.  
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These can be used for example to construct an Assembly drawing where different categories 
have their own colour, or to draw components matching a particular Value in a bright colour 
to assist with things like component obsolescence. 

 

Translating from Schematics 

Within the integrated environment you can translate the Schematic design into the PCB layout 
editor with a simple button click. There are no netlists to use or other commands to use. 

The Translate To PCB option is available from the Tools menu within the Schematic editor.  

 

By setting up this dialog, this will give you the name of the PCB design, the Technology File 
and whether or not to use the Component Bin. 

Once this is completed, you are ready to start the component placement and track routing. 

The Translate To PCB option has been discussed in detail at the end of the previous chapter, 
Creating Schematic Designs under Transferring Schematics into PCB Layouts. 

Adding a Board Outline 

The board outline (or Profiles as they are sometimes called) is used to define the edge of the 
PCB design. This will often be the shape or size required to fit the PCB into a box or 
enclosure. 
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You can create board outlines in a number of methods. You can use the Add Board option to 
simply create the shape or you can use the Import DXF option to use an existing shape 
created in a mechanical package such as AutoCAD where the shape maybe very complex. 

 

 

 

 

This shows an example of a more complex board 
outline imported via the DXF import option.  

 

Using Add Board 

Board outlines can be created using the Add Board Rectangle/Polygon/ Circle/Line options 
from the Add menu.  The board is added directly to the design and created on the fly. You 
can also a add board using the Add Board option from the PCB Design toolbar. The Line 
shape style allows you to create a simple line board item that could be used for board detail 
for example.  

Board outlines are created using an Unfilled shape that is normally Closed, i.e. the start and 
end point are the same, unless you use the Line shape style. They cannot be self-intersecting 
where part of the shape extends outside itself (the option will check this for you when you 
finish the shape). You may edit a shape after it has been added by double-clicking the shape 
segment. 

Board outlines are not layer biased in that they appear on all layers. 

The Board outline default style is taken from the Defaults dialog and Lines page on the 
Settings menu. Whatever is defined here will be used as the initial board outline. You can of 
course change this afterwards by selecting the shape and using Properties or Change Style 
from the context menu. Defaults are saved with the Technology file. 

If you require cutouts in your board then you should use the Add Board option to create this 
cutout shape, or use Add Copper to define the area of cutout. The advantage of using copper 
is that other items placed near or on it will be checked during a Design Rules Check. 

���� To add a board outline 

1. From the Add menu select Board shape. Select the shape type required. 

2. Click to add the first corner or the centre point of a circle (if Add Board Circle was 
selected). 

3. If Add Board Rectangle option was selected, move the mouse to create the opposite 
corner and click to finish adding the shape. 

4. If the Add Board Polygon option was selected, click to add the first corner, each 
subsequent click will add another corner. You will notice that during the mouse 
movement, a trailing line segment joins your current position back to the start position. 
This indicates that the shape is closed. 

5. To finish this shape, double-click the mouse. 

6. If the Add Board Circle option was selected, click to start the circle at its centre point, 
then move the mouse to the required diameter. Click again to finish the circle. 
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7. At any point, if you want to exit or make a mistake and need to start again, press the 
<Esc> key on the keyboard. 

8. During the addition of the board shape, if you right click you will see options available 
on the context menu.  

It is recommended that you create board outlines in the centre of your working area although 
this can be changed using the Working Area option later on. 

Adding 'Free' Pads 

There are a number of pad types that can be used during your PCB design. For components, 
regular Pads are used. Vias are automatically added during a layer change when using add or 
edit track. Vias can also be added interactively to copper for example, if stapling is required 
(the process of attaching extra vias to an electrical item and plane).  

Free pads are pads that are not part of components and are not vias but can be used as 
additional pads within the design to define special uses such as mounting holes etc. They 
should not be used for component pins or vias as they have no pad number and are not 
recognised by other options.  

These pads take their style from the Design Technology option and the Pad Styles page, their 
styles can also be set locally as can other normal pads and vias. Local means a style on that 
item only and not added to the Design Technology. 

Free pads can be connected to, but are not identified with a component reference number or 
pad number. If connected into the design, for example a mounting hole might be connected to 
GND to earth it, this additional connection will not be checked in the integrity check. 

Free pads can be added to the design using the Add Pad option from the Add menu, or from 
the Add Pad option on the PCB Design toolbar. 

When a free pad is selected, there are additional options on the context menu that can be used. 

Adding Components 

Once the technology file has been loaded and the board outline created, the next process to 
attempt is the insertion of components into the design. Components are a fundamental design 
item for PCBs. As with most design items there are numerous ways to work with them. 

Components can be added interactively from the Add Component option, or loaded 
automatically from the library during the Translate to PCB phase without using an existing 
netlist or using a Schematic design. 

Components are used in both the Schematic and PCB design editors and are used to reference 
both the Schematic symbol and the PCB symbol depending which design editor is being used 
at the time. For components to be used, you must have a PCB Symbol. You may also have an 
associated Schematic Symbol with this component. The actual creation of components is 
covered later on in the chapter Library Creation.  

Within the PCB design editor, PCB symbols are used. These are 'footprints' of the pad land 
patterns and Silk Screen details required for the placement of the actual devices onto the 
manufactured board. These symbols are made up of the footprint detail and stored as a single 
item within a PCB symbol library. 

As well as adding components to the design, if you previously translated the design from the 
Schematic editor, you may have components located in the Component Bin ready for 
placement. This option will be covered a little later on in this section. 
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Adding Components Interactively 

The Add Component option can be found on the Add menu, on the PCB Design toolbar and 
with the shortcut key <F8>. 

 

This dialog allows you to search libraries and find components, then add them to the design or 
component bin. 

The Library list allows you to choose the library to select components from. From the drop 
down list, you can also choose [All Libraries]. This will display the components from all of 
the libraries found in the search path defined in the Library Manager under Folders. 

Once a library has been selected the Component list will update with all the components in 
the selected library. If you wish to use specific search criteria for components, the Find button 
and options within this will enable you to do so. The Find dialog allows you to search 
libraries and enter names based on wildcard names. This dialog is described in more detail 
below. 

The Add button will place it on the end of your cursor ready for positioning in the design. 
You will notice it will snap to the screen grid while placing. You can adjust the snap mode 
using the <H> key and by selecting one of the snap modes from the context menu. 
Alternatively, you can use the Add to Component Bin check box to send the selected 
component directly to the component bin. The Count entry will allow you to specify multiple 
copies of the selected component. 

The Preview button can be used to show you the component before it is placed on the design, 
it also shows you a preview of the PCB Symbol. Once you create your own library you will 
probably not use this unless you need a reminder of what they look like. 
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Using the Find dialog 

When the Find button is selected it displays a dialog that allows an item name to be found in 
the libraries. It then searches the libraries for the given Component/Symbol and selects the 
appropriate library and item. It searches the current library first, then all the libraries in the 
library directory. 

 

Matching on the library item Name can be done in three different ways: 

• Is Exactly: only matches items with exactly the name specified. 

• Starts With: only matches items that start with the given text. 

• Contains: only matches items that have the given text anywhere in their name. 

The Number of terminals/pads field allows you to limit the search to match only those 
library items with the specified number of pins. 

For the Value field, when searching for components, you can also choose to search for items 
that have a particular value. Leave the 'is' field blank to match all items that have this value 
regardless of its actual setting, or enter the desired setting to search for a specific value. 

Choose Only Search in Enabled Libraries to refine the search into enabled libraries. If not 
selected, you will be able to search all of your libraries in the Folders path. 

On pressing Find, there may be a delay whilst any library index files are updated. Having 
done this, the libraries are searched for matching items. Any matches found are listed on the 
dialog, showing their name and library file and for components their 'package' as well.  

To select the desired item, simply click on it in the list. As you select the item, the 
corresponding 'master' dialog (Libraries, Add Component, etc.) will update its details and 
preview to show you the selected item. To close the Find dialog, either click on Close or 
double-click the required library item in the list. 

Using the Component Bin 

The Component Bin bar is available as a sliding window. This feature provides you with a 
facility for holding unplaced components in an off screen location. This frees up the design 
space while placing other components and generally makes it less cluttered, especially on 
dense designs. 

The component bin has been discussed in detail in the previous chapter on Using the Product. 

The component bin itself consists of the component bin preview and the component bin. It is 
used to store and view unplaced components in the PCB design editor. 
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The Component Bin Preview window shows the component currently selected in the bin, 
along with its pad numbers and names. This updates automatically as each component within 
the bin is selected. 

The Component bin window lists the components currently in the bin. This shows the 
component reference name, the component name and component type and is sorted 
alphabetically on the component reference name. The components are selected by clicking in 
this list. 

Placing Components on to The Design 

To place components onto the design while they are located in the component bin you can 
click on the required component in either the Preview window or the Bin itself, and drag it 
across onto the design. 

Note: the drag may be cancelled either by dropping the component back into the bin, by 

pressing the <Esc> key or once released, by selecting Undo (<Ctrl Z>). 

In summary, components can be placed in the bin: 

• From the Add Component dialog. 

• By dragging the component from the design to the bin. 

• By selecting a component in the design and choosing Move To Component Bin from 
the context menu. 

• From the Autoplace option dialog. 

• During the Translate To PCB option. 

In a PCB design, layers have to be considered when adding components from the library. If 
the PCB symbol has shapes or text on layers that do not exist in the PCB design, these shapes 
and text items will be removed from the Component used in the PCB design. The matching is 
performed by layer type and side. 

Updating Components 

Components and Symbols can be updated or changed in the design using two features: 
Update Component and Change Component. 
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Update Component 

Update Component is available on the context menu when a component is selected and also 
on the Tools menu. It is used to update the current component on the design to an updated 
component from the library. This feature can also be used to force component updates from 
the library if required, to globally replace all components to the latest ones that exist in the 
library. 

Components within a design are always unique as are Symbol instances. A design cannot 
contain a DIL14 for example that has two different shapes or pad shapes they must always be 
identical. Once a component or symbol is added to the design, the next addition of that item 
will be duplicated from the design not accessed from the library. 

On selection of the Update Component option, the dialog presented allows a number of key 
functions to be performed. 

 

Firstly, it enables you to select particular devices to update, or you can choose them all using 
the All button. Then check boxes allow control of the facets within uploaded components: 

Only update item if version different in library effectively allows you to 'force' an update 
even if the library items are the same. Leave the check box unchecked if you wish to force the 
update. 

Remove pad style exceptions is used to control local pad style exceptions that have been 
added to components that are to be updated from the library. It is also used if the technology 
file used for the library creation and the design technology files are different. 

Keep existing component Values is used to control local attribute values which have been 
added to the components which are to be updated from the library. 

Keep value positions If this is checked the positions and layers of the components value 
positions are retained. Otherwise the value positions will revert to the symbol or footprint 
defaults.  

Keep associated parts If this is checked, any associated parts for that component are 
retained. 
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Change Component 

Change Component is available from the Properties option on the context menu when a 
component is selected. By selecting this option, you are able to change components and/or 
Packages for that component in the design. 

 

The dialog gives you options to change the Component or the Package from a selected 
library. The information displayed shows the item before and the changed item. Find allows 
you to select different library items using the Find facility.  

The ‘Delete’ option is not to be used! 

The net effect for both of these options (Update Component and Change Component) is 
that if a component or PCB symbol is incorrect in the design, instead of removing the device 
and its connections/tracks, you simply replace the component or symbol for the one that is 
required or updated. 

Replacing Components 

The Replace Components option on the Tools menu enables you to perform ‘global’ find 
and replace on components in a design or project. It allows you to choose a replacement 
component to apply across the design or project. 

Use the Replace This: selection of Component and/or Package to select the item to replace. 
The Replace With: option allows you to choose the Library and the Component/Package 
as the replacement. Once selected, the PCB Symbol name and number of Pins will be 
displayed as confirmation. 

The Preview check box and windows allow you see previews of the new replacement 
Schematic and PCB symbols before replacing them in the design. 

The Find button will display the standard Find dialog from which to make an advanced 
search and selection. 
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Settings switches are available to Apply to selection (rather than the whole design) and 
Apply to all sheets in a Schematic design. 

Placing the Design Interactively 

Once the components have been added to the design (by hand or during the translation form 
the Schematic) they will be either in the component bin or in the design unplaced. From here 
you have two options, to place them interactively by hand, or to autoplace them using the 
Autoplace option. For now, this section will concentrate on manual placement.  

This product follows Microsoft standards, the movement of components is straightforward, 
you simply ‘pick’ the component and ‘drag’ it to the required location. As well as individual 
components you may also use the Frame Select mode to pick a group of components for 
moving (Frame Select is activated by dragging a box around the items required). 

You may also put the component into Place mode, this means that the component is 
‘attached’ to your cursor until released. This mode is available from the context menu of a 
selected component. It is sometimes more convenient to move the component like this 
without having to concentrate on keeping the mouse button pressed while dragging. This 
method is slightly slower as it requires more mouse button presses and is not dynamic.  

Using the Place mode, you can also use the arrow keys on the keyboard to make precise 
positional changes, it is more difficult to do this with the mouse alone. 
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Component placement options 

During component move you have a number of features available. 

 

As part of the component interaction, you also have many features available to you that can be 
accessed on component selection from the context menu (in addition to those found on the 
Place menu). 

  

Setting up placement options 

Most of the options available during Place can be pre-defined ready for use. These are located 
on the Preferences dialog (on the Settings menu), on the PCB Interaction tab. 
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Rotate 

During move, press the <R> key and the component will be rotated by the default rotation 
step, this will be set to 90 degrees by default but can be changed in the Preferences dialog 
under PCB Interaction. This is also available on the context menu on Rotate>. On this sub-
menu, you are also able to Rotate By and specify the rotation value. 

 

Dynamic connections during move 

When you place components, you’ll notice how the connections move with the components; 
this is called 'rubber-banding'.  Move of components is also equipped with a de-clutter 
mechanism for ensuring that the function is as smooth and accurate as possible. This means 
that during place (and is especially noticeable when using larger PCB components such as 
BGAs) that the entities within the component are only drawn if the system performance 
allows it. If the mouse is rested momentarily then the component will be fully redrawn.  

On movement of a large pin device, you would only see the pads and connections drawn once 
the movement has stopped or paused momentarily. 
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Placing surface mounted components  

The placement of surface mounted  components is no different to that of through-hole 
components except that they can exist on both sides of the design (Top and Bottom sides). 
When placing you may need to make consideration of any down-stream processes such as 
automatic assembly machines and their physical restraints. For example, the jaws of a 
placement machine may need to be accounted for when placing SMD components next to 
each other. 

The only main difference is in the way they behave when the component is flipped (mirrored) 
but this is purely only for SMD components. 

Flipping (Mirroring) Components 

For SMD components in a PCB CAD system you need to be able to indicate that the 
component has been physically moved from one side of the PCB to the other. This entails the 
view of the component being mirrored from the Top layer to the Bottom layer, including all 
pads and text as well as moving drawing items such as Silk Screen idents. This is an easy 
process using the Flip option.  

If a component is selected and the <F> key on the keyboard pressed, the component will flip 
to the other side of the board. This means that when it pads and silk screen detail (outline and 
component reference name) were on the Top side, they will now only exist on the opposite 
(Bottom) layer. 

 

The picture above shows the effect of mirroring this device using the Flip command. Pin 1 is 
now shown on the top right hand side of the device on the right, whereas it is on the top left 
on the non-flipped device. You’ll also notice the silk screen name, IC1, has also been 
mirrored. 

Pushing Components 

Components can be ‘pushed’ while interactively moving them. This feature is enabled though 
the Preferences dialog and PCB Interaction, or while actually moving the component using 
options on the context menu. Options are available for pushing to select the push mode as 
Never, Continuous and On-drop. The push direction can also be set to Both, Vertical and 
Horizontal. You can also set whether components use Springback (with Springback set the 
component being pushed will continually attempt to return to its original position before the 
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pushing started. This is particularly useful on a tightly packed board where space is at a 
premium).  

 

Fixing components 

Components can be fixed in position. The Fix Item option is located on the context menu for 
a selected component. 

 

If they are selected and dragged for placement, a warning dialog is displayed. You can 
confirm that you want to move the device by clicking Yes, if you want to leave it fixed and 
not move it, click No. If Yes has been selected, the component can be moved. Once the move 
is completed, the fixed status will be reapplied. 

 

Using the Properties option to place components 

When a component is selected, the Properties option is available from the context menu. This 
displays information about the component including its X and Y position, Mirror status, 
Rotation and Fixed status. 
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From this dialog you can interactively change fields that are not greyed out. 

Grid settings 

During placement you can snap the component on a grid. By pressing the shortcut key <H> 
the grid setting menu will be displayed. You can then select the grid required for placement.  

 

The grids here are taken from the Grids dialog on the Settings menu. From this dialog the 
Grid Snap mode can be set to the setting required. This will ensure that the placement is 'on-
grid' and that the footprints are aligned. 

From within the Grids dialog you can also set a grid to be the component grid by selecting it 
and pressing the Make Comp button. This has been discussed previously under Grids. 

Adding Connections 

Connections are used to indicate the point-to-point connectivity of the netlist. When designing 
PCBs on the fly directly into the PCB editor, you may wish to add connections to create the 
design. You may also add tracks directly to the design without adding connections; the track 
path still makes the connectivity but is not so easy to work with at the start of a design.  

Where a design has been translated from the Schematic, the netlist will already be defined 
with the associated components and connections. In this situation all you need to do is to 
place the components and route the track paths in.  

Connections or nets carry a number of properties: 

• The net always has a net name, whether it is user-defined (like GND, CLK, RESET 
etc.) or a system-allocated net name (like N0001, N0011). 

• A net class – this name provides an inherent set of physical characteristics to the net, 
such as track thickness and via sizes to be used when routed. 

Each of these properties has already been discussed earlier in this chapter under the 
Technology File section. 
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Connections may be connected to any electrical items, such as copper, pads, vias and free 
pads. 

Note: Guard Spacings can also be defined for connections, these are optional – an additional 

spacing value can be applied to a net where it requires more spacing over the design spacings 

or net class spacings. Usually not used now as Net Class to Class spacing rules are available. 

Note: there are also Wire items, these are not connections, they are used for adding jumpers 

and suchlike to the design. 

Default Connection Settings 

When adding a connection to the design, the net class of the net will be taken from the 
Settings menu, Defaults and Nets. The net class contains properties for setting the track and 
via styles when the connection is converted to a track.  

If the design has been translated from a Schematic, the net class would have already been 
defined. The net class properties will be taken from the PCB technology file. 

The Net Class can be changed using Properties of the net or by using Change Net for the 
selected Net. 

 

Using Highlight Net with Connections 

Connections can be highlighted at any time, during adding or during editing, you can use the 
Highlight Net option from the context menu. This will display any pads and connections on 
that net using the highlight colour defined in Display under the Settings and Highlights tab. 

���� To add a connection 

1. This option can be used if starting your design from within the PCB editor. If starting 
with a design translated from the Schematics, then the netlist will already be defined for 
you. 

2. From the Add menu, click Connection. 
This option is also available from the PCB Design toolbar icon. 

3. Click on the first pad to add the connection, click on the second ‘target’ pad. A 
connection will be made between the two pads. 

4. The Add Connection option will work on ‘pairs’ of items. If you want to ‘daisy chain’ 
the pads together then switch on the Stitch Connections/Tracks option in the 
Preferences dialog, Interaction page. 

5. Click <Esc> to exit the Add Connection mode. 

During Add Connection you can also use the context menu to change or highlight the net.  

Change Net will enable you to add or edit the net name and add or edit the net class.  

Highlight Net is used to highlight the whole net to make it stand out from the other 
connections in the design. 
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Once the connection has been added, if you select it, there are additional items on the context 
menu. 

 

On the Net> sub-menu, there is Optimise Nets. This is used to optimise the selected net only 
(Optimise is the process of shortening the connection to the nearest connection point on the 
same net).  

PCB Net Names 

By default, all PCB nets (nets added to the PCB design, not ones originating in the Schematic 
editor) have a net name of Nxxxx, for example N001, N010 etc. This name can be changed 
during or after the Add Connection process using the Change Net option from the context 
menu. 

Net Optimisation  

Before starting to route the tracks, you can make use of the Net Optimiser. This is used to 
make the shortest possible connection lengths within the unrouted design (it only works with 
unrouted designs). When creating the logical net list in the Schematic design, it won’t 
necessarily be the shortest connection path when passed into the PCB design editor for layout. 
The Net Optimiser enables you to get the most optimised connection length as you design.  

The Net Optimiser is invoked from the Tools menu, Optimise Nets> option. As soon as the 
option is selected, the layout will be redrawn with all the nets optimised. You have three 
options for performing an Optimise on All Nets, Browsed Nets and Selected Nets. 

You can perform a dynamic optimise during component move. This is enabled from the 
Settings menu by selecting the Dynamic Optimise switch on the Preferences option and 
Interaction tab.  

As the Net Optimiser is a commonly used option, we suggest you set it on a shortcut key 
using he Customise dialog and Keyboard tab. 
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Adding Tracks and Routing the Design 

Following on from component placement (and the addition of netlist/connections if you 
started in the PCB design itself), you will now need to convert the connections into copper 
tracks. Routing can be done both manually using the interactive tools provided, or 
automatically if the autorouter is available to you. 

This section will guide you through the interactive manual routing tools. The automatic 
routing tool can be found in a later chapter Automatic PCB Features.  

The design may also be created directly into the PCB. You can add connections to 
components in the design or you can add tracks directly into the PCB. By doing this, the 
underlying connectivity will be constructed from the track node to node connection (if you 
were to remove the tracks using Unroute, the connection base would still remain). 

���� To edit track manually 

1. To start editing a track (and subsequently convert them to tracks) you can: 

• Select Add Track from the Add menu and select the pad to start from, or: 

• Double-click on a connection. 

2. The Add Track mode can be started from both the Add menu and from the PCB Design 
toolbar. 

When a track is referred to as being ‘edited’ this means double-clicking on the connection 

when it is then dynamically converted to a track 

The picture below shows the Add Track method of adding tracks: 

 

The picture below shows the alternative method of directly editing the connection showing 
the ‘flying’ connection from the end of the track to the target pad. This is the normal 
recommended method of manually editing connections to tracks. 

 

Overview of the basic modes of routing 

The basic commands for editing tracks are: 

Single-Click, once editing a single-click will add a corner and enable you to change direction. 
In the appropriate mode, a change of direction will also add a mitre to the corner. When using 
Add Track, a single click over the picked item will end the track on that item. 
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<L> (Change Layer) followed by <Enter> will enable a layer change of the track to be 
made. This will automatically insert a via at the point of the layer change. 

 

Layer changes automatically inserts a via and changes layer. The current track segment will 
now be on the new layer and will stay there until another layer change is made. If a new layer 
change is made another via is inserted. This rule is only applied if starting on a through-hole 
pad and finishing on a through-hole pad. If the track starts and stops on a surface mount pad a 
via will automatically be inserted regardless of any layer changes, obviously, this is required 
anyway to change the track to the correct layer for completion. 

<S> (Change Style) followed by <Enter> will enable the style of the track segments from 
that point onwards to be changed. Choose from the styles presented in the dialog. 

 

Double-click, during edit this will finish the track in mid-air with a connection back to the 
target pad. 

<F> (Flip) enables the current segment and the previous one to be mirrored. 

   

This shows the original track path. This is how it looks when the Flip 
command is used. The fine dotted line 
shows the original track path. 

 

<I> (Insert shape), using this mode will enable you to determine which end of the net the 
track will start from. You can also fix this by setting the Edit Segment Towards Nearest 

End switch on the Settings menu, Preferences dialog and PCB Interaction tab. 
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Editing from the resistor adds 
the vertical track and 45-degree 
segment with the flying track 
back to the IC. 

 Flipping the direction then starts 
the vertical track and 45-degree 
angle from the IC with the flying 
track back to the resistor. 

Show Nearest Node on Net 

There is an option on the context menu when adding a track or sketching, called Show 

Nearest Node on Net. Use this option to show a line to the nearest item on the net to the end 
of the track being added, a dynamic optimise mode. The option can also be set on the PCB 

Tracks tab in the Preferences dialog. 

 

Setting up preferences 

As well as the General preferences, there are also preferences specific to the PCB design 
editor on the PCB Tracks tab: 
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PCB Track Segment Mode – there are four modes available on the drop-down list, Fillet, 
Free, Mitre, Orthogonal and Right Angle. 

For all of these modes, the ‘trailing’ segment back to the target pad is always left as a free-
angle track. In the examples below, this is shown as the right most track segment back to the 
resistor leg of R8. 

Free – the track will exit the pad or corner at any angle following the cursor until the next 
mouse click.  

 

Orthogonal – the track will remain in 90 degree mode at all times during the addition of 
corners. Alternate track segments are horizontal and vertical with the previous segment being 
dynamic.  

 

Right Angle – the track will remain in 90 degree mode at all times during the addition of 
corners. Alternate track segments are horizontal and vertical. 
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Mitre – following the orthogonal track, the corner added will be a 45 degree mitre. The size 
of the mitre will depend on the length of the movement away from the corner.  

 

Fillet – following the orthogonal track, the corner added will be a filleted track with a radius. 
The size of the fillet will depend on the length of the movement away from the corner.  

 

Fixed Angle – this segment mode can be used for adding single segments at a supplied angle. 
The default will be to add single segments at 45 degrees. 

 

Selecting this mode again from the menu returns it to the previous segment mode you were 
using. Use Enter Angle from the context menu to change to the required angle, you will then 
be able to add segments at this angle and at 45 degree rotation increments from that angle.  

 

Select Snap to Angle Step from the context menu to snap to steps equal to the angle 
originally supplied. For example if the angle supplied was 15 degrees then you will be able to 
add segments at multiples of 15 degrees.  

Select Grid the Length from the context menu to grid the length of the angled segments 
being added using the current grid value. For example, if your working grid is set to 100, then 
the length of the segment in this mode will be 100. If this feature is not selected the line ends 
will snap orthogonally to the nearest grid point.  
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Changing Segment Modes 

These modes can also be set while editing the track using the context menu. The shortcut key 
for this mode is <M>. 

 

Advanced options on the context menu 

Some useful features to note on the context menu (note, not all are listed here): 

Edit Segment – this option is available on the context menu when an existing track segment 
is selected. It has the same effect as if you double-clicked on the track segment directly. It 
allows you to edit the track path of the selected segment, you may also change the style and 
layer once in the edit mode. 

End On Via – this option is used to end the track being edited on a via, effectively creating a 
‘stub’ route. This is discussed further on in this section.  

 

Disconnect Track End – this option is used for disconnecting tracks from pads when an end 
segment of a routed track needs to be connected to a different end location. This option is then 
available on the context menu. You can also use the shortcut key <E> when in edit mode on 
the track. This will leave the track end segment on the end of your cursor from which you can 
then select a new pad or land site for the segment. 

       

The sequence above shows how this might be applied, moving from left to right. 
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If working with a master Schematic, you would edit the schematic and then run the Forward 
Design Changes option to apply the net changes to the PCB design. 

Autoroute – for a selected connection or for a partially routed track, you can select Autoroute 
to finish the track. This is only available if you have the Easy-Router option installed. 

Auto Adjust Track – this option will attempt to correct track errors but adjusting the track 
with minimum deviation from its path. 

Smooth Track – for a selected track, the smoother will try and reduce the track length, 
number of vias and number of staircases. This option is described in more detail later on in 
this section. 

Auto Mitre Track – for a selected track, a 45-degree mitred corner will be applied to it using 
the values set in the Auto Mitre dialog on the Tools menu. 

Arc – when selecting an existing track segment, the Arc command converts a segment to 
curve. As well as the pre-defined arc angles of 45, 90 and 180 degrees, there is a flip 
command to reverse the sense of the arc. An Angle Free Mode option will enable an arc of 
any angle to be created using the cursor position to define the required size. This gives quite 
fine control, providing that the rotation step size has been set sufficiently small (0.1 degree is 
possible). There is one illegal value, 360 degrees. If an attempt is made to create effectively 
an infinite circle, the segment defaults back to a line. The Arc To Line mode provides you 
with an option to snap the arc back to a straight line segment. 

Editing Existing Tracks 

Where tracks have already been routed but the path needs to be adjusted, the manual editing 
feature is very easy and powerful to use. Some basic, (and standard Microsoft), techniques 
have been used to make the edits a familiar format. 

Moving a Track 

Moving a track segment is a simple process of selecting the track segment and dragging it to 
the required position. During this pick and drag you may also (from the context menu) change 
the tracks’ Style and Layer, toggle the Online DRC on and off, and allow the tracks to have 
free rubberbanding (rather than be fixed orthogonally). 

Editing and Selecting a Track 

To edit an existing track, double-click the cursor while over the track, this then makes the 
segment 'flexible' so the path can be changed using add corners etc. To finish the edit, double-
click again. 

A <Single-Click> selects the tracks and then waits for something to be done with it, e.g. 
right-hand mouse key and change layer etc. 

A <Single-Click> and drag will move the track segment, but will move it either orthogonally 
if the track is at 90 degrees, or if the track is on a free angle or 45 degrees, will move it 
parallel to its existing position. 

Editing a Corner 

The same principles will be applied to a corner track. One point to make is that the selection 
or editing of a corner track has to be reasonably accurate otherwise the track segment could be 
selected by mistake. 
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Double-Click on a corner will edit the corner, the corner must be orthogonal though. This 
means that the corner will automatically be edited to be a 45-degree mitre. Once editing, you 
move the mouse and the mitre will snap to the Working Grid.  

A <Single-Click> and drag on a corner will move the corner retaining its orthogonality but 
will allow you to reposition the corner. 

Other editing options and techniques 

‘T’ Routes 

When using the Add Track mode it is possible to connect a track into an existing to tracks, 
effectively 'copper sharing'. This is particularly useful when a 'T' junction is required. A 
hidden connection will be automatically created to the nearest node on the net to retain its 
connectivity (this would only be visible if the track was unrouted). 

 

Finishing Tracks 

To finish the track on the target pad you simply Double-click the mouse over the pad. If you 
wish to finish the track before reaching the pad and then come back to it later and edit the 
remaining track path, click to add a corner, then Double-click to finish. An angled track will 
be drawn to the target pad. This track can be edited later on. Finish will always work from the 
current corner not the current cursor position (they could be the same though). 

You may also use the context menu options to Finish - finish at the current corner and add 
orthogonal segments back to the target, Autoroute – allows the autorouter to complete the 
track, this will not be available if you don’t have the Easy-Router option.  

Adding Corners 

During edit corners can be inserted in a track path by a single mouse click at any point. After 
the mouse click, move the mouse and continue with the track.  

The shape of the corner will be affected by the Segment Mode that you have selected. When 
editing the track, select an option from the Segment Mode> option on the context menu.  

Exiting the edit option 

If you get lost with the routing or make a mistake you can use the <Esc> key to cancel the 
edit. You can also use Finish from the context menu which will complete the track, then use 
the Undo option <Ctrl-Z> to remove it. 

Using Delete to Unroute Tracks 

If you wish to unroute a track back to its connection, use the Unroute Track option (see 
below). If you use the <Del> key on the keyboard there are two situations that you should be 
aware of: 

• Delete on a track that is in the ‘middle’ of a net will remove the track and the 
connection. However, when you run an Optimise on the design or that net, it will 
reinstate the connection path. 
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In the above example, with the end 
connection between R4 and R9 routed, this 
track is selected and the Del key pressed. 

Even when Optimise is run, the 
connection is not reinstated. 

• Delete on a track that is at the end of net will remove it completely from the design even 
if Optimise is run afterwards. 

          

With the middle 
connection routed, this 
track is selected and 
the Delete key pressed. 

 The track is deleted. The 
nets on each side of the 
deleted connection retain 
their original Net Name. 

 If Optimise is then 
run, the connection 
reappears 

Unrouting Tracks 

Tracks within a design can be unrouted back to their 'connection'. To do this, use the Unroute 

Nets> option from Tools menu and choose either All Nets, Browse or Selected Nets 
depending on the refinement of unroute that you require.  

The context menu also contains unroute options under the Nets> option. From this menu you 
can choose Unroute Track Segments, Unroute Track Path, and Unroute Nets. This gives 
you control over unrouting the individual selected track segment(s), the point-to-point track 
path and the whole net. 

  

After selecting the track segment(s), choose Nets> and 
Unroute Track Segment from the menu. 

The selected track segment 
only is unrouted. 
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Viewing the Grids 

A visible grid is helpful when positioning tracks. If the grid dots are not displayed, press the 
<G> key on the keyboard. You may also switch on the grid dots from the Settings menu and 
Grids. Each named grid has its own visibility switch. 

 

 

You can also make the grid dots displayed as lines on the design. Use the Lines check box 
next to the Primary or Secondary Colours. 

By selecting the check box, Draw Grid First, you can control whether the grids are draw in 
front or behind design items. Selecting this box will draw them behind design items. This 
switch really depends on whether  

The Grid Snap settings will use the grids defined in the Grids dialog. To access this menu, 
while designing, press the <H> key, see below for more information. Experienced users 
usually work with the grid displayed. 

Snapping Tracks to Grid 

The Grid Snap menu is accessed at any time during the design process using the shortcut key 
<H>. It can be changed for the placement of components and routing of tracks for example as 
well as all other interactive options. 

 

It also allows you to set fractions of the currently selected named grid using the shortcut key 
<H> while editing the design. By pressing this key, you will be shown a context menu that 
contains alternative grid modes. These grid snap modes are useful when routing fine tracks 
between the pins of ICs and where more than one track between is required. 
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For the neatest layouts, always try to work to the largest snap grid possible, use the snap 
modes where required and only move off-grid using freehand when absolutely necessary. 

Using named grids allows you to swap grids between imperial and metric if you require 
mixed-unit designs. By defining a grid of 0.5mm for example, this will be exactly defined 
once Metric units are invoked (using the Units option and Metric). When using Imperial 
units, you can ignore this grid until it is needed. 

Adding Stub Routes 

Stub routes are short segments of track, normally with a via at the end of them. These might 
connect a surface mount pad to an inner layer power plane. Because surface mount pads have 
no way of connecting to a power plane (unlike through hole pads which have plated drill 
holes), a track and via are required to make the connection as the picture below illustrates.  

 

The nets act as an indicator of the connectivity and can be used later on to highlight gaps in 
the 'copper' path when the Connectivity Report is run (from the Output menu). This picture 
also shows the nets before Net Optimisation has been run, showing the actual connection 
path and not the nearest path. 

Once run, the nets now take the shortest connection path between the vias. 

 

���� To add a stub route 

To add a stub route, you must be in Add Track mode and not be editing the connection 
directly. 

1. From the Add menu, click Track, you can also use the Add Track option from the PCB 
Design toolbar. As explained before, the connections and nets are only there for clarity 
of connectivity of the nodes in the design. 

2. Select the pad to have the stub route, and click on the pad centre. 

3. Drag the track to the length required as indicated below on the left hand surface mounted 
capacitor: 
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4. From the context menu select End On Via. 

 

5. This will give you a dynamic via on the end of the track ready for placement. The via can 
be moved around to place it on a grid point or to the location required. 

 

6. Double-click the mouse button to release the via in its current position. If the position of 
the via is critical and you are working on a very fine grid you can also use the keyboard 
keys to add corners and release the via. The up and down arrow keys can also be used to 
move the via. The spacebar will add a corner and the <Enter> key release the via. 

Protected Vias 

On the Properties dialog for selected vias, you have the ability use the Protected switch. 
This is used to lock a via against being automatically removed when a track attached to it has 
its layer changed so that the via is no longer required. Protected vias are never automatically 
deleted, and are usually used for stub routes from a surface mounted pad to reach an inner 
plane or the other side of the board.   

Track Fattening 

Tracks can be ‘fattened’ up allowing more track copper to be laid down on the PCB. 

  

The Net Class track settings on the Design Technology dialog are used to define the 
Nominal and Minimum widths.    

Where the Nominal width used causes a DRC violation and with the Neck Track feature 
enabled, the option will ‘neck’ down to the Minimum Track Width defined. 
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The option to Fatten Tracks is available on the context menu while editing tracks. 

 

The minimum length setting can be defined in the Design Technology dialog under Rules 
and the Min Neck/Fatten Length rule. 

 

This rule is also used to define the ‘stub’ distance when routing and fattening. This is the 
distance between the pad and the start of the ‘fat’ track segment.  

 

Automatic Track Necking into SMD Pads 

While editing a track, it is possible to enable automatic track necking if the ‘fat’ track is too 
wide to enter a pad without causing a design rule violation.  

 

Like the Fatten Track option, the Net Class settings are used to define the Nominal and 
Minimum widths. Where the Nominal width used causes a DRC violation and with the Neck 
Track feature enabled, the option will ‘neck’ down to the Minimum Track Width defined.  
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To operate in this mode, you need two features enabled. The Online DRC and Neck Tracks 
options should be enabled. Both of these features are enabled in the Preferences dialog under 
PCB Interaction. 

 

Auto Neck Track 

The Auto Neck Track option allows you to dynamically track segments to automatically 
neck down to use a smaller track width to pass by obstacles when the normal width would 
produce a design rule error. When the obstacle has been cleared, adding a corner to the track 
will automatically swap back to the fatter normal width.  

The necked track width will be taken from the minimum track style associated with the Net 

Class of the track being edited. Necking will not be performed if there is no minimum track 
style, or the current track width is not greater than the minimum from the net class. 

 

Use the Auto Neck option on the context menu when adding or editing a track, this can also 
be set in the Preference dialog under PCB Tracks. 
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Swap Layers Mode 

You may have a requirement for swapping track layers (this also works for shapes) from one 
side of the board to the other, the Swap Layers option allows you to interactively do this for 
selected items. This is generally useful for a post-routing clean up, you work your way around 
the design swapping items to the other layer to reduce the via count. 

The Swap Layers option is available from the Edit menu in a PCB design.  

As a quicker mode of swapping layers, it is easier to select the track and use <L> (Change 
Layer). It will do exactly the same as the Swap Layers mode including adding or minimising 
vias. 

Note: A certain number of vias can usually be removed automatically using the Smooth 

Track option (see the Tools chapter below). 

Swap Layers works much like the normal Select mode, including the ability to select single or 
multiple items, but the selection is restricted to the type of items that can be swapped. Once 
selected, the items are swapped to the opposite side of the board. When swapping tracks to the 
other layer, vias are automatically inserted into the ends of the tracks where they swap layers. 

Note: Online DRC is not carried out within this option, as it would prevent much of its 

usefulness in ‘untangling’ track patterns. 

Display Clearances 

The Display Clearance option is used to show the Spacing clearances around items within 
the design.   

 

This is enabled through the Display option, Settings and Highlights page using the Show 
Clearances switch and the colour settings for Error: and Warning: 

 

This will highlight potential obstacles when performing various editing options (such as track 
editing or moving a single item). You can specify how far away potential obstacles should be 
before they are highlighted, this can be specified as an absolute distance, or as a number of 
grid steps (the larger of the two is always used). If both values are 0, then obstacles are only 
highlighted if actually in error. 
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The maximum distance to a highlighted item is set in the Preferences dialog on the PCB 

Interaction tab using Design Clearance Distance Maximum. 

 

When adding a track for example, you are able to switch on the display clearances using the 
Show Design Clearance option from the context menu when you right click. 

 

Pull-Tight Mode 

The Pull Tight Track mode is available complement the Trace-Router autorouter and is 
available on the Add menu. Note, without Trace-Router enabled, this mode is not available. 
This works slightly different to the conventional manual routing and sketch track modes. Two 
things make is different; the track is ‘pulled tight’ between the source and target pads. Think 
of it as a piece of string if you like, being pulled tight around some obstacles.  

This is what the appearance of the completed track would look like, the shortest track length 
but pulled close to obstacles.  

 

The second is the auto-finish option (switchable). When the track gets close enough to the 
target pad, it will auto-finish, ready to start editing the next connection. This mode is available 
on the context menu when in Pull-Tight mode.  
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Using the Settings menu and Preferences, PCB Tracks tab, you can define how double-click 
on a connection action will behave for Pull Tight mode. 

 

Online Design Rule Check (DRC)  

Online Design Rules Check (DRC) will help you to detect design rule errors as they happen 
whilst you are editing your PCB design.  

As each item (track, component, etc.) being added, placed or edited is released, the program 
checks for design rule violations against other items in the design. All affected items are 
checked, including for example, any tracks attached to a component you have moved. 

If errors are found by these checks, error markers are added to the design, and a message box 
is displayed prompting you to choose between finishing with errors, or resuming adding or 
editing the item. 

 

To control this feature, the Online DRC check box is available on the Preferences dialog 
under the PCB Interaction tab. 

 

A shortcut to this switch is also available on the context menu when in select or edit modes on 
a track and when placing items. 

 

The Online DRC option switch is also accessible on the main Tools menu. 

Differential Pairs 

As part of your tracking or manual routing process, you can define and route in Differential 
Pairs.  

What is a Differential Pair? 

A Differential Pair is a term used in PCB design to define a pair of tracks that carry signals 
that are transmitted down them. These are usually tightly coupled tracks; one carries a 
positive signal and the other carries the returning signal, this tight coupling balances the pair. 
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Setting up Diff Pairs 

Diff Pairs are defined using Net Class settings within your Design Technology and they must 
be enabled for use by selecting the Differential Pairs check box. 

If Differential Pairs are enabled on a Net Class, Easy-PC will automatically detect pairs of 
nets using this Net Class and then based on their Net Names, it searches for pairs of nets with 
the suffix _P and _N and automatically designates those as a pair, for example, DQS_P and 
DQS_N. If you had DQS1_P and DQS2_N for example, these would not match as a legal Diff 
Pair. 

The Net Class dialog allows you to enable Differential Pairs: 

 

Once enabled, controls are available for separate Diff Pair Gap and Skew Length for pairs 
on the Net Class. 
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A gap different to the main Track to Track Spacing rule may be required for specific Diff 
Pairs. This is the gap between the edges of the tracks of a pair and overrides the normal Track 
to Track Spacing rule. 

The Skew Length value between each pair can be set, this effectively enables you to set a 
maximum delay distance. This can be as long or as short as required depending on your 
timing requirements. 

 

Other length rules for a Net Class can also be utilised within a Diff Pair, such as Min/Max 

Track Lengths, Maximum Via Count and Maximum Stub Length. 

Creating Diff Pairs 

When a Diff Pair is added to the design, it will be the actual centre of the two lines that is on 
grid, not the Diff Pairs themselves. This means you should try and use grid multiples when 
routing so that odd segments are avoided. 

To start a Diff Pair, you can choose a number of options: 

• Pick one of the Diff Pair connections and choose Turn diff pair connections into 

paired track from the context menu: 

 

• Pick either the connection or Pad of the Diff Pair connections and select Diff Pairs from 
the Edit menu. 

Once the Diff Pair option is selected you will see two ‘dots’, these present the start of the 
Diff Pair, a modal cursor indicated you are in ‘pairing’ mode. 

Gap 

Skew 
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From here, you can ‘draw’ in your pair. This operates the same as when adding tracks with 
most tracking modes available; Change Layer, Segment Modes, Display Clearances etc. 
These are available on the context menu. 

When you see the start points, you can also immediately right click to view the context menu. 
This contains the Route Connection At Start Point mode.  

 

When this is selected, the start of the Diff Pair will be taken from the pads and will 
automatically route out (where it can) to the Diff Pair tracks. 

Draw the tracking in as required: 

 



 Creating PCB Designs   195 

During routing, this uses the Diff Pair Gap (on the Net Class, if defined) or if not defined, it 
uses the Track to Track spacing for the current Net Class and Layers (this way you can have 
different gaps on different layers). 

During editing, you can use Change Layer using the context menu option or <L> key. Two 
vias are inserted along with suitably spaced tracking. When using Change layer, if not All 

Segments then it inserts a 45-degree via pattern where vias are separated using the Via to Via 

Spacing. 

 

Double Click to finish a Diff Pair 

While editing a Diff Pair, it uses the Edit Track options in Preferences to decide what to do 
when double-click is used to finish, for example, Finish Here or Auto Complete. 

Using Auto Complete will enable the pairing to finish on the target pads for you: 

 

Partial routing of Diff Pairs 

If a diff Pair has been partially completed, within Add Diff Pair mode, you can pick the two 
junctions at the end of the paired section to start from. Move the gather point back over the 
junctions to add paired segments to the existing ones and continue Diff Pair routing. 

Diff Pairs – Nets Bar 

Columns are available in the Nets Bar for Diff Pairs.  

 

The Edit Nets Bar Columns dialog includes Diff Pair Skew Rule and Diff Pair 

Skew. 
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For a Diff Pair net, Diff Pair Skew Rule shows the rule on a net if its Net Class has a skew 
rule defined and Diff Pair Skew shows the actual difference between the lengths of the two 
nets forming the Diff Pair. 

As with all Length columns in this dialog, the cells change colour to display whether the 
Skew is within the limits defined. 

Design Rules Checking of Diff Pairs 

The DRC Track Lengths check also checks and reports Diff Pair skew errors. 

Diff Pair Report 

A report is available in the Output menu and Reports called Differential Pairs Report. 

 

Copper Pouring  

As well as add basic copper shapes to the design, copper can also be used to produce partial 
copper planes or split power planes with intricate shapes and cutouts where the copper avoids 
obstacles such as pads and vias.  

You should use the Copper Pour Areas and Copper Pour if you wish to: 

• Add a copper shape with no net association (a shape with cutouts to avoid pads etc.); 

• Add a copper shape with net association, for a small ground plane area for example. The 
net will be connected to the copper using thermal relief;  

• Add a copper pour area to a layer defined as a power plane to create a split power plane 
(two nets associated with the same plane but not connected); 
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To achieve the above you must add a Copper Pour Area first to the design then ‘pour’ the 
copper into it.  

Copper Pour Areas 

A Copper Pour Area is used to define a boundary in which the copper is to be ‘poured’. 
Using these areas as templates for pouring provides the ability to re-pour areas and to clear 
blocks of copper within that area. It allows net association to be made where connection of the 
copper to a particular net, optionally with thermal relief, if required. It also allows properties 
or rules for that template to be defined. 

The Copper Pour Area shape options are located on the Add menu. Choose from four shape 
types; Rectangle, Closed Shape, Open Shape, Circle, Triangle, Square and Single Line.  

Copper Pour Areas can only be added to electrical or power plane layers. They cannot be 
added to non-electrical layers. When inserted, these areas are added to the current layer, this 
can be changed using the <L> key during insertion or after insertion.  

The Copper Pour Area is drawn using the Pour Areas colour in the Colours option on the 
View menu. The actual copper uses the Poured Shapes colour in the Colours dialog. These 
colours are layer specific depending on which layer the area or shape appears. 

 

Pour Copper 

���� To add a copper pour area 

1. From the Add menu, select the Copper Pour Area shape required. 

2. Select the area shape type and draw your shape. 

3. Copper Pour Areas can be modified using the same editing methods as any other shapes 
or areas.  

4. When the final shape has been completed, select it and from the context menu you will 
be presented with a context menu of commands applicable to Copper Pour Areas: 

Copper Pour 
Areas 

Actual Copper 
Shape 
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5. On this menu Pour Copper (and Clear Copper once the area is poured) are used. 

6. As their names suggest, Pour Copper is used to create the poured area and Clear 

Copper is used to remove areas of poured copper from the design. 

7. On selection of the Pour Copper option, a dialog is displayed. 

 

8. This allows you to associate a Net Name to the copper, to control the Minimum area 
size of copper poured and the Isolated Islands. Values for Thermal relief and Isolation 
gaps used for the thermal ‘connections’ of the attached copper spokes are displayed. 
These are taken from the rules defined in the Design Technology dialog and Rules page. 

   

9. Check the Isolated Islands Removal button or the Highlight button if you wish to 
control how isolated islands are handled. Isolated islands are created when copper is 
required but there is not enough space to connect it to the next shape.  
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The picture above shows the 
effect with isolated areas 
retained. 

This picture shows how the isolated 
area (on the right of the main 
copper area) has been removed 
because the check box is selected. 

10. Click the OK button to ‘pour’ the copper into the area. 

 

Net Association 

Poured copper areas can be made without any net association and are used to add more copper 
to an electrical layer if required avoiding the tracks, vias and pads etc. Net association will 
mean that thermal spokes and isolation gaps are automaticaly added to pads on that net during 
the creation of the copper area.  

The spoke width will be defined using the width of the Spoke Style defined in the Rules of 
the Design Technology dialog: 
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When associated with a net, leaving 'Thermal Pads' unchecked will pour copper over the the 
top of the associated pads. This may be a requirement for some design applications. 

During the pour of an area, all spacings used are as defined in the Spacings dialog. For each 
net the Guard Band spacing is also considered and added to the spacing already defined as a 
default. For example, a Guard Band spacing of 50 thou would be added to a default spacing of 
10 thou to create an overall clearance between the copper area and a particular track/via/pad 
of 60 thou. 

Copper Pour Areas can be assigned a net name and a pour order using the Properties dialog 
and Shapes and Area tabs. A Pour Order means that all pour areas in the design can be 
poured at once using the Copper Pour command from the Tools menu. They will be poured 
in numbered order in assending order. 

   

Warning: Do not pour copper onto layers which have been defined in the Layers page of the 

Design Technology as Powerplane. When plotted this can cause adverse results. See below 

for Split Power Plane usage. 

Editing the copper poured shape 

To edit a copper shape, the poured copper should be unpoured first using Clear Copper 

from the context menu. Do NOT use Delete to remove the copper shape. The Copper Pour 
Area template can then be edited and re-poured. This way all the spacings and net association 
are maintained.  

If curved tracks or shapes are used, the shape looks like this: 



 Creating PCB Designs   201 

 

Clear Copper 

Clear Copper is used to 'unpour' the copper area. This must be used to remove copper before 
editing or repouring the area. Any poured copper within a Copper Area will be removed when 
Clear Copper is selected. Copper which has not been poured but has been manually added 
will not be removed.   

���� To clear a copper pour area 

1. Select the Copper Pour Area boundary to unpour the copper area. 

2. From the context menu select Clear Copper. 

 

3. All the copper associated with that poured area will be removed including thermal 
spokes. Do not use delete on copper areas, this will not clear all the associated copper 
shapes created. 

Copper Pour Keepout Areas 

Adding a Copper Pour Area to a power plane layer and designating it as a Pour Keepout 
will cause that region of the layer to be kept clear of copper on the resulting plane. 

To designate the Copper Pour Area as a Keepout Area, select the area and then in Properties, 
select the Pour Keepout check box.   
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When the Pour Keepout area is added to the design, copper is avoided when poured. 

 

 

The area will be shown on the Preview in the Plotting & Printing dialog to assist you in 
checking that the area is set up correctly. 
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Split Power Planes 

The Copper Pour feature can also be used to create split power planes (split planes are two or 
more copper areas on the same layer, normally an inner layer that contain two different 
signals).  

To create a split plane there are a number of rules that should be observed: 

• The layer must be defined in the Layers dialog as an Electrical type. 

• The layer can be defined as Bias of Powerplane but must not have a net associated with 
it. 

• The Copper Pour Areas must be defined on that layer and must each be associated 
with the required power/ground nets that will connect to it. 

• The Copper Pour Areas must be poured. 

• The layer must be plotted as if plotting a normal electrical layer. 

By using Copper Pour Areas on an inner power plane layer, and a layer nominated for plane 
use (although the layer doesn't need to be a type of Plane as long as it is an electrical layer) 
but not associated with any nets, a split plane can be generated. 

Enough space should be left between each of the copper areas, although when poured the 
copper areas will be spaced to at least the distance of the Copper to Copper spacing rule 
defined in the Spacing dialog.  

When poured, the split planes will have this effect: 

 

This would then be plotted as you would a 'normal' electrical layer. The power plane has 
effectively already been generated using the copper pour and no other process is now required 
other than plotting it.  

Teardrops 

Teardrops are supported in the PCB design. A Teardrop is a copper shape which smoothes 
the entry of a track into a pad, causing the pad shape to resemble a teardrop. Adding teardrops 
would normally be done near the end of the layout process, when track positions have been 
finalised.  

Use the Apply Teardrops command from the Tools menu to add teardrops to all or selected 
nets. A teardrop is just a copper shape which you can later apply most of the normal edit 
commands on. So, for example, you can select and delete individual teardrop shapes once 
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they have been added. A teardrop will not be added if there is not sufficient track length on 
the track segment leaving the pad, or if it would cause a design rule error.  

These shapes are not dynamically changed, so they need to be deleted and regenerated if the 
design is changed. 

 

When the Apply Teardrops option is selected, a dialog is displayed to allow you to define 
parameters of the teardrop. 

 

You can control which types of pad receive teardrops using the Apply To check boxes. Check 
the Vias box if you want Vias to receive teardrops. Use the Round Pads and Non-Round 

Pads boxes to control if all pads other than Vias will receive teardrops. You may not want 
Non-Round Pads to receive teardrops because they do not produce the same smooth effect of 
round pads.  

As well as controlling which types of pads receive teardrops, you can select which nets. If you 
had nets selected when you entered the dialog, then the Selected Nets Only box will be 
checked, and only those selected nets will be used. Uncheck this box if you want teardrops 
applied to all nets in the design. Alternatively, you can use the Browse Nets button to select 
which nets will be used, once you have done this, then the nets you selected in the Browse 

Nets dialog replace those initially selected when you entered the Apply Teardrops dialog.  

You can control the appearance of new teardrops by changing the Parameters. The V-Angle 
is the angle formed at the sharp end of the teardrop. The smaller the V-Angle, the longer and 
more slender the teardrop will be. The default value of 60 degrees is a typical value. You can 
choose to curve the sides of the teardrop by checking the Curved Sides check box, this gives 
a better transition into the track itself.  

The Add Teardrops button will add teardrops to the design. Any existing teardrops will be 
removed from affected nets, before the new ones are added.  

The Apply Settings button simply stores any changes made in the dialog but it does not add 
any teardrops.  
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DRC Track Spacings for Teardrops 

A check box on Spacings page of Design Technology dialog instructs Easy-PC to use the 
spacings defined for tracks when dealing with teardrops. This is used instead of the default 
setting which is to use the Copper Shape spacings. 

The pouring will use the Shape to Shape spacing if this option is not checked: 

 

If the Use Track spacing for Teardrops check box is selected, it will use the Shape to 

Track spacing instead: 

 

Removing Teardrops 

You can remove individual teardrops by selecting and deleting them. There are three 
commands which allow you to remove them in batches. Remove All Teardrops will remove 
all teardrops from the whole design. Remove Teardrops From Selected Nets will remove all 
teardrops from the nets currently selected. Remove Teardrops From Browsed Nets will 
remove all teardrops from the nets selected from a dialog.  

Dimensions 

For documentation purposes in a PCB design, you can interactively create linear dimensions 
that show the distance between two chosen points. 
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On the Add menu in PCB Design you have the following options; Horizontal Dimension, 
Vertical Dimension, Radial Dimension, Angular Dimension and Free Angled Dimension. 
There are also three buttons on the PCB toolbar to add dimensions:  

 

Selecting one of these options puts you in Add mode for the appropriate type of dimension. 

���� To add dimensions 

1. Select the Add Dimension> option from the Add menu.  

2. The interaction is very simple; the first mouse click starts the dimension at the 
designated position. 

3. The second click places the end position. 

4. The third click fixes the length of the construction lines.  

5. Drag can be used at each stage instead of click and move, if preferred. 

6. The dimension text will be automatically updated to show the measurement between the 
dimension start and end arrows in current units. This will be automatically positioned 
between the arrows or to one end of the dimension as space dictates.  

7. Once added, a dimension may no longer be manipulated as a composite item, only as 
individual shapes and text. For removal, rather than editing a dimension, it should be 
frame-selected, deleted, and replaced by a new one. 

Dimension Defaults 

Dimension settings may be modified by using the Design Technology dialog and the Line 

Styles and Text styles pages. 

When adding Dimensions, their ‘look’ is defined from the Defaults page and Dimensions. 
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This dialog allows you to view and change the line styles, text style, layer and other settings 
used when dimensions are added. 

The Snap To Item check box will cause the dimension start or end point to be at the closest 
edge of the item selected. If a pad is being dimensioned the snap point will be at the pad's 
centre.  This option may also be toggled via the right mouse context menu when adding a 
dimension.  

Text Callouts 

There is a composite design item in both PCB and Schematic designs called Text Callouts, 
used for documenting points of interest.  

 

Text callouts consist of a text item, a shape around the text (the text box), a line from the text 
to the location of interest (the pointer), and a shape at the end of the line (the pointer end). 
These items are invisibly grouped so that if any one item is selected, the whole callout is 
selected, and so the callout is always considered as a single item. 

These are available on the Add menu, Add Text Callout and on the PCB toolbar.   
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���� To use Text Callouts 

1. First select the pointer end position, you will be presented with a dialog to supply the 
text and layer. The layer can only be a non-electrical layer. After this the callout is 
displayed on the screen and you can place the text item at the required position.  

2. The defaults for the styles, layer and appearance of new callouts are defined in the 
Defaults dialog. You can override this by pre-selecting a Text Callout or Free Text item 
before using the Add Text Callout function. 

 

3. Once added, you can alter callouts by dragging the text item, dragging the pointer end, 
moving the whole callout by dragging any other part of it, and changing cutouts 
appearance by double-clicking on it and using the Properties dialog. You can change the 
appearance of each of the three shapes. 

4. By default the text and shapes are drawn using the normal text and shape colour, but you 
can also highlight all callouts in a single supplied colour using the colours dialog. 
Individual callouts can also have their own colour using the properties dialog. 

5. Different styles of text callouts can be achieved by changing their Properties. 

The illustration below shows the various callout options: 

 

Measure 

This is an interactive option to measure between two design items.   

���� To use measure 

1. Select the Measure option from the Tools menu. 
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2. The Measure option appears, this is a floating dialog.  

3. This prompts you to select the first item to be measured. This window can be moved if it 
obstructs the items you wish to measure. 

  

4. Select an item, then a second item. 

5. The results window shows various distances between the two items. 

6. This is the real distance between the points as would be calculated through the DRC 
option and is measured against the closest point of each item selected. The electrical 
items selected will be highlighted in the selection colour to show which are chosen. A 
small line also indicates the points chosen for the measurement as confirmation. 

7. The window can be cleared using the small cross [X] or by selecting <Esc> on the 
keyboard. This will also cancel the option when you have finished. 

8. Sometimes there is no measurement that can be shown, for example if the two items are 
track segments on different layers; this is indicated in the result window too. 

9. Click the cross in the top right corner of the dialog to exit this mode or press the <Esc> 
key on the keyboard. 

Dual Design Units 

The Measure dialog/panel can display lengths/areas in two different units. From the main 
Measure dialog, click on the Units: button (the one that shows the current units) to access the 
Measure Units dialog. 

This dialog has an extra check box Show Two Units and a second pair of controls to let you 
set up the secondary units. 
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Once this is set up, any measurements you do will be displayed in both sets of units. The 
second unit set being shown in brackets ( ) on the Measure dialog: 

 

Design Rules Checking 

The Design Rules Checking option will allow you to check your design prior to sending it 
away to be manufactured. The rules checked against are set up in your Technology file and 
passed into the design in the Spacings dialog available from the Design Technology dialog 
on the Settings menu.   

While it is perfectly acceptable for unrouted tracks (connections) to criss-cross the board, 
routed tracks must not cross each other, and should be routed with a certain minimum 
clearance between each other and between tracks and pads.  

When this option is run, if DRC errors are found, the error will be highlighted using an error 

marker with an appropriate code for that rule violation. This will help you identify and 
correct the error.  
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Setting up clearances 

The clearances used for the check are set up from Spacings page on the Design Technology 
dialog. All combinations of tracks, pads, vias, shapes, text and board outline can be specified 
independently.  

 

The Rules page of the Design Technology dialog is used to define rules for other design-
based objects such as thermal relief on power planes and copper pour and Component 

Height Checks. 

 

Running the DRC option 

The Design Rule Check option is located on the Tools menu. 
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A dialog controls that items are included in the check. If an area on the design has been 
selected, it is also possible to check just this selection by checking the Selection check box. 

The dialog is split into areas of functionality to check – Spacings, Nets and Manufacturing. 

The design rule checker can be configured at any time to suit your design and manufacturing 
requirements. This information is stored in the Technology File. 

Resolving Errors 

When a Design Rule Check has produced errors, you have a choice of either correcting the 
error by re-positioning the offending elements, or of relaxing the minimum specified 
clearances in order for the check to succeed.  

Once you have made the appropriate edits you must re-run the checker, or to remove them 
temporarily (to view a clear design for example) select the Delete Errors button on the 
dialog. 

Removing the error marker from the design by using delete or by switching it off in Colours 
does not remove the error as well. Beware, this is dangerous in-case you forget to re-run it 
before plotting. 

Note that if a group of items are selected, the Design Rule Check can be applied to the 

selected items only by choosing the Selection option rather than the design option from within 

the Design Rules Check dialog. 

Finding the error markers 

Once a Design Rule Check has been completed and one or more errors have been reported, 
you can move through the errors in turn using the Goto> option from the View menu. Use the 
Goto> Next Error and Goto> Prev Error options. Alternatively, you can use the shortcut 
keys of <V> and <T> for Previous and Next Error respectively. 
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At each error the display will pan and zoom if necessary to show the offending elements in 
the centre of the screen with a line linking them together. There will also be a text item 
indicating the type of error, e.g. T-T is a Track to Track error marker. 

You may also use the Goto Browser and the Errors option. Each error can be selected from 
the list and the design will pan to the centre of the screen showing that error marker. 

 

DRC Error report 

The format of the report is similar to most of the others in that it starts with a header block 
giving information about the design file, followed by a list of all the errors found. Each error 
is described by type, location and layer, and a summary of the errors found.  

Note: If there are several errors between two items, only the first is reported. The occurrence 
of several errors is most likely with track to track faults. There is no risk in this as re-running 
the checker will always report the next error until all are cleared, and on large designs it helps 
keep the report to a manageable size. 

DRC Sign-Off Checks 

Two sets of DRC settings are stored in the design – one for ‘normal’ checking and the other 
for running as acceptance checking within the plotting dialog before manufacturing.   

The Checking Set is used at the start of the Plotting process to check your design before 
producing outputs, these form the Sign-Off checks. The Sign-Off checks are used as a final 
verification that your design conforms to the rules you’ve specified. It highlights important 
information, errors and warnings the moment before you send off your plots to be 
manufactured. It will ensure you remember to run the DRC checks and will highlight the 
errors to you at a critical time in the design process. 

DRC option 

There are two sets of DRC settings stored in the Design. You can use the Load and Save 
buttons in the lower left corner of the dialog under Checking Sets to load either of the two 
sets into the dialog, and save the current dialog settings away to either set. 

• Normal - The first is the 'normal' set that is used when running Design Rule Check.  

• Sign-off - The second is a 'sign-off' set that is used when running the Sign-off Checks 
prior to producing plots.  

Note: When you click the Run button on the Design Rule Check dialog to start the checking, 
whatever settings are present in the dialog at that time will be saved to the 'normal' set. 

The two sets of Load and Save are used for Normal and Sign-off checking sets. 
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Sign-off checks in the Plotting dialog 

A check box on the Plotting Options dialog is used to enable the Sign-Off Checks when the 
plots are generated. 

 

A button on the Options dialog to setup the Sign-Off checks. This is a reduced version of 
DRC dialog showing only settings, and main DRC dialog has controls for saving and loading 
both sets of settings. 

 

The Sign-off Checks button displays a reduced set of DRC options to enable you to select the 
rules to check. 
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‘Accepted’ DRC Errors (PCB) 

Error markers can be ‘accepted’ (as ‘signed-off’). You may find that DRC finds errors which 
you are prepared to accept (or 'sign off'). This might happen for example if you have a set of 
'finger' pads touching the edge of the board. DRC will flag these with 'Pad to Board' errors, 
which you can then set as 'Accepted' so that there is a positive indication that you have 
examined these errors and agree that they are not faults that need to be fixed. Once you have 
resolved all the faults in the design except those that you are prepared to sign off, you can use 
the Accept Existing Errors button to mark all remaining errors as accepted. Alternatively an 
error marker can have its Accepted property toggled using the Properties dialog.   

Accepted error markers are only deleted by you, either by deleting them interactively in the 
design, or using the Delete Accepted Errors button on the DRC dialog. When you run 
Design Rule Check, any existing accepted errors are left alone. 

Accepting errors 

Individual errors can be checked as Accepted on the Properties dialog. 

 

DRC dialog 

The DRC dialog has buttons to help with clearing and accepting existing errors. These are 
listed under the Existing Errors section: 

The buttons in this section are used to deal with existing error markers in the design. 

• Delete All Errors - removes all existing error markers from the design.    

• Delete Normal Errors - removes all existing error markers that are not set as 'Accepted' 
errors.  

• Delete Accepted Errors - removes only existing error markers that are set as 'Accepted' 
errors.  

• Accept Existing Errors - use this button to mark all existing error markers as 
'Accepted'. 

• Show/Hide Accepted Errors – use button to show and hide accepted errors in the 
design. 

On running DRC, the option will only delete ‘normal’ errors and will leave Accepted errors 
in-place. 
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Colours dialog 

There are different colours and visibility settings on the View menu and Colours dialog under 
Layers and Layer Spans and Accepted Errors. 

 

Find Error types 

From the Goto bar, on selection of Errors, you can list errors by type. From the context menu 
within the Goto bar, you can select List All Errors, List Only Normal Errors and List Only 

Accepted Errors. 

 

When showing a list of all errors, they are separated into 
two; Normal and Accepted, so they are easily visible. 

 

Adding Shapes 

You can add shapes both electrical and non-electrical layers. The type of shape that is added 
to any layer is dependent on the layer type itself. If the layer is electrical, the shape will be 
copper, if the layer is non-electrical e.g. Silk Screen, then the shape will be a non-electrical 
silk screen shape. A shape type of Shape can be added to electrical and non-electrical layers. 
It will appear as documentation, silkscreen or copper depending on which layer it has been 
added to. 

You can add Shapes (to documentation layers), add Board to create a board outline, add 

Copper Pour Areas (to electrical layers) for use with the pour copper option and add 

Routing Areas (to electrical layers) for use with the autorouter. You can also add Cutouts to 
all shapes. 

To add a shape, you can use Add Shape from the Add menu, or from the PCB Design 
toolbar. 
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Once the shape has been started you can use the context menu to control the Style and Layer 
of the shape, and whether it is Closed or Filled. The tick next to the Closed and Filled entry 
shows that it is used; by not selecting one of these items shows that it is Open or Not Filled. 

There are no specific rules for the polygon shape other than when filled it must have at least 3 
sides, and all segments can only be on the same layer. All segments must have the same width 
and style, and for polygons, they are not allowed to self-intersect. 

Copper shapes on electrical layers can be associated with a net. Copper areas with contoured 
shape following and net association are detailed in the following section. 

Shape Defaults 

When adding a shape to the design, the default style used is taken from the Design 

Technology dialog and Line Styles page. 

 

Hatch Defaults 

You can make shapes hatched using Hatch Styles defined on the Design Technology dialog. 

 

The dialog allows you to define hatch styles for hatch (single angled lines) or cross hatch (two 
sets of crossing angled lines). The angle can be changed as well as the coverage. Changing the 
coverage allows you to define what percentage of the hatched area has copper on it. A higher 
percentage will apply more copper to the area. A 50% coverage is normal. 

Available Types and their usage 

The table below shows the shape type available on the Add menu, the shape available for it 
and its layer usage and usage. 
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Shape Type Shape Layers/Usage 

Shape Rectangle, Closed Shape, Open 
Shape, Circle, Triangle, Square, 
Single Line 

Electrical and Non-electrical layers, Closed, 
Open, Filled, Hatched 

Copper Rectangle, Closed Shape, Open 
Shape, Circle, Triangle, Square, 
Single Line 

Electrical layers, Closed, Open, Filled, Hatched 

Board Rectangle, Shape, Circle, Square Only <Through-board> (all layers), only 
Closed, cannot be Filled or Hatched 

Merge Rectangle, Shape, Circle, 
Triangle, Square 

Electrical and Non-electrical layers, Closed, 
Open, Filled, Hatched 

Cutout Rectangle, Shape, Circle, 
Triangle, Square 

Electrical and Non-electrical layers, Closed, 
Open, Filled, Hatched 

Copper Pour Area Rectangle, Shape, Circle, Square Electrical layers, Closed, Open, Filled, Hatched 

Copper Pour 
Keepout Areas  

Rectangle, Shape, Circle, Square Electrical layers, Closed 

Routing Area Rectangle, Shape, Circle, Square Electrical layers, Closed, Open, Filled, Hatched 

Component Area 
Height Area 

Rectangle, Shape, Circle, Square Electrical layers, Closed, Open, Filled, Hatched 

Shape Usage 

Once added to a design, the Layer of a shape can be changed by selecting it choosing <L> 
Change Layer from the context menu.  

The shape Style can be changed by selecting the shape and using Change Style <S> from the 
context menu. 

 

If you need to change the shape type, from Silkscreen to Board for example, use Change 
Shape Type from the context menu. 
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If you wish to change a shape’s usage 
(Closed/Open, Filled/Not Filled, 
Hatched/Cross Hatched/Not Hatched, 
Fixed/Not Fixed etc.) select it and choose 
Properties from the context menu. 

 

To aid the drawing of shapes, you can use the Shape Information browser available on the 
View menu. 

 

You can also edit the shape during addition or interactively after adding, by selecting options 
from the edit context menu. Type Coordinate and Type Offset can be used to place corners 
and shapes whilst editing. 
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The Add and Delete Corner options are available also for selected segments when editing 
shapes as is the Arc> option to make the segment curved. 

 

Named Areas 

You can name some areas using the Properties dialog. 

 

Naming an area allows it to be referenced by name in the Arrange Components, 

Autorouting and Autoplace options, as well as the Height Checking. 



 Creating PCB Designs   221 

Component Height Checking 

From within the PCB design editor Height Checking is available for Components. This allows 
you to define a special height area on the design with a maximum allowed height. The 
maximum height allowed can be assigned on the whole board (using the Design Technology 
dialog and Rules) or on an area basis (using Component Areas).    

Using Height Checking 

The process for using this option is: 

1. Define the Height Value to be used in the Rules page of the Design Technology. 

2. Optionally, define the Side to be checked and the Max Allowed Height for that layer in 
the Spacings dialog. 

3. Add a Value of Height to the components to be checked in the design. Do this in the 
component library or in the design itself (using Properties or Component Values 

editor) on a component basis (it is more efficient to do this once in the component library 
for each component type). 

4. Run the DRC option and select Height under Manufacturing rules. 

Rules dialog 

On the Rules dialog on the Design Technology dialog, there are controls for setting up the 
maximum Component Height Checks for Top and/or Bottom layers, and choosing the 
default Value Name for components to define their height. 

The values used are in your current design units. 

 

Height Check Areas 

On the Add menu, there is an option to add Component Areas. These areas are layered and 
have a maximum Component Area Height setting available in their Properties. 

When the area is selected, Properties will allow you to change the area Height for checking. 
That is, components within this area will have their Height Value checked against the 
maximum Height defined for the Area (defined in the Spacings dialog). 

 

Component Properties 

For Properties of Components, you should add a Height value (Height is the default value 
but you can define and use any Value you wish). This value can be assigned locally within 
the design on a component basis but it is more efficient to define this in the Component 

library. 
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Design Rules Checking 

On the DRC dialog, a check box for Component Height under Manufacturing is used. Use 
this for checking the Values and Spacing Heights of components. 

 

Integrity Checking 

The Integrity Checker is used to check that the Schematic and PCB are 'in-step' electrically. 
Any problems with the design not being synchronised can be corrected using the Forward 

Design Changes or Back Annotation options. This is an important option.  

The Integrity Check option is run from the Tools menu. It begins to run immediately, 
displaying its progress in a window in the screen. 

On completion, it reports success or failure in the form of a Design Integrity Status report. 

If any Back Annotation changes are pending, you will be warned. These must be back 
annotated to the Schematic design prior to using the Forward Design Change option. 

The Integrity Checker works by extracting two connectivity netlists, one from the 
Schematic, the other from the corresponding PCB design. The two netlists are compared and 
any differences reported. If any discrepancies are found, you can bring the PCB in-line with 
the Schematic by using the Forward Design Changes option which is automatically offered. 

 

To make the Schematic design match the PCB you will have to note the changes or print the 
report and make them by hand manually. Design changes should always be made to the 
Schematic and brought forward using the Forward Design Changes option. 

The Integrity Check option can also be run as part of your DRC checks or Sign-off Checks. 
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Bringing Design Changes Forward from Schematics 

Both Forward Design Changes and Back Annotation are related although they are used 
independently. They both work to achieve design synchronisation between related Schematic 
and PCB designs. 

Forward Design Changes executes a partial netlist translate from SCM to PCB to update the 
design. This means that design changes made in the Schematic can be forwarded into the PCB 
design automatically. 

The diagram below indicates the 'flow' of information between the applications: 

 

 

Design changes which are 'pushed' forward include: 

• Net name changes/additions/deletions. 

• Connection/Net changes/additions/deletions. 

• Net Class changes/additions/deletions. 

• Component changes/additions/deletions. 

• Component Values changes/additions/deletions. 

• Package changes/additions/deletions. 

• Pin changes additions/deletions*. 

* disconnects track from pad end using the corner of the last segment inserted and reconnects 
to new pad without altering track path significantly. 

Undo levels are retained for all forward design changes (restricted within number of Undo 

levels defined in Preferences). 

Note: Forward design changes are often called Engineering Change Orders or ECOs and is a 

terminology normally used in larger companies to describe a 'note' to inform the PCB layout 

engineer of changes to the design being laid out. Forward Design Changes are used to best 

describe the function being performed. It is this function used if an ECO is raised to modify 

the design. 

To use this option the design should have been translated from Schematics to make a PCB 
design first. The PCB design doesn't necessarily have to be placed, simply having the design 
components and connections in PCB is enough to be able to apply further design changes 
from the Schematics. Components may also reside in the component bin. 
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The Forward Design Changes option is located on the Tools menu in Schematic or PCB 
design editors, or in Project. Before attempting to perform changes to the PCB, it is advised 
that the Schematic design be saved though this is not essential. 

When this menu entry is selected you are prompted with the dialog shown. 

 

The Component Library Directory browser will be used to locate the library for when 
loading new components into the PCB design. Although stored in the actual application it 
provides you the opportunity to change the location using the Browse button. The Ignore 

Different Package check box will ensure that the component package remains the same even 
if it has changed on the Schematic. Use Component Bin will add any new components to the 
component bin and will make the bin visible when the design changes are made. 

When the OK button is clicked, changes are made automatically and a report of the changes 
and/or errors is produced. The Undo option can be used to revert the changes made to the 
PCB if required. 

 

If the design has any name changes which have not been back annotated to the Schematic 
before a Forward Design Changes process is attempted an error message is displayed. Click 
on OK to clear the message and use Back Annotate before retrying Forward Design 

Changes. 

Connectivity Check 

The connectivity is a vital part of a design. When a Schematic is being designed, the 
connectivity is generated automatically as the interconnections are drawn. After Translation to 
PCB, or in the case of a PCB only design, the connectivity becomes vulnerable to editing 
operations. It is all too easy to decide that a net requires to be routed the long way round, and 
remove the link before manually re-routing it. This is no problem. What does cause a problem 
is when part of this route is accidentally omitted.  

Integrity check compares net lists. A design can pass perfectly and still be faulty because 
there are two clusters of tracks, electrically isolated, but with the same net name. This is a 
common result of the above scenario. The Connectivity Check detects all such instances, and 
generates a detailed report to enable corrections to be made. It will also detect places where a 
net has been started but not finished, so that only one connection is present.  

To generate the report, a PCB must be the active design. The report is run from the Tools 

menu and Connectivity Check.  
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The dialog displayed contains a check box for Report, 
which should be checked. You can also choose whether 
the whole Design should be checked, or only Selected 
items. If you choose only selected items, all nets with the 
same name as any of the selection will be checked, not 
just the specific highlighted items. 

The report comprises of header information for the design, followed by a detailed report of 
problems found. The last few lines contain a summary, giving a quick overview as to the 
extent of any problems. 

Back Annotation to Schematics 

Back Annotation provides a facility to make changes in the PCB design to the net names and 
component reference names, either manually or in the case of component names 
automatically, and to then apply those changes back to the master or original Schematic 
design. 

Any changes made to the PCB are automatically stored with the PCB design, there is no 
separate or additional file to retain with the design. This means that the associated Schematic 
design will be able to detect whether back annotation changes are required when the option is 
selected. 

Back annotation is run by selecting the Back Annotation option in the Schematic design 
editor or from the PCB design editor from the Tools menu. When run from the PCB design 
editor without the associated Schematic or project open, the system opens the Schematic 
design automatically ready for the back annotation. 

 

With the Back Annotation dialog you have the option to View Renames before they take 
place and to click OK to perform the changes. Cancel will exit you from the option without 
performing Back Annotation. This gives you the facility to check the any back annotation 
changes as you progress with your design. 

Back Annotation Renames Report 

------------------------------ 

Report Written : Thursday, June 05, 2022 

Design Path    : C:\Examples\Design99.pcb 

Design Title   :  

Created        : 05/05/22 11:58:05 

Last Saved     : 05/07/22 12:00:56 

Editing Time   : 48 min 

Outstanding PCB renames awaiting back annotation to the 

Schematics design(s). 
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Rename Component from "U2" to "U1". 

Rename Component from "U1" to "U2". 

End of Report. 

 

The report for View Renames shows the steps which need to be taken by the program to 
change the Schematic so that it is in-step with the PCB design. 

When the OK button is clicked you are presented with a warning dialog which allows you to 
confirm the back annotation changes. This is your final chance to escape the changes before 
they are made permanent. 

The changes are made permanent with no undo facility available because back annotation is 
seen as a 'down-stream' design process after the initial PCB design and one which is 
synchronising the Schematic and PCB designs. 

Once the changes are made to the Schematic, the design should be saved. 

Back annotation should be used after any changes to PCB net names, after using the 
automatic component rename option, after making any manual component changes, and 
before making any changes to the Schematic (after making net or component name changes in 
PCB). If back annotation changes are pending for the Schematic and a Forward Design 

Changes is attempted, you are prompted to use the Back Annotation facility first. 

Be warned, if Back Annotation is not run to make necessary changes, the Schematic design 
can easily become out of synchronisation with the PCB design. 

Using the Cross Probe Mode 

This feature allows you to probe and locate items in a known design. It enables bi-directional 
Cross Probing between corresponding Schematic and PCB designs, between Schematic 
designs within a Project or between any open designs. This enables better integration of 
design data between each stage of the design process. 

   

To use this option, a toolbar button is available to put the applications into the Cross Probe 
'mode' prior to probing. There is also an entry on the Edit menu, Cross Probe, which selects 
the cross probe mode. 

 

Once this is selected the designs can be cross probed. 
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Items which can be probed 

Pins/Terminals By picking the pin. 

Components By picking a component or symbol gate. 

Nets By picking connections/tracks/net names or copper. 

Closed busses By picking the closed bus containing the same net 
names (good for viewing all similar closed buses). 

Where multiple sheets have been combined to make one PCB, the sheets must be 
encompassed by a Project in order for probing from the PCB design to search all design 
sheets. Where Projects are not used and a single Schematic sheet is probed with a 
corresponding PCB design the design names for both must be the same. These rules apply if 
you wish to make sensible use of the probing mechanism and can be controlled by the settings 
defined on the Preferences dialog (detailed below). 

If different designs are in the same Project and do not have the same name, they can still be 
probed using the Probe All Open Designs switch from the Settings menu and Preferences 
option (detailed below). 

Cross Probing Schematic to Schematic is useful for checking for multiple component 
references and symbol gates not located together as well as checking nets spanning multiple 
sheets. Again though, Schematic to Schematic sheets must be included under a single project. 

The Cross Probe tab on the Settings, Preferences dialog enables Cross Probing to be 
tailored to be your own preferences. 

 

As its name suggests, the Bring Probed Design Windows to Front will ensure that the 
probed design is always visible by forcing it to the front as the active design. 

The two other options under the Which Designs To Probe heading allow you to force 
intelligence into the cross probing. Probe Corresponding Design means only designs under 
the Same Project or Same Name will be probed, any other design names will be ignored. If 
probing a PCB design, a Schematic design not containing probed net names will be opened 
automatically. If probing a Schematic design, the PCB design will be opened and probed but 
only the Schematic designs already opened will be probed. 

Probe All Open Designs has the opposite effect and allows any design to be probed 
regardless of its name and even if it doesn't correspond to the other open design - care should 
be taken using this option as it could mean an irrelevant design is accidentally probed!! 

Single Shot Operation enables cross probing 
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Using the 3D Viewer 

The 3D viewer allows the ‘flat’ view of the PCB to be annotated so that it can be seen as it 
would be when populated with components after assembly. A menu option 3D View on the 
View menu in the PCB editor is used to send the current design into the viewer. 

The appearance of components in the 3D view is controlled using the 3D Package library type 
edited from the Library Manager.  

 

Using the 3D Viewer 

The 3D Viewer option is easy to run, use the 3D View option from the View menu and a new 
window is opened containing the design in a 3D view. Options within this window allow you 
to customise the look of the design. Packages must be created in the library to represent the 
3D view of the PCB footprints within the design. The standard library contains 3D Packages 
for all supplied PCB symbols but more can be added of your own. 

Within the viewer you can manipulate the view by using the zoom and unzoom shortcut keys, 
<Z> and <U> respectively. By clicking and dragging the mouse you can roll the PCB in three 
axis to show all views of it. 

Options within the 3D Viewer 

The Options dialog is available on the 3D toolbar and on the View menu. The tabs within it 
allow you to define how the 3D view will look. 

 

The Layers tab will enable you to switch on and off the design layers within the view. Note 
this is not displayed when viewing 3D Settings in the PCB Editor, only available in 3D 
Viewer. 

The Colours tab allows you to setup preferred colours for the 3D view. 
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The Settings tab is used to define view parameters such as the thickness of the board in the 
3D view. Each of the entries for Sizes defines a thickness that can be created and viewed. 
Generally speaking, Board and Copper thicknesses would be consistent, whereas you may 
change the Gap thickness to show internal layers more clearly, perhaps to show the internal 
via stacks. 

Defining the 3D Packages 

In order to view components in the 3D viewer, you must define the package ‘shape’ in the 
library. There is a tab on the libraries dialog called 3D View, use this to define package 
libraries.  

 

The package libraries have the file extension .pkg. The contents of the package libraries have 
definitions which relate to a footprint or groups of footprints, for example DIP*. The supplied 
libraries are defined by functional groups i.e. connector, CPS, SMT, DIP 

Package Overview 

3D Packages define how PCB symbols are represented in 3D View images of your PCB 
designs. Each 3D Package has a 'style' (DIL, Quad, Axial, and so on), and various settings 
that control how the 3D image is generated. It also has one or more names that specify which 
PCB symbols the 3D Package applies to, allowing one package to be used to generate the 3D 
image for many PCB symbols. These names can be specific symbol names, or they can 
include 'wildcards' to match multiple symbol names.  

To generate the 3D view of the actual components on your PCB design, the set of package 
libraries is scanned to find the first package that matches each of the PCB symbols used in the 
design. Because each package can have a basic name and a set of 'aliases' both of which can 
include wildcards, it is possible to create packages that can auto-generate the 3D view for 
many PCB symbols. 

3D Edit Dialog 

The 3D View tab gives a summary of the selected item, and small pictures in 3D and 'normal' 
view of a corresponding footprint. The PCB symbol that is used for this dialog will be the first 
one found that matches the rules defined by the selected package. 
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System Reports 

There are a number of report files that can be generated. Some of these are error and status 
reports, while others give information about the content of the design files.  

 

When created, all the reports 
automatically open in your 
nominated viewer for immediate 
display, with the exception of the 
comma separated values (CSV) 
parts lists. 

All of the supplied system reports 
can be accessed from the Custom 

Reports dialog on the Output 
menu. 
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Component Positions Report 

One report of special mention is the Component Positions Report. This report will output 
information suitable for assembly machines. Because this is created in the User Report 
section, it can be edited to your own specification.  

Component Positions Report 

Units : mm (precision 4) 

Name Component Side Place X Place Y Rotation 

J1 6-174681-6 Top 75.0452 174.6250 90.00 

J2 6-174681-6 Top 75.0452 98.4250 90.00 

U24 74AC174SJ Top 158.7500 154.9400 90.00 

U25 74AC174SJ Top 189.2300 154.9400 90.00 

U11 74LS151 Top 87.6300 91.4400 180.00 

HTML Reports 

An integrated report viewer is provided, this includes ‘live’ HTML for some reports with 
links back to design data. The links back enable you to probe report items within the design. 

To activate the HTML reports, from within the Preferences option (Settings menu) and 
General page. Under Reports, there are two check boxes: View Reports in Report Browser 
and As HTML 

 

If View Reports in Report Browser is enabled, any TXT or HTM report that would 
normally be sent to Notepad or your normal web browser will instead be sent to the Report 

Browser. The only files that are sent outside are be CSV files. 

Report Browser 

The Component Positions report would look like this for example. Where items are shown as 
underlined hyperlinks, they can be queried back to the design.  
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Browser Controls 

Browser controls along the top of the report allow you to configure the report or print them. 

 

Settings takes you to your General Preferences. Print - reports in the report browser can be 
printed to your Windows printer.  

Custom Reports 

As well as system reports, the Custom Reports dialog can be used to create advanced Parts 
lists.  

 

By editing the selected report, you are able to add build information to the report. 
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This dialog allows you to edit the contents of a component list contained in a user-defined 
parts list. The settings on this dialog control how the output will be formatted, which 
components should be included, and in which order they are listed. 

Each field can be edited to add detail for when formatting the report. 

     

BOM (Bill of Materials) / Parts List Composer 

The BOM Composer allows you to create BOM reports and Parts Lists using a simple point-
and-click WYSIWYG (what you see is what you get) dialog.    

Available on the Output menu the BOM Composer option opens up a new set of dialogs to 
control the BOM (Bill of Materials) creation with various levels of user control over 
formatting. 

Using example templates, a built-in default setup, or building your own template from 
scratch, the whole process is quick and easy. What's more, you can immediately see the effect 
of each change you make to the template, right in front of you on the screen. 
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When the BOM Composer is first run, the dialog will look something like the picture shown 
above. 

Along the top are some controls that are used to load, save and generate BOM templates and 
reports. Below this are some lists and buttons which allow you to control what appears in the 
BOM and how it is built and formatted. 

Finally, the main body of the dialog shows you the BOM as it is generated based on the 
current settings. At the top right is a button that lets you 'fold up' the dialog to hide the lists 
and other editing buttons. Once you have got your BOM formatted how you wish, you can 
hide away the formatting controls to give you more space to view the actual BOM. 

For more detail about configuring and running the BOM Composer, please refer to the On-
Line help. 
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Chapter 9. Output for Manufacture 

Overview  

There are a full range of output capabilities supplied for printing, plotting and manufacturing; 
these are accessed from the Output menu: 

• Gerber RS-274-D, RS-274-X and X2 format files  

• Excellon compatible NC drill files  

• PDF format files (using a built-in driver that is supplied for you) 

• Windows printer devices 

• HPGL compatible pen plotter files 

• ODB++ format files  

• IPC-2581 format files 

• DXF files (AutoCAD compatible)  

• IDF 2.0 and 3.0 format files (cost option export)  

• GenCAD format files (cost option export)  

• Pick & Place Coordinate lists (from Reports dialog) 

Each of these outputs is described on the following pages. For printing and plotting outputs, 
the dialogs use a common interface. This interface is discussed first followed by specific 
information about the different formats and outputs required for manufacturing. 

Note: ODB++, IPC-2581, DXF, IDF and GenCAD are output from their respective menu 

options on the Output menu and not from the Plotting and Printing option.   

The Plotting and Printing Mechanism 

For Gerber, Pen and Windows outputs the process is fundamentally the same with small 
variations to cater for the formatting specifics of the file type to be output. 

The Plotting and Printing option on the Output menu encapsulates all the necessary plots 
into a single, re-usable plot ‘job’. These plot jobs can be used to reliably recreate your plots, 
not just for one design but also across all designs using the same technology. 

The plotting ‘process’ 

For the initial plot session, you will need to create a plot job. After the initial session you can 
reuse plot jobs and edit existing jobs, although the jobs are very simple to create using the 
automated process of the option. 

The flow of the process is to start or open a new job, choose the device type, auto-generate the 
plot job, select the plot(s) required, make adjustments to the plot and run the output to 
generate the plot set. 
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Creating a Plot Job 

When you select Plotting & Printing from the Output menu, the main plotting dialog will 
open. This option can also be accessed from the toolbar using the Plotting button. 

You will note that the whole plotting mechanism is the same for both Schematic and PCB 

design, except that for Schematics there is no layer information which makes the process 

much more simplified. 

The dialog is divided into two main areas. The first deals with the current Plot Job file, and 
the second shows the contents of that Plot Job. Buttons in the top right allows you to run the 
plot job and to access various subsidiary dialogs to view or change device options.  

 

Depending on the general plotting settings, you may find that some plots have already been 
generated for you. If not, the next step is to create the plots you need for your design. 

A typical plot job 

If we consider an example 4 layer PCB design with: 

• two signal layers 

• two power planes (for power and ground) 

• through-hole components on top side 

The following steps would be all that is required to create a plot job for our design:  

1. Select New Job, click on Gerber (or whichever format is required). 

2. Under Layer/Plot types, uncheck All, and check all other plot types except undersized. 

3. Under Side, check 'All'. 
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4. Click OK. 

5. The plot list is now completed with a plot for each layer and plot type requested. 

Plot Jobs 

Plotting works around the concept of a 'Plot Job'. Each job defines a list of plots, with each 
plot specifying the type of output device and what is to be included on the plot. Plot Jobs can 
be created, saved, edited and re-used, and are independent of any particular design file. If you 
are reasonably consistent about the technology settings you use for your designs, you should 
be able to create a small set of Plot Jobs that can be re-used time and time again to generate 
the plots for all your designs. 

The row of buttons along the top of the Plot Job area allows you to manage the current plot 
job: 

 

The functions of these buttons (from left to right) are: 

• New Job: create a new job with a set of plots. 

• Open Job: load an existing job file. 

• Save Job: save the current job. 

• Save As: save the job under another name. 

When opening a Plot Job, the program looks in two places. The first is the Job Files directory, 
and the second is the directory where the current design is stored. The Open Job dialog lists 
the jobs it finds in these two locations, and displays the description (if any) for any job file 
you select. 

 

The Job Dir… button will allow you to choose the default Jobs folder. 
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Plots 

Each plot in a job specifies the type of device it will output to, the layers to be included in the 
plot, and a range of other settings depending on the type of plot (such as pen numbers, 
inclusion of pin names and numbers, etc). 

There are two lists in the lower (plots) area of the dialog. The left-hand list shows you the 
plots that are already defined for this job. The right- hand list shows the items (layers etc) that 
don't have plots defined for them in this job.  

Plots are managed using the buttons provided:  

 

• Add Plot: add a new plot to the job. 

• Copy Plot: add a new plot by copying an existing one. 

• Delete Plot: delete the selected plot. 

• Reposition: reposition plots to re-align with selected plot. 

• Step & Repeat: use this to create the rules used to export multiple plots. 

Plotting & Printing Devices 

For each plot a device is selected. Initially, this might be the default device/layer combination 
choice made when generating the Plot Job. This can be edited using the selections on the tab 
dialog, this also includes the device type. Additional plots can be added to this Plot Job even 
if they are similar to other plots which already exist. For example, a full set of Gerber plots 
for final manufacturing can be copied and changed to also output to a Windows printing 
device for checking the plots before they are sent away. 

 

Each of the tabs is discussed in more detail later on in this section.  
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Auto-generating Plots 

The best way of creating plots is to let the program do it for you! From the row of buttons at 
the top of the dialog, click on the New Job button. 

 

Auto-generation of plots for a design depends on the type of design and the type of the output 
device selected. On choosing to create a new set of plots, the first thing you need to do is 
decide on the output device type. 

 

In a schematic design or a symbol, this is all you need to do. The single plot needed to print or 
plot your design is created and you are returned to the main Plotting dialog.  

For a PCB design, selecting Gerber will also enable you to create an Excellon plot for the 
NC Drill data if you select the NC Drill the check box. You can also produce a Drill 

Drawing plot by selecting the Drill Drawing plot check box. For other output types in a PCB 
design, you should use one of the other options available for the plots it should cover. 
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There are two main selections, the Layer/Plot Type and the Side to plot. 

Layer/Plot Type relates to the Layer Type specified in the Layers dialog on the Settings 
menu for Electrical and Non-electrical layers, as well as Power plane layers and special 
plots for pads-only. 

Side allows you to choose the side required for plotting. 

Powerplane Layers 

For power plane layers, the program will automatically select the appropriate plot type for the 
plots it generates. 

Additionally, if a power plane layer is found to contain actual design items (perhaps you have 
some tracks on the power plane), two plots are created, one to produce the negative oversized 
plot for the power plane itself, and one positive plot to be super-imposed to get the items 
‘embedded’ on the power plane layer. 

Pads-Only Plots 

The Pads-only Oversized and Undersized plots are for layers which can contain pads and can 
therefore be plotted as pads-only. Pads-only plots are typically used to create solder mask 
(resist) and solder paste plots. The Auto Generate dialog allows you to choose one or both of 
these plot types which will be used for each side of the board, as well as allowing you to 
specify the amount by which these plots should over or under size the pads as they are plotted. 

Values for the over and under size are defined in the boxes adjacent to the plot type and are 
defined in the current units. 

Generating the Plot Job 

When you have chosen what plots you want your plot job to contain, click the OK button to 
add the relevant plots to your plot job. 

Adding Plots to a Job 

As well as auto-generating a whole set of plots, you can add individual plots by clicking on 
the Add Plot button. This will bring up the Choose Device Type dialog. 

 

Once selected it opens up the relevant plot ‘details’ dialog to allow you to specify what to plot 
or output, as is the case of Reports, DXF or IDF. This dialog is described in the next section. 
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Editing Plots 

The details of each plot are easily accessed. The plot details are displayed for the currently 
selected plot. 

 

To edit an existing plot, click on the plot name in the list of plots. The plot detail has four 
‘tabbed’ pages. The exact contents on some of the pages depend on the device type for this 
plot, but the basic operation is the same for all of them. 

The pages described below are almost the same for each plotter or output type. Where 
differences appear, these are highlighted. 

Output dialog 

The Output page is used to specify the name of the plot, its type and the output mechanism. 

 

Plot Name is a name you type in. By default, the option will give you Plot 1 as the name but 
it is better to give the plot a more meaningful name. 

Plot Type enables an artwork plot or an outline or check-plot to be specified for output. 
Mostly, Artwork will be used, but a quick check-plot may be clearer, and will use less ink, if 
Outline is chosen. For Excellon, the output is set to Drill Data. 

Output To is used to show the direction of the output. For Pen Plotters there is a choice of 
File, Com1/2, File or LPT1/2/3. With the Windows printers this is set to your current default 
Windows printer. With the Windows printers, the name of the print device selected is shown 
but greyed out. This device can be changed using the Device Setup dialog. The destination 
will be one of the ports supported by the computer. When using serial (COM) ports, it is 
important that the communications settings used by the operating system correspond with 
those set for the plotter. A browser allows you to select a destination file if you have chosen 
File as the output. Gerber and Excellon plotters can only be directed to File. 
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With the Windows option you are able to specify the number of Copies to print at a time.  

 

This saves time in setting up the dialog and in the load time to the printer. Once the initial 
setup to the printer has been completed and loaded into the printers’ memory, additional 
copies are simply the time taken to put the print to the paper itself. 

The Step & Repeat button allows you to panelise your design, in other words to add multiple 
copies of the same design onto a panel when it is plotted or printed. This is discussed below in 
more detail. 

Gerber File Extensions 

When setting up Gerber files, you can also customise the file extension for each plot. To do 
this, select the Setup button on the setup page.  

 

This opens the Gerber File Extensions dialog from where you can customise the file 
extensions. 

Step and Repeat Plotting 

Included in the main Plotting & Printing option is the ability to Step & Repeat plots. This 
allows you to print multiple copies of the same plot, side-by-side on the paper or artwork 
without using an additional post-processing tool or process. Using this mechanism is an 
alternative to that of using the Panel Editor option.   
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The Panel Editor is a more comprehensive mechanism and is the preferred method of doing 
this. The Panel Editor not only allows you to panelise one design into many arrays, but also 
enables you to panelise different designs (provided they have the same layer count). 

Layers dialog 

The Layers dialog displays a list of layers in the design to select for plotting. The Excellon 
output doesn’t use this table and is therefore not presented here.  

 

By selecting more than one layer you are effectively creating a combined plot. Remember that 
even though you might combine a number of layers, these are still only one single plot. To 
plot all the different layers shown on this dialog, you will need to create a number of different 
plots. 

This gives control over the finished print. It is often useful for a check-plot to output the 
layers together in colour, but for prototyping (for instance) they would need to be separate. It 
also allows for 'composite' plots to be generated. That is, plots which require two sets of data 
which have been produced over two layer spans, or where two layers are required using 
perhaps two different pen colours to show both the top and bottom layers. By toggling the 
Selected box to Y, you will make that layer selection active and therefore output. 

Settings dialog 

The Settings page is the same for Gerber, Pen and Windows outputs. Excellon has no 
Settings dialog. This dialog is used to define the contents of the plot.  
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Fill Drill Holes enables an output to have any drilled hole to be solid. When prototyping. It 
can be useful to have all drill holes filled, as then a slight drill misalignment becomes 
unimportant. 

All Colours Black is used for the Windows printers where all colours are printed to black 
regardless of their on-screen colour. Without this box checked, a coloured design on a colour 
printer will be printed in full colour, and a coloured design printed to a black and white printer 
will become greyscale.  It is often a necessary function when generating printouts which will 
be used for prototyping to ensure that they are as black as possible to give the maximum 
effect.  

Plot Board Outline is used where you wish to include the board outline in the plot. This isn’t 
always required and so is available as a check box option. The additional check boxes allow 
you to specify which type of plate status you need to plot. This allows you to plot board 
cutouts that are plated to highlight these to your manufacturer. 

Include Drilled Out is used if you have pad styles where the drill size is larger than the pad, 
this produces an effect called 'drilled out pads' where any copper land for the pad would be 
completely removed by the drilling process. If you want to suppress the pad land from these 
drilled out pads, then uncheck this check box. 

Plot Pin Names/Numbers, again this is an option for the instances where these items may be 
required for checking purposes for example. Under normal circumstances these are not 
normally required. 

If a Pads Only plot is selected, then a pads-only output will be generated for the layer. This 
activates the Pads Only Plot section in the top right hand corner of the dialog which allows 
you to make the pad selection and oversize selection for the output. 

A solder resist mask consists of a pads only plot, with all of the pads being both filled and 
also oversize (or undersize) by the amount specified in the ‘Oversize’ box. For a solder resist 
mask it would be normal to oversize the pads to allow for any slippage over the actual size 
used. For a solder paste mask used on SMT pads it would be normal to undersize the pads to 
shrink the actual size used. 

All Colours Black is used for the Windows printers where all colours are printed to black 
regardless of their on-screen colour. Without this box checked, a coloured design on a colour 
printer will be printed in full colour, and a coloured design printed to a black and white printer 
will become grey-scale. It is often a necessary function when generating printouts which will 
be used for prototyping to ensure that they are as black as possible to give the maximum 
effect. 

Exclude Tented Vias is used to exclude any vias that are designated as Tented by the settings 
on their Net Class or Via Properties.  

If plotting a power plane to a Windows printer, you may plot positive and negative plots 
together to give you a composite plot. This would be used if the power plane contained track 
items on it. 

Power Plane 

When generating power plane plots, Thermal Relief and Isolation Gap ‘spokes’ and 
isolation gaps are plotted for pads and vias on the appropriate power plane net. are used with 
power planes in PCB designs. The settings for these are taken from the Design Technology 
and Rules dialog. 
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These values are used for layers which are defined with a Bias of Powerplane in the Design 

Technology and Layers dialog and which are selected as 'Yes' in the selected entry at the top 
of the Layers dialog.  

Thermal Relief and Isolation Gap can also be overridden on a per-area basis for Copper 

Pour Areas. 

When a through hole is connected to a power plane, it is necessary to 'slot' the continuous 
copper sheet adjacent to any drill hole (otherwise too much heat is required for soldering). 
The program puts in four profiled slots (Isolation) for each such hole, positioned round the 
outside of the pad so as to leave bridges (thermal relief) on the major axes. It is the width of 
these bridges that is specified under ‘Thermal Relief’. The isolation gap is similar, but in this 
case, it is the width both of the thermal relief slot and the extra clearance allowed round an 
isolated pad where it passes through the power plane. 

The generation of power planes is based on selections shown as small pictorial representation 
to display the intended output. 

Plot combinations are possible using the switches but also final composite plots to give the 
full plane required in the correct positive/negative film for use directly with Windows printers 
and photo-sensitive films. 

When the Positive/Negative list box is selected, four types of plot outputs are displayed: 

Negative (only plot gaps)  

This is used to produce a plot of all the oversize in the plane, mainly for the 
Gerber output, to be reversed and combined with a Positive (only plot items) 
plot. 

Negative (plot isolation)  

This is used to create the full power plane with isolation gaps, thermal relief 
and embedded tracks (with isolation) but in negative mode. To create the 
power plane from this plot, the image would need to be photographically 
reversed. Producing this type of plot saves printer toner and can be 
photographically reversed to get the plot image required. This option is not 
available for Pen plot outputs. 

Positive (only plot items)  

This is used if the power plane contains 'embedded' tracks or items. This plot 
is the item itself without any isolation or thermal relief. This would be used 
in conjunction with the Negative (only plot gaps) plot to produce a power 
plane with embedded items for a Gerber plot. 
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Positive (plane & items)  

This is the full power plane output with isolation gaps and embedded tracks 
with isolation clearances and thermal relief where connected to the plane. 
This is used to create the full power plane with everything plotted as it would 
be when manufactured 

This option is not available for Pen plot outputs. 

Position dialog 

The Position dialog is used to set the position and scale of the plot on the plot bed. 

 

The best view of this dialog is when using the Preview option. Check the Preview check box 
to reveal an additional preview pane. Using any of the options on the dialog for scaling and 
positioning the plot will change and update the Preview view. 

When viewed, the red outer box shows you the plot bed or paper size. The blue box is the full 
design extents; that is everything in the design, including the drawing border. The green box 
is the board extents. 
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The Options Dialog 

The Options dialog is used to define the Device Setup, the default Job folder and where the 
plots are written. To open this dialog, click on the Options button on the main Plotting 
dialog. 

 

The buttons along the top of this dialog allow you to access the device-specific setup dialog 
for each type of output device. These settings are independent of any particular plot job, and 
are generally stored in the system registry (and hence 'persist' between design sessions). 

 

Each plot has a name, which is used to give the resulting plot output file a name (for those 
plots which are actually output to a file). 

The Job Files area of the dialog allows you to view (or change, using the Browse button) the 
directory where the 'master' job files are stored. 

 

Plot files are written out to the location specified in the next area of the Options dialog. This 
should be set up to fit in with the way you want to organise your files. 
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Customisation of Plotting File and Folder Names 

User-defined formatting of Folder and File names in the Options dialog of Plotting and 

Printing is available. This uses a ‘tag’ scheme with user-defined key words to format the 
output filename. This applies to the folder name when the folder is set to ‘this folder below 
design’, and to file names for each plot. 

Tags can include Design Name, Plot, Plot Job and Project Name, Device Type, etc. To help 
you construct the tag pattern, syntax and creation, there is a new Compose dialog. 

Where patterns are used 

These patterns are used to construct the folder name for storing plots and other files generated 
during Plotting and Printing, and also to construct the actual names for these files. This 
allows you to apply some quite sophisticated rules to name and organise your output files. 

When composing the pattern for the output folder, the default value is simply the text "Plots" 
which will place the output files in the Plots folder below the design file.  

When composing the pattern for actual output files, the default value combines the design 
name, the plot name, and (if variants are used) the variant name.  

By selecting the Compose button, this reveals the Compose File Name Pattern dialog. From 
here, you can make choices that will customise your output filenames. 
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The File Name Pattern box on the dialog shows you the current pattern. These patterns are 
made up of 'tags' or 'fields' that are replaced at runtime with the relevant values, as well as any 
text required to complete the name. 

Example Name: will display a preview that will show you what the final composed name 
might look like when the current pattern is applied. This will help you to quickly see the 
results of manipulating the pattern by altering the text or adding or removing elements.  

Click on any of the buttons in the Insert Elements area to add the relevant item to the pattern 
at the current location of the text cursor. 

When you click any function button that is not a text character, you will see the relevant tag 
added to the pattern. The 'character' buttons are there for convenience to simply save you 
typing the character yourself. They do not form part of the element but are used for filename 
formatting. 

As well as design elements, you can also choose to add a Value to the pattern. The drop down 
list will provide you with all the value names defined in your design. Not only does this give 
you system values but also component values should you so wish to use them. 

To remove elements from the pattern, click within the tag on the pattern box, then click the 
Select Element button. The text for that tag will become selected, and you can then either 
click one of the Insert buttons to replace that tag with the one you really want, or click Delete 

Selected to remove it from the pattern. 

You can also edit the pattern by hand, to insert, alter or remove plain text items. 
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The Options Section 

The Options section contains settings that you can use to control the way the plotting works. 

 

Output Plots to Zip file 

There are two check boxes on the Options dialog of the Plotting dialog. This allows you to 
automatically save the generated output files (Gerber, NC Drill, Reports, etc.) directly into a 
Zip file, and optionally remove the individual files afterwards. 

 

Pack output files into a Zip – output files are exported as normal, then saved into a Zip file. 
Without the Remove check (see below) selected, all the files will remain saved on your hard 
drive along with the Zip file also. The Zip file will be named DesignName -.zip following 
your file name pattern for plots. 

Remove individual files after Zipping – if the check box to Zip the output files has been 
selected, selecting this option will then remove them from your hard drive. All plots will be 
removed and just the Zip file (containing the plots and reports) plus the Plot Report will 
remain. 
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Pre-Plotting Checks 

Before opening the main Plotting dialog, the program will check your design. If it is a PCB 
design with components still in the Component Bin, a warning message may be displayed.  

This gives you the option of continuing with plotting, but it does at least warn you about 
potential problems before you produce plots that may be incomplete. 

Drill Drawings 

A drill drawing can be output, this is used to inform the PCB manufacturer of which holes to 
drill at specific sizes. This is important when drill plated and non-plated through holes. . 

Use the Drill ID Setup dialog accessed from the Plotting Options dialog, from the Settings 
tab for a selected Drill Drawing plot and from the Settings menu and Drill Ident to define 
the drill hole ID/Shape relationship. This information is used for the Drill Symbol table used 
in the design and for Drill Ident Drawings used for manufacturing. 

 

When setting up the Plotting dialog for drill drawings, select the Plot Type as Drill Ident 
Drawing and output to the required format. 
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Using Drill Tables in the Design 

You can a drill table of drill sizes & counts in the design itself by selecting the Drill Table 

option from the Add menu. . 

 

The drill table will list all drills required, separating plated and unplated if this is enabled in 
the NC drill options dialog, with a separate section for each layer span. Each entry in the table 
lists tool number, size, count, ID (letter) and the drill-drawing symbol. Boxes and lines are 
used to divide the table into sections. 

 

When using the blind and buried via technology, you can specify a specific layer span for the 
inserted drill table, or set it to show all spans.  

If a drill output is run, or if the Update Drill Tables option is used (from the context menu), 
or if Properties is used on it the table will change to the new style with lines. 

 

The Add Drill Table option on the Add menu in PCB generates the table for the current 
drills, and allows you to place it. The defaults for the text style, line style and layer are 
defined in the Defaults dialog under the Inserted Tables page. 
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You can define the symbols used by editing the Drill ID Setup option on the Settings menu. 

Once added, you can use Properties to change the layer, text style and line style, and add an 
optional ‘footnote’ field that will be added at the end of the table (could be used for example 
to add manufacturing notes like tolerances etc.).  

 

By default, the drill table text, lines and pads are drawn using the normal text, shape and pad 
colour, but you can also highlight all drill tables in a single supplied colour using the colours 
dialog.  
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Power Planes  

The generation of power planes is provided by an automatic mechanism. It is of course true 
by definition that a power plane is dedicated to one signal but it could also be a split plane 
where multiple signals are contained on the same ‘plane’ layer. Within your Layers dialog in 
the Design Technology, you can name plane layers and make the name association. Inclusion 
of a net name in a layer definition automatically defines that layer as a power plane regardless 
of other settings. 

 

There are a number of considerations when using power planes. Tracks from other non-
related signals can be used on a power plane layer, and will generate a clearance round them, 
BUT such clearances can reduce or defeat the effectiveness of a power plane as a low 
impedance high frequency path, so they should be kept to a minimum. You can also add Text 
to a power plane layer for documentation purposes perhaps. 

Power planes are not shown during editing unless the View Power Plane feature has been 
used. Rather they are generated during the plotting process.  

Normal Power Planes 

A ‘normal’ copper power plane (a plane without tracks or text) only requires one file to create 
all the necessary thermal relief and isolation gaps. This would require the Negative (plot only 

gaps) selection to be made within the Power Plane section of the Settings page on the 
Plotting dialog. This would then be processed by the plot house and reversed to produce a 
‘gaps’ only positive plot.  

The negative plot is initially generated as you then only plot the items which will not exist in 
the final plot, this generates a much smaller plot. In most situations up to 10-20 times smaller! 
The file sizes are not a problem in themselves but their transportation on regular media or 
electronic mechanisms may cause a problem, especially if the file is upwards of 10Mb in size. 
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Power Planes with embedded items 

If the plane includes embedded tracks or text, then the rules change and a different 
mechanism is required to process the plot.  

 

There are two mechanisms available depending on how you want to work or your level of 
competence. 

1. Create a ‘composite plot of the final plane with the tracks and text already embedded in 
the plane. This would show all the gaps for the plane isolation of connected nets and 
gaps for tracks and text. 

2. Create two files; a negative plot of the plane with the thermal relief, isolation gaps and 
oversize for tracks plus spacings, and a positive plot of the copper items, the tracks etc. 
These two files are then composite together in a Gerber viewer/editor and the composite 
plotted as a final plot. Usually, this is done by the manufacturer. 

Mechanism 1. Creating a composite plane 

This is the easier of the two methods and is more complete if you have embedded tracks or 
text on your plane layers. However, the file sizes are much larger because the files contain a 
lot more information. 

You would use the Positive (plane & items) selection from within the Plotting dialog and 
Settings page. 

 

Mechanism 2. Outputting two files to create a composite plane from 

Two files are required for one composite power plane with embedded items.  

The first plot is a negative of the required copper, and defines the holes in a continuous 
copper plane (thermal relief, isolation gaps and oversize for tracks plus spacings).  

You would use the Negative (only plot gaps) selection from within the Plotting dialog and 
Settings page. 
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The second is a positive, which defines all copper items (e.g. tracks) appearing inside the 
holes defined by the first file. 

You would use the Positive (only plot items) selection from within the Plotting dialog and 
Settings page. 

 

By reversing the sense of the first, and adding it to the second, the required composite power 
plane is generated complete with embedded items. This process would normally be completed 
by the plot house using the plotters own 'front-end' software to create the require effect. If can 
be done using commercially Gerber preview/editing software but you should really 
understand what you are doing before attempting to create this composite plane. 

A word about settings, the clearance specified as “Isolation Gap” not only describes the 
separation between pads and power plane, but also specifies the width of the thermal relief 
profile round connected pads. The "Thermal Relief” figure specifies the width of the four 
spokes connecting appropriate pads to the power plane. Clearly it will normally be somewhat 
larger than the isolation gap.  

When plotting power planes, ensure that there are no spurious tracks left on the plane layer. 
Run the Dangling Tracks option from the DRC option to check this. 

Plotting Solder Resist Layers 

Solder resist plots are generally a pads only plot which is oversized by a small amount, 
usually 5 thou or thereabouts. This can easily be done using one of two methods.  

Plotting the Solder Resist layer 

The first method is done using the Output menu and the Plotting and Printing option. You 
should generate a Pads only plot of the Top (and Bottom, if required) electrical layers. 

When creating a plot, you must first select the Oversize Pads-Only plot entry using the New 
Job button (then select one of the: Gerber, Pen, Windows buttons). 
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This can be selected as part of a new plot job or added to the plot selection for an existing job. 
Once selected, this will allow you to specify the oversize required by typing in the value. 

When the Plot Type is selected, the layer required for the solder mask will need to be 
selected. Change one of the layers to be selected (usually the Top Electrical). This will be one 
of the electrical layers (Top or Bottom Electrical) which contain pads, or a specifically named 
Solder Resist layer if one has been created. 

 

Because a layer has been selected which contains pads, the Pads-Only (Resist/Mask) Plot 
option is enabled on the Settings dialog. 

 

For a solder Resist plot, the size option Make Pads/Vias is normally set to Larger and the 
value specified. For a solder Paste mask this would be set to smaller and the value to show 
and undersize of the plot. This can be defined as an Absolute value or a Percentage. 

You should select the check boxes for the plot type required. 

Creating a new Solder Resist layer 

The second method is to create a new layer called Solder Mask using the Layers option from 
the Design Technology dialog and to setup this new layer using the Layer Type option.    
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By setting up the layer type to have all pads except Vias available for plotting or display, 
these will be used for the solder resist. The Layer must then be created to have this new 
Layer Type. 

 

By using this method, it enables the pad sizes to be controlled specifically on a one to one 
basis using Pad exceptions. 

From the Design Technology dialog, select the Pad Styles page.  
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Select each of the pad styles in turn which will appear as a different size to that of the default 
pad stack. Select the Add Exception option and select the Layer to change (Ground) and the 
new Width and Length to be used. 

When a Solder Resist layer is now processed in the Printing and Plotting option you do not 
need to oversize the pads. 

Viewing Power planes 

This is used as a visual on-screen representation of the final power plane for full power plane 
layers. This is generated using the same output mechanism used to generate the 
manufacturing plots rather than a simple ‘bitmap’ image. 

 

This option is available from the View menu, there is a menu option Powerplane with three 
sub-menu options – Show, Hide and Regenerate. 
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Show displays a dialog allowing the selection of which power plane to view. If only one 
power plane is present in the design, it will not display this dialog but go straight into the 
display of the power plane.  

 

Hide turns off the visible power plane mode and resumes the ‘normal’ view mode. 

Regenerate, this recalculates the visible power plane items and redraws the picture. 

The full power plane displayed using this option cannot be plotted directly without using the 
plotting modes on the Output menu. 

View Powerplanes using the Layers Bar 

As well as using the View Powerplanes option, you can also access the view of power planes 
using the dockable Layers Bar.  

Powerplane layers are indicated by a small thermal pad icon to the right of the coloured 
square.  

 

If the power plane is being displayed in the design the icon is in negative. Left click on the 
icon to toggle the display to show/hide the power plane. 
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Note, this option is a quick way to access the View Powerplane functionality. View 
Powerplane is still available from the View menu. 

Tented Vias 

What is a Tented Via and why/when should it be used? 

Tenting a via refers to covering via with solder mask to enclose or skin over the opening. A 
via is a hole drilled into the PCB that allows multiple layers on the PCB to be connected to 
each other. A non-tented via is just a via that is not covered with the solder mask layer. 

The role of the PCB solder mask is to protect the via (and copper traces) from damage, 
oxidation, and solder bridging. Tented vias will be more resistant to physical damage and 
electrical shorts by protecting the plating inside the via hole.  

Whether or not you should use tented vias is down to your preference and that of your PCB 
manufacturer. If you contact them, they can advise you. 

Defining Tented Vias 

This is a simple method of specifying whether or not vias are to be ‘tented’. A tented via is 
one that is covered with solder resist during the manufacturing stage. In order for this to 
happen, the via that is to be tented must be identified in the design and a specific output 
generated.  

The ‘tented’ property is defined in the Net Class. When vias in the design use this Net Class, 
the output file generated in the Plotting and Printing dialog can use this flag as a selection 
option. 

 

 

Each Net Class has a property of Tented which can be set to one of three values: 
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 None: vias on this Net Class are automatically not tented so they will appear on plots as 
normal. 

 All: all vias on this Net Class are automatically classified as tented. 

 Individual: the Tented flag is set by you as required. This is set on Via Properties for each 
via 

Via Properties 

When Tented is set to None or All on the Net Class, the tented state of a via is displayed on 
the Via Properties dialog but the check box is greyed out because it is inheriting its setting 
from the Net Class. 

 

When the Tented property is set to Individual, this check box then becomes available for 
setting. 

Tented Vias in the Design 

If this highlight is enabled (checked) in Colours, any via that is tented (either individually on 
Properties or from its Net Class) will be marked with an X (cross) in the same way as we do 
to highlight unconnected pads: 

 

Note, this is the only visual indication of the ‘presence’ of the via shape on a resist layer, the 
rest of the processing is done at the plotting stage. In other words, if you display only your top 
resist layer, vias that are marked as tented will still be drawn. 

Plotting Tented Vias 

In Plotting and Printing, there is a new check box on the Settings tab for each plot that 
allows you to decide whether or not to exclude tented vias from that plot. 
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The default setting for this is unchecked (plots include tented vias) but when auto-generating 
plots it will try to determine which plots are Resist and will thus tick this box for you. This 
setting is also saved in Plot Jobs so it is easy to prepare a preferred set of plots and settings 
and save it for future use. 

Split Power planes 

The creation of split power planes has been covered previously in the section Copper 

Pouring. Although the split planes would appear on what would normally be full power 
planes they are output somewhat different to conventional power planes. They are output as a 
'normal' plot layer but because the net association has been removed from the plane layer to 
allow for the split plane, they are no longer doesn't recognised as a power plane layer. 

 

To output split power planes on internal layers, ensure that the net association in the Layers 
dialog for this layer has been removed to show [None].  

 



264   Output For Manufacture 

This internal layer is then output by selecting the layer name in the Output dialog and treating 
it as a 'normal' positive layer (whereas power planes are normally output as negative layers to 
save plotter file sizes). 

Some checks to make before plotting split power planes. 

• Check that the net name association has been removed from the Layers dialog for this 
internal plane layer. 

• Check that no components have been moved after pouring the plane(s). Check by re-
pouring if necessary. 

• Check that thermal relief and isolation gaps have been added to nets which need to be 
connected to the planes. A visual check in the design using the Highlight Net feature is 
a good start. 

• Check that the splits are in the correct position. 

• Check that the Copper to board spacing is a sensible distance and not too close e.g. 
approx. 75 thou rather than 8 thou (but use your own values based in manufacturing 
requirements). 

Schematics Print/Plot Outputs 

Not strictly a PCB manufacturing output but plotting or printing the Schematic is a vital part 
of the whole process and completion of the design. 

Windows and Pen Plotting 

The Windows and pen plotting dialogs are much simplified to that used in the PCB design 
editor. Obviously, within Schematic there are no Layers to plot or power planes to consider. 
For Schematics, the ability to Plot Terminals and plot Pin Names/Numbers is available for 
extra control over the 'look' of the final plot.  

The Output, Settings and Position pages are the same as in the PCB Editor. 
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Printing Across Multiple Pages 

You can print across multiple pages (with an optional overlap), this is enabled on the Printer 

Setup dialog within the Plotting and Printing option. The Print option will always print 
across multiple pages, if required.  

 

The Overlap value enables you to specify an overlap 
to allow for print quality degradation at the edge of the 
sheets. 

Note: This option is available for both the Schematic 
and PCB design editors. 

 

Print Overlap 



266   Automatic Routers in PCB 

Chapter 10. Automatic Routers in PCB 

Trace-Router 

Automatic Routers Overview 

An autorouter is a set of software routines that automatically determine the routes of inter-
connections on a printed circuit board. Using an autorouter to route even part of your PCB 
will give you a significant saving in time (and hence money!), and by combining the power of 
an autorouter with your experience in PCB layout, the resulting design can beat even the most 
labour-intensive manual layout results in terms of manufacturability, cost and even aesthetics. 

An autorouter takes sets of ‘nodes’ (connection points) and works out physical paths (where 
possible) between those nodes whilst at the same time obeying the design rules needed for 
error-free manufacture. During this task it makes many decisions about what to do when 
tracks cross, directions of track segments on different layers, design rule spacings between 
different kinds of items, and so on.  

Trace-Router Overview 

The Trace-Router is a modern shape-based router optimised to produce low track lengths and 
low via counts as well as a hand-routed looking result. It uses multi-pass algorithms to route 
and resolve tracking errors during its iterative process. By utilising rip up and retry 
technology, it can improve on its own previous pass results without major disruptions to 
existing tracking. The Trace-Router updates the design view as it runs allowing you to see the 
results as they are generated. You can also stop the router at any time, modify tracks yourself, 
and then re-start the router to complete the task. 

The Trace-Router option is run from the Tools menu and Trace Router 
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Routing Passes 

Routing This invokes a number of routing passes which will route either all nets in the design 
or the specified nets, depending on which option started this dialog. You can specify the 
number of passes that you want. The more your design the larger number of passes that you 
will want to give it. If it routes to 100% before the number of specified passes then no more 
passes will be attempted.  

Tracks 

Use Minimum Width means that if a net has a net class defined the router will use the 
minimum track style as opposed to the nominal track style.  

Keep Preroutes means that existing routing is protected against being ripped up by the 
autorouter.  

Keep Fixed means that only routes that are already fixed will be protected against being 
ripped up by the autorouter.  

Fix New means that tracks routed by the autorouter will become fixed and will remain 
unaffected by the autorouter if a subsequent routing pass is made, changing the route 
parameters.  

Routing style allows you to specify the angle of tracks, either 90 degree (orthogonal), or 45 

degree (angled tracks). 

Optimising 

This invokes re-routing passes which attempt to reduce the overall track length and via count 
once the Routing passes are complete. You can specify the number of passes that you want. 
Be aware though, engaging this option can adversely affect the run times of Trace-Router and 
may significantly increase them. 

Fanout 

This invokes a number of passes that routes short escape tracks to vias from SMD pads. This 
is done before the Routing passes. Fanout passes are not necessary in order for the router to 
function, and is more useful as an initial phase before manual routing. You can specify the 
number of passes that you want.  

Any of the above pass options can be disabled by unchecking the appropriate box. You can 
also specify unlimited passes, in which case, the router will continue until the board is 
complete, or until it is cancelled. 

Route By Net Class 

This dialog is used to control the nets which are selected for routing.  
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For each net required for routing or not required for routing, a net class must be specified and 
assigned to the net(s) concerned. Nets which are power or ground, or which have specific 
properties e.g. high speed or memory etc. should be assigned their own net class.  

Load Results – Check this option if you want the display refreshed with the latest results 
after each pass.  

Display Report On Completion - Check this option if you want the Auto Router to produce 
and display a status report when it finishes. 

Costs 

This will invoke the Costs dialog from where you can change the Cost Factors used by the 
Auto Router. You can use this dialog to change the costs involved with Ripping up existing 
tracks and inserting vias. You can also restart the Router at a specified Pass.  

 

Default Costs changes the costs back to their default values.  

 

The Route button will start the Auto Router using the values specified in this dialog. Close 
will exit this dialog without starting the Auto Router but will store any changed values. 

Preparing and Routing Designs 

Before running the router, there are certain rules and guidelines that need to be considered in 
preparing the design for routing. This is especially important if the router is to produce the 
best possible results.  

Design Considerations 

To allow the router to work correctly and produce the best possible results, it is important to 
understand how the various rules and items within the design affect the routing.  

This section details rules and guidelines that need to be considered before routing a design. 
Not all of these are “hard and fast” rules, but a good understanding of how the router uses and 
interprets these rules and the design data will help you to achieve the best possible results 
with Trace-Router. 
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Layers Used 

Trace-Router works on designs with any number of electrical layers, adding tracks on these 
layers and inserting vias to drop from one layer to the other when it needs to. 

In addition to these electrical “signal” layers, the design may also contain any number of 
power (or ground) planes. As well as routing on the signal layers, Trace-Router knows how to 
route power and ground nets to the appropriate power plane layer. 

Layers are added and deleted through the Layers dialog on the Settings menu. 

 

Routing Direction (Bias) 

Under most circumstances (especially when routing surface-mounted components), the 
predominant direction of signal flow on each layer of the board is important. This routing 
flow is controlled by the Bias setting for each layer on the Layers dialog and should be 
defined in consideration of the general connection flow of the design and the required routing 
bias on the given layers. 

 

If you are routing on two layers, you should set the Bias to X on one side and Y on the other. 
The choice of which layer is X and which is Y will depend on the side of the board on which 
your components are placed, the component pad orientation, and other such considerations. 
You may need to experiment with these settings to find out which one gives you the best 
result for the kind of board you are designing. 

When routing on a single layer, there are special considerations to take into account. You can 
use a wire layer to allow the router to add flying wires where it cannot route. 

Bias values 

X or Y 

Tracks should generally run in the X (or Y) direction on the layer. 
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Tracks may be run in the ‘wrong’ direction, but the router treats these tracks as very 
‘expensive’ and will try and restrict them to a minimum to avoid blocking other potential 
routing paths. 

None 
No restriction on the direction of tracks on the layer. The router is free to run tracks in any 
direction as it requires. 

No Tracks 
No tracks will be placed on this layer by the autorouter. If you accidentally set one of the 
outer layers to None, no routing will occur if an SMD component resides on that layer. 

Minimum Tracks 
The router will try and avoid placing tracks on the layer, but may do so if it has to. Tracks on 
this layer are again treated as ‘expensive’. 

Power plane 
The layer is a power or ground plane, to which stub routes may be routed. 

Nets, Net Classes and Styles 

Each connection and track in the design belongs to a net. Each net belongs to a Net Class. 
These are used to specify a pad style to be used for vias, and two track styles to be used for 
routing, these are defined in the Design Technology. 

 

Trace-Router uses the Via pad style for vias that it inserts, and either the Min. Track or the 
Nom. Track style for tracks created during routing. The track style ‘type’ to be used, either 
Min. Track (Minimum) or Nom. Track (Nominal) is controlled by the Minimum Width 
switch on the main routing dialog. 

Net Classes are important for defining different widths required for different 'classes' of 
connections or tracks. For example, the default technology supplied has a net class for Signals 
and one for Power type connections with values of 10/15 thou and 25/40 thou respectively. 
These values allow different track packing and different current carrying capabilities. 

Spacings and Track Sizes 

Trace-Router uses the same spacings as used by the Design Rule Check option. These define 
the gaps required between tracks, pads, vias, and so on. 

It is important to set up the right combination of spacings (gaps) and track sizes if you are to 
maximise the amount of space available for routing. You will find that a little arithmetic can 
improve the routing immensely. For instance, when manually routing, if a track grid of 25 
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thou is used with 15 thou track, and the track-to-track spacing is also 15 thou, then the 
minimum legal pitch between adjacent tracks is 30 thou. This potentially wastes around half 
the possible track positions. If the track-to-track spacing is reduced to 10 thou, this will allow 
twice the available track positions. 

 

Note: Depending on your manufacturing process, some processes, and especially less 

professional ones, may tend to over-etch the copper areas of the board. This means that 

tracks can be eroded during manufacture. It is important therefore to consider how the board 

will be manufactured when choosing the spacings and track sizes, and if need be consult with 

the person making the boards to see what is acceptable to them. 

Board Outline 

The design should contain a board outline to constrain the area for routing. The thickness of 
the board outline line style (as well as the track- or via-to-board spacing) is taken into account 
when deciding how close the router can go to the edge of the board. A typical board outline 
thickness would be 10 thou (provided it isn't being used for profiling or as an inner layer 
copper boundary for power plane clearances). A typical item to board spacing might be in the 
order of 50-75 thou (or even more) depending on the manufacturer. For power plane layers, 
these clearances are certainly near the correct value but again, consult with your board 
manufacturer.  

Trace-Router will not cross the board outline, nor will it cross any routing area. This means 
that if there are areas of the board in which you do not want any tracks, you can add routing 
areas to the design in the required location to keep the router from running tracks into those 
areas. If you don’t want tracks on either side in a given part of the board, you can add a 
routing area on each of the two routing layers. Routing areas are not used for routing into. 

As you might expect, if you don’t have a board outline in your design, the router will simply 
run the tracks out as far as it needs to go in “open space”. There may be instances in which 
this would be useful, perhaps when making prototypes. In this case you may not care how 
large the board should be, so you can let the router do its work and then enclose the resulting 
routing pattern with a board outline once the routing is complete. 

Routing Grids 

The Trace-Router is a gridless autorouter, it does not use any grid to run. It simply uses the 
track thickness, via style and spacing rules defined to make the best possible use of routing 
space available. Correct consideration for the ‘gaps’ available should be made up-front. 

Component Placement 

Placement of components has a significant effect on the routability of any particular design. 
There will usually be some components that have to go in specific positions, such as 
connectors, but you can help the router to achieve better results by taking a little care over 
placement of other components on the board. 
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In general, you should place components so that the density of the unrouted connections (after 
using the Optimise Nets function) is reasonably even. This should allow the router as much 
choice of routing paths as possible. Over-congested or tightly-packed boards are clearly much 
harder to route successfully.  

Although important for most boards, achieving adequate spacing and even distribution of nets 
across the board is vitally important if you are intending to route on a single side only. Single 
layer routing will be much easier if the design has a minimum number of crossing nets and a 
generous border around the edge. 

As well as net density, it also helps routing (as well as build and test later on) if components 
are placed in neat rows and/or columns, on a regular grid. If component pads are ‘off grid’, 
the router will need extra effort to route into or out of these pads. 

You can also help the router (as well as keeping down manufacturing costs and errors) by 
keeping component orientations consistent. For example, all IC’s should be placed in the 
same orientation, as should other ‘like’ groups of components (transistors, diodes, polarised 
capacitors, etc.). 

Where surface mounted devices have been used, and especially when they are used on both 
sides of the board, you should attempt to overlap pads (when they appear on the top and 
bottom sides obviously) so that the router has the maximum amount of 'free space' available. 
Normally, we call free space the area on the design which when viewed is black (assuming 
you have a black background). This is the space which the router can use for tracks and vias 
and should be kept to a maximum if possible. Where devices don't have equal amounts of 
pads, still line up rows of pads with each other, this all helps create free space. 

Net Optimise 

Trace-Router will attempt to route the connection pattern as it is defined in the design when 
routing starts. It is generally good practice to optimise the nets in the design before routing, to 
minimise the overall connection lengths of each net and generally reduce connection density. 

To optimise your connection pattern, select Optimise Nets then All Nets from the Tools 
menu. 

The autorouter will run Optimise after each routing pass (including the final or only pass), to 
optimise any remaining unrouted connections. 

Copper Areas and Text 

Shapes on electrical layers are treated as obstacles and should therefore be avoided. If 
obstacles appear on non-electrical layers they are ignored. Another word of caution for 
copper shapes, if they appear on power plane layers the router will avoid putting vias through 
them, so their use on these layers should be carefully controlled. 

The same applies to Text which appears on electrical layers, the router will avoid it. Text on 
non-electrical layers is ignored. 

Checking the Design before Routing 

Finally, before actually running the autorouter, run the Design Rule Check option from the 
Tools menu. If you run the router before running a Design Rule Check and there are errors 
you will waste valuable routing time and may get an unexpected routing result for the wrong 
reasons! 

Run and correct any design rule errors before running the router. Also check the Spacings set 
to validate that they are relevant to the board and design technology being used. 
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Schematic Designs and the Autorouter 

Schematic designs or the original netlist are not required when autorouting with the Trace-
Router. The PCB design is self-contained and holds all the information required by the router 
to run successfully, a PCB design which follows the basic rules defined in this manual is all 
that is required. 

Interrupting Routing 

At any time during the autorouting, you can interrupt the processing by pressing the Cancel 
button on the progress dialog. 

Another dialog is displayed, allowing you to decide whether or not to keep the routes that 
Trace-Router has already created. 

Press Yes to keep these tracks, or No to return to the connections as they were before this 
routing operation started. Tracks that are in error are always unrouted. 

Resuming Routing 

You can at any time during the design process go back into the routing dialog and use Trace-
Router on the remaining connections. This applies equally well if you have interrupted the 
router to modify some of the tracks that the router has inserted, or if you have routed critical 
nets first (as described below). All you need to remember is to “check” the option to Keep 

Preroutes, and any existing routes will be left alone by the router. 

Free Pads and Component Pads 

Free pads and component pads are treated the same by the router, in that they can be used in 
place of vias when routing tracks on different layers, and they form obstacles to routing when 
they are on a different net to the connection being routed (or not on a net at all). 

Free pads are not removed by Trace-Router. They are treated as a fixed part of the board just 
the same as ‘true’ component pads. 

Routing SMD Components 

There are special considerations which apply when routing designs with surface mount 
components. Some surface mount packages can give a low success rate when routed using a 
single routing pass.  

Consider the example shown below. The track has been routed according to the layer bias, but 
it has blocked connections from being routed up and out of their respective pads as they 
would need to be for these long rectangular pads. 

 

To overcome this problem, you will need to let the router complete its processing, 
interactively move some of the problem tracks, and then use the autorouter to finish off the 
rest.  

Stub Routing To Power Plane Layers 

Where surface mounted pads need to be connected to power planes, Trace-Router can do this 
for you by inserting what are called “stub routes”. These are short track paths ending in vias, 
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allowing the signal from the power plane to be connected up through the via and along the 
track to the pad. 

Before the router can insert stub routes, the power plane layers must be correctly set up (with 
their Bias set to power plane, and with the appropriate Net assigned to the layer). 

 

Trace-Router can then route any connection on that net by inserting a stub route, rather than 
by routing a complete track path between the pads at each of the connection. 

Stub routes are only added to surface mount pads. Through-hole pads on power plane nets are 
of course already connected to the power plane through their pin, so they don’t require stub 
routes with vias. 

The distance between the pad and the via is controlled by the pad-to-via spacing, the larger 
the spacing, the longer the stub track. 

Single Layer Routing 

Single-sided boards are widely used, as they are generally significantly cheaper than double-
sided and multi-layer plated-through boards. The principal areas where single sided boards are 
competitive are low cost products (especially high volume) and some circuits dissipating high 
power. 

However, these benefits don’t come without a cost. The restriction of routing to a single layer 
often means that track paths are a great deal longer (although this may not always be a 
problem), and links are often needed to achieve routing completion. Component placement 
and the resulting connection cross-over and density also becomes much more critical in its 
effect on routing completion rates. 

Component type also has an effect on the routing results. Boards with mostly IC components 
often have much higher connection densities than those with mostly discrete components, and 
it may be unreasonable to expect good completion rates on such boards. 

One of the key factors in achieving good completion rates on single-sided boards is good 
component placement with plenty of free space, especially if you can leave a wide “border” 
around the edge of the board. It is usually better to start with components well spread out, and 
only move them together if you find that the routing result allows you to do this. 

To make the router operate on a single layer it is only necessary to set up the appropriate Bias 
on the electrical layers. The layer on which the tracks are to be routed should be set with a 
Bias value of ‘None’. This allows the router to run tracks in any direction on the routing layer. 
The other electrical layer (if there is one) should be set with a Bias value of ‘No Tracks’, to 
prevent the router from placing tracks on that layer. 

There is a variation on this setup that can be used if you find that there are a few connections 
that simply cannot be routed on the single layer. By setting the bias of the other layer to 
‘Minimum Tracks’, the autorouter can now place tracks on the “non-routing” layer, but will 
try and keep them to a minimum. As with all attempts to perform single layer routing, you 
may find that you need to experiment with the settings to achieve the best result. It may be 
best only to allow this minimal tracking on the “other” side for a final pass with those 
connections which won’t route on the preferred side. 
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Alternatively, you can use a Wire layer and manually add wires to jump gaps in the tracking, 
this is a design process following automatic routing. 

Post-Routing Cleanup 

Depending on the density and complexity of the board, there may be some connections that 
Trace-Router has not routed. This is frequently due to the restrictions on track direction on the 
routing layer(s), or congestion around the start or end pads of the connection. It is often 
possible with a little careful manual editing to clear enough space to allow the router to find a 
suitable routing path for these unrouted connections. 

If there are a lot of unrouted connections in a particular area, this can tend to point towards 
component positioning as the problem. Rather than struggle to route the connections, it is 
often worth moving (or rotating if necessary) some of the components in this area and trying 
the router again. Don’t forget to use Optimise Nets after moving any components, again this 
will help to reduce connection density. You could even consider alternative components to 
make more board space available for routing. You could perhaps use surface mounted 
decoupling capacitors even on a through-hole board (although this will of course affect the 
manufacturing cost).  
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Chapter 11. Library Creation 

Understanding Libraries 

The next few chapters concentrate on getting you started with creating your own libraries. 
After the chapter on designing Components, there is more detail about how to use the Library 
Manager at the end of these chapters. 

Libraries are easy to understand and use once your grasp the basic concepts. The library 
structure is made up of three individual libraries.  There is a Component library made-up of 
elements from the Schematics library and the PCB Symbol (footprint) library.     

Schematic Symbol 

Library 
 PCB Symbol 

Library 

 

 

Component Libraries 

 

Symbols are often 
called ‘gates’. These 
have generic names 
like: NAND, Buffer, 
OPAMP, Res, Cap 

 

 

These have generic 
names like: DIP14, 
SOIC14, QFP44 

 

 

These 
symbols are 
used in the 
Component 
libraries to 
produce 
Components 

 

 

 

 

 

These normally use the 
manufacturer’s proper 
component names like: 

SN7400 

SN74LS10 

SN74HCT4002 

SN74LS258 

CA3450 

Only the names from 

this library is used in 

both Schematic 

design and PCB 

layout. 
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The benefits of separate Schematic Symbols, PCB Symbols and Component 
Libraries 

In electronic design we have Schematic Symbols and we have PCB Symbols (or footprints). 
Commonly, integrated circuits and other components use the same physical footprint, but 
have completely different technical specifications and internal digital or analogue circuitry. 
Take for example, the standard 14-pin DIP footprint: 

 

The 14-pin DIP (Dual Inline Package) is used on 100’s of different components. For 
efficiency, we only want to store the 14-pin DIP PCB Footprint once and then use it 
repeatedly to build different Parts or components that specify a 14-pin DIP footprint. 

By the same token we only want to store a Schematic Symbol once and use it repeatedly in 
various configurations to produce different components. Hence, we have a PCB Symbol 

library to store a 14-pin DIP footprint plus any other footprints and a Schematic Symbol 

library for a 2-Input NAND gate plus any other Schematic symbols. These can then be used 
on their own or be brought together (Schematic Symbol plus PCB Footprint) in many 
different permutations to create a Component Library. You also have multiple component 
libraries to make the categorisation of components clearer, these can be by manufacturer, type 
etc. 

Key Point: It is only the component name taken from the Component library that is used in 

the Schematic Design and PCB layout 

Here’s how we go about creating a simple 7400 component for example, to use in a 
Schematic design and the PCB layout: 

 

4x 2-Input NAND 
gate symbol from the 
Schematic Symbol 

library. 

 

1x 14-pin DIP 
footprint from the 
PCB Symbol library. 

We can create a new 7400 Part by selecting 4x 
2-Input NAND gates from the Schematic 

Symbol library and a 14-pin DIP footprint 
from the PCB symbol library. By combining 
these in the component editor and inserting the 
correct pin mapping as per the data-book 
specification, we produce a SN7400 
Component. This is then stored with a unique 
component name (SN7400 in this example) in 
the Component library ready to use in your 
designs. 
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+  + 

 

= 

SN7400 

Component 

 

This is stored in the 
Component library 
as a SN7400 to be 
used in your 
designs. 

4x gates 
 

1x PCB 
footprint 

 
 

 
 

 

Can I create a Schematic symbol and then select it for use in the Schematic 
design without creating a PCB symbol? 

You can create a new Schematic symbol and store it in the Schematic symbol library. But 
before you can use it in a design you have to create a Component to ‘hold’ the Symbol and 
store this in the Component library for use in your designs. A Schematic only component 
could be used as power and ground symbols for example, or may just be this way for now 
until you decided which footprint to use in the PCB design. The PCB symbol information can 
be added to the component later on in the design process. 

Why is there this added step of creating a Component - why can’t I just use the 
symbol immediately? 

Working this way, any Schematic symbols you produce are stored with an appropriate name 
in the Schematic symbol library. It can then be reused multiple times to create different 
Components using the manufacturer’s component name. Most Components you produce will 
be complete with Schematic symbols and PCB symbol.  

Is this the same for PCB symbols? Can I create a PCB symbol without a 
Schematic symbol? 

This is exactly the same for PCB symbols as with Schematic symbols. Before you can use 
your new PCB symbol in a design you have to produce a component even though this 
component may not have a Schematic symbol associated with it. A PCB-only component 
could be added to the design as a drawing blank or test-pad probe point for example. 

On the following pages is a tutorial that goes through the steps of creating Schematic 
symbols, PCB symbols and a component to tie them together. 

Note: Standards for symbols vary from company to company. The tutorial is presented only 

as a means to understand the process of design and management and how to use the tools 

available. 
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Introduction to Schematic and PCB Symbol Libraries 

Two types of symbol libraries exist as discussed previously, those for Schematic symbols 
with the file extension .ssl, and those for PCB symbols with the file extension .psl. There is no 
limit how many symbols may be kept in a given library. 

Introduction to Component Libraries 

Component libraries can be identified by the extension .cml. Each component in a library is 
aware of the symbol name and library names of its constituent symbols. The components can 
contain several Schematic symbol gates in each component, and a number of PCB footprints, 
each with its own symbol. For example, a component might have 3x NAND gates and a 
power gate for use in the Schematic design, a DIL, and an SMD footprint for use in PCB. 

The diagram below shows how the component will access both the Schematic symbol library 
and the PCB symbol library as required in the relevant design editor. 
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Creating Schematic Symbols 

For this tutorial, you will be guided through a basic symbol example, a 2-Input NAND gate. 
This symbol is already available in the standard library but it gives us chance to use some of 
the shape editing features to create the symbol body. 

 

���� To open the symbol editor  

1. Click the Libraries icon on the File toolbar (the one that looks like a ‘book’), shortcut 
<Ctrl-L>. You can also do this by clicking on the File menu and selecting Libraries. 
For this tutorial, we will use toolbar icons where possible. 

 

2. From the Library Manager dialog select the Schematic Symbols tab. 

 

3. On the Library: drop down list, [All Libraries] will be selected. 

4. The Library Contents list will show Schematic symbols that already exist. 

5. We will create a new symbol and add it to a new library called Demolib. 

6. For now, we will leave the Technology file to the one defined. 
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7. Click the New Lib Button. 

8. In the File Name entry, type demolib and Save. 

 

9. The Library entry will show demolib with no contents. 

 

10. Click the New Item button. 

 

11. The Symbol editor opens. You will see that it looks similar to the Schematic design 
editor. It is pretty similar except it is limited to functionality required to create Schematic 
symbols. 

���� Zoom in to view the grid dots 

1. You will need to zoom in a bit (roll the mouse wheel or click the <Z> key) so you can 
see the Screen Grid displayed. 

2. The grid is set to 50 thou increments (as defined in the selected Technology file). 
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���� Adding the symbol detail 

1. From the Schematic Symbol toolbar (the vertical toolbar on the left side of the screen) 
select Add Shape Rectangle. 

 

2. Choose a starting point on a grid dot, hold down the left mouse button drag a rectangle 
down to create a shape 200.00 x 400.00 thou. 

 

3. The status bar at the bottom of the screen will display the size being drawn as you draw 
it. It will show the Size: value changing dynamically as you edit the shape. 

 

4. The Symbol origin point ‘S’ is at the top left corner of the shape. This is always added 
automatically to the first item when creating a symbol. We will move this later on to a 
more relevant location. 

5. When the shape is the size required, click the mouse button once to release it and press 
the <Esc> key to cancel this option. 

6. The first stage of your Symbol should look like the picture above.  If it isn’t to quite the 
right size you can easily click and drag the shape segments that make up the rectangle 
until it is 200 x 400. 

���� To create an arc  

The shape needs an arc on one side of it. Again, the tools are on-hand to create this easily. 
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1. Right click the mouse on the right hand vertical shape segment (this is a standard 
Windows command and emulates a left mouse click to select then right click to view the 
context menu, and is quicker). 

2. From the context menu choose Arc> and then Angle 180 

 

3. The segment selected now becomes an arc. 
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4. If your arc is the pointing the wrong way, right click on the shape again and choose Arc> 
and then Flip Arc from the context menu. 

 

���� Adding the inverter circle  

We need to add an ‘inverter’ circle to the output pin of the symbol. 

1. From the Schematic Symbol toolbar select Add Shape Circle. 

 

2. In free space, click and drag open the circle to a radius of 25 thou, this will be displayed 
on the status bar. 

3. Release the mouse key to finish the circle. 

4. Click <Esc> to cancel the Add Shape Circle mode. 

5. Select and drag the circle, position it at the end of the arc. 

 

���� Adding more symbol detail 

1. Pan to the right so that you have a bit more space at the sides of the symbol. Use the <P> 
key to pan or use the scroll bars. 
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2. On the Schematic Symbol toolbar, select Add Open Shape or use Add Shape Single 

Line from the Add menu. 

 

3. On a start point 100 thou (2 grid dots) above the bottom left hand corner of the shape, 
drag a line 100 thou long (2 grid dots) to create a horizontal ‘leg’. 

4. Double-click to finish this line. 

5. Add a second line 100 thou (2 grid dots) from the top left corner of the main shape. 

6. Create the line 100 thou long as shown below. Double-click to finish. 

 

7. Click the <Esc> key to cancel. 

8. Now add the third leg to the right side of the symbol. 

9. This shape will be only 50 thou long because of the inverter circle already positioned. 

 

10. At this stage the lines are not recognised as electrical connect points or pins. We are now 
going to insert these as Pins. 

���� Adding pins 

Pins need to be added to the Symbol to give ‘real’ electrical points on which to make 
connections in the design. This gives its unique true electrical connectivity at all times. 

1. On the Schematic Symbol Toolbar, select Add Pad. 
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2. Drag each pin onto the symbol and position it on the end of the lines so that it looks like 
the example below. 

 

3. You will see that these are auto-numbered as you proceed.  After the last pin has been 
added, click the <Esc> key to cancel. 

4. The pins must be numbered sequential overall but the numbering sequence on the 
symbol doesn’t matter, they are there for reference only. 

5. Click the <A> key to position the symbol to fit the window. 

���� Information on the pins 

Each Pin contains three pieces of information: the big cross marks the location of the pin, N1, 

N2, N3 etc. which marks the location of the pin name of the component when used in the 
design, and the pin number position marker (1, 2, 3 etc.). 

 

The pin name N1 will only be fulfilled once the component is used in the Schematic design, 
until then you only see the name position marker. 

You will also see the S character on Pin 1 (if the pin was the first item to be added to the 
Symbol before the Symbol Shape or if you have subsequently moved it). 

The style of the pin can also be changed using the Properties dialog for a selected pin. 
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By default, the pin styles is taken from the Setting menu, Defaults and Pads. Pad styles are 
defined in the Pad Styles dialog under Design Technology. 

The Pin Number is automatically assigned a number. The number is shown in the position it 
will appear in when used in the design. This can be moved in the Symbol editor but cannot be 
moved once placed in the design. 

If you select the N1 and choose Properties from the context menu, the following dialog is 
displayed: 

 

You can change the text alignment that will be used once the symbol is placed in the design, 
you can opt to align it Left, Right or Centre 

Tip: When adding terminals, if you have moved the sequence number and the location or 

alignment of the pad name text, if you wish to use this on subsequent terminals, select it first 

and then press Add Pad. This will take the style of the selected terminal and add the next one 

in exactly the same way. If you don’t select one first, the Remembered Style for Pads is used. 

���� Moving the symbol origin 

The Symbol origin is the symbol’s reference point used when moving it in the Schematic 
design. For consistency we always place this on the pin 1 of the symbol. 

The symbol origin would have been added with the first design item. In our example, this was 
the outline shape but it could have been the first pin added. 

1. Select the origin on the symbol (the small ‘S’ marker). This is currently on the top left 
side of the symbol shape. 

2. If you don’t select it the first time, click the <N> key on the keyboard to Select Next. 
This will pick the next closest item to the one selected. Click <N> until you select the 
symbol origin marker. 
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3. Pick and drag the symbol origin to pin 1 as shown below. 

 

���� Moving the pin name and number positions 

The default position of the pin names and numbers is not what we would like. There is no 
right position, it’s a personal preference to make the drawing more aesthetically pleasing 
when viewed. 

You are still working using a 50 thou grid. This should be changed to a finer grid so that more 
precise name placement can take place. 

���� Changing the snap grid 

1. With nothing selected, in ‘free’ space press the <H> key. 

2. From the context menu select Tenth Grid, this will set the Working Grid step to 5 thou 
(a tenth of the 50 thou grid). 

 

3. Now that the grid step is set, anything you place or move will be on this new grid. 

���� To move the pin names and number positions 

1. Zoom in by rolling the mouse wheel or use the <A> key on the keyboard so more detail 
of the symbol is visible. 

2. Select and drag the pin names, N1 and number, 1, into position as shown below. You 
may wish to position them to your own requirements, doing this has no impact on this 
tutorial but allows you to try it. 
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3. Note the position of the pin name N1. The small plus + sign sits below the centre line of 
the pin. It is the pin name N1 position that represents the actual pin name position in the 
design. 

4. The name and number positions now look like this: 

 

5. One small detail to change before we move on is the alignment of the pin name position 
for pin 3. 

6. Currently, the pin name is aligned to read right to left. For this pin name position to the 
right side of the symbol, ideally it should read left to right. We will change this to 
demonstrate the ease at which it can be done. 

���� Changing the pin name text alignment 

We want to change the alignment on pin 3 from this: 

To this >>        

1. Select the pin name marker N3. 

2. Right click and select Properties. 

3. From the Alignment: list select Right. This will change it from its current position of 
Left. 
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4. Click OK. 

5. The pin name would have moved left on the symbol. 

 

6. Drag it back to be closer to its host pin, pin 3. 

���� Adding the reference origin 

The component Reference Origin is the position that the component name (U1, IC2, R3 etc.) 
resides. Without a Reference Origin, the component name used in the Schematic design will 
automatically be on the Symbol Origin. By adding a specific Reference Origin you can make 
the place Component name in a location of your choosing. 

By default, the libraries have the Reference Origin set to be the bottom right side of the 
Symbol.  

1. From the Add menu, select Reference Origin. 

2. Place the ‘R’ marker on the Symbol. 

 

3. The first time you add a Reference Origin, you should edit its properties so that the 
Reference Name only is displayed when used in the design. 

4. Select the Reference Origin and from the context menu select Properties. 
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5. In order for other information such as Component Name or Values to be displayed, you 
must add Value Positions. This is described below. 

���� Adding additional reference origins to display values 

Value Positions are used principally for positioning the component Values. You can also use 
it for displaying Component Name, Package Name and PCB Symbol Name etc. if required. 

If user defined values are to be used and their position is specific, then the value names should 
be added to the same Technology file that you will use to edit both the Schematic design and 
the Schematic Symbol. 

���� Adding Value Positions 

1. From the Add menu, select Value Position 

2. You must add position markers for each value field that you wish to display on the 
symbol. Value fields for Watt and Value for example would require two Value 
Positions. These Values would have been previously defined in your Technology and 
will be then available for use. 

3. With the value position marker on the end of your cursor, position the first marker where 
required, we’ve positioned our example under the Reference Origin. 

 

4. Notice that the value position name has defaulted to [2InputNAND, this is the design 
name value (a symbol is a design when editing the symbol, hence why it is displayed as 
2Input NAND). This value can be changed. 

5. Select the name value and from the context menu, select Properties. 

6. Select the Value you require. We have selected Tol as our example. Click OK. 
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7. In the symbol, Tol looks like this: 

 

8. Using the same method, we will now add Watt and Value to the symbol. 

 

9. You are now ready to save the symbol into the library. 

���� Saving the symbol 

1. From the File menu, select Save To Library. 

 

2. The Save To Library dialog opens. 
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3. Choose the Discrete library from the list and give the symbol the name 2InputNAND, 
click OK. 

4. The symbol is saved. You can close the symbol editor now using Exit from the File 
menu. 

���� Viewing the symbol in the library 

1. Now that the symbol has been created and saved, let’s view it in the library manager. 

2. Select the Libraries icon on the File toolbar. 

 

3. Select the Schematic Symbols tab if it isn’t already selected. 

4. Check the Preview box. 

5. Select the 2InputNAND symbol from the list of Library Contents: it should look like 
the one below. 

 

6. If you don’t see your symbol in the list, you may have saved it to another library by 
mistake. You can use the Find button on the library manager dialog to locate it. 



294   Library Creation 

Introduction to Library Creation Wizards 

The library creation wizards provide a quick method of creating symbols and components 
using a ‘guided’ system. Complex footprints are especially suited to the wizard as it contains 
parameter fields matched to the manufacturer’s datasheets which when completed, creates a 
footprint as per the specification. 

Wizards are provided for Schematic Symbol creation, PCB Symbol (footprint) creation and 
Component creation. These can all be accessed from each of the library tabs from within the 
Library Manager itself. 

More specific detail on each of the wizards, including how to set them up and use them can be 
found in the online help. 

We will use the footprint wizard to create our tutorial footprint. 

Creating PCB Symbols (Footprints) 

You can create footprint symbols using the footprint wizard or interactively using the editor. 
Once created using either method, you can then use the footprint editor to change the footprint 
detail. 

For this tutorial, we will use the footprint wizard to create the symbol and then discuss some 
of the editor details later on. 

We create this footprint even though it already exists in the supplied library: 

 

Copyright © Acknowledged to Analog Devices Inc. 
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���� To open the symbol editor  

1. Click on the Libraries icon on the File toolbar. 

 

2. From the Library Manager select the PCB Symbols tab. 

 

���� To start the footprint wizard  

1. Click the Wizard button from the Library Manager. 

 

For the purpose of clarity in this tutorial we have changed the colours of the items and the 

background so they contrast better when printed or viewed as a PDF file. If you prefer, you 

can change the colours to be the same using the Colours dialog. 

2. Before we start, you will notice that from the typical manufacturers datasheet shown 
above as our tutorial example, the number ranges supplied are pretty vague. The creation 
of footprints is not an exact science and depends largely on the final manufacturing 
process. 

3. The wizard opens and the Start page is displayed. 
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4. This page indicates the start of the creation process. 

5. Click the Next> button to move forward to the next page. At the bottom of the page, you 
can navigate the dialog page by page backwards and forwards. If you wish to skip pages 
or go back more than one page, use the navigation bar along the left side of the dialog. 

6. The next page allows you to specify a Technology file to be used if required. For this 
tutorial, we will use leave this and create our styles when required. 

 

7. For this example, change Units to Imperial and Thou, and a Precision of 0 

8. Click the Next> button 

9. This page allows you define the type of footprint you wish to create. This sets up 
subsequent pages based on your selection. 

10. Select SOIC as the type.  

11. Click Centre for the symbol origin. We have used Centre for surface mount devices and 
Pin 1 for through-hole device by convention in the supplied libraries. 

12. Click the bottom right radio button for the Component Name position. You will see the 
preview update as you make the changes. 
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13. Click the Next> button 

14. The Pads page is used to define the overall footprint layout. This is one of the most 
important pages of the wizard as it allows you to map the manufacturers’ datasheet 
specification to your footprint. 

15. We need to change quite a few of the parameters in this dialog. 

 

16. Change the Pad Count: to 16. 

17. Change the Pad Style: Shape to Rectangle (this should be the default anyway)  

18. We will be changing the pad style dimensions to you need to edit the Pad Style name to 
be something more meaningful, type Rec 75x24  

19. Under Measurements, type the following for each category: 

e 50 

E 400 

PW Automatically calculated by the wizard 

PL Automatically calculated by the wizard 
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L 50 

T 20 

H 4 

b 16 

 

20. The preview will update each time and will now look like this: 

 

21. Ensure that the Pin 1 position is the bottom left corner, the Pin Numbers are hidden 
and the Pin Numbering is Anti-Clockwise (Counter-Clockwise). 

22. Click the Next> button 

23. The Silkscreen page allows you to say whether you require a silkscreen outline and how 
it will look. 

 

24. You will require one for this tutorial. 

25. The only parameters to edit are the Position Silkscreen Outside the Pads by 10 and 
include a Notch At End with a size of 30. 

26. Click the Next> button 

27. The Placement page allows you to say whether your footprint will have a placement 
outline or not. Placement outlines can be used for assembly purposes or to define the 
maximum bounding box size of the component. 
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28. We will add a placement outline to our example. 

29. From the Layer: drop down, choose Top Assembly. You don’t want the placement 
outline on the silkscreen layer as it will then be plotted on the finished PCB. 

30. In the Position Shape Outside Pads box, type 20 as the value. 

31. Click the Next> button 

32. The Finish page lets you type the footprint name and choose which library to save it 
to. 

 

33. In Footprint Name type 16-Pin SOIC. 

34. Check the Save the footprint to the library box and select the IC.psl library from the 
drop down list. 

35. Click the Finish button to save your footprint and exit the dialog. 

 

���� Viewing the symbol in the library 

1. Once the symbol has been created and saved, let’s view it in the library manager. 

2. Click the Libraries button on the File toolbar. 

 

3. Check the Preview box. 

4. Select the 16-Pin SOIC symbol that you just created, it should look like the one below. 
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Additional Footprint information 

Using the wizard will create you a finished footprint. This footprint can be edited in the 
footprint editor to change features or add additional information. Where footprints required do 
not fall into one of the ‘types’ available in the footprint wizard, you would then use the 
Footprint Editor to interactively create them. Much of the footprint editor is fundamentally the 
same as the editor used to create Schematic symbols previously. 

The short sections below highlight some of the important areas of using the footprint editor. 

���� Information on the pads 

When pads are added in the footprint editor (using Add Pad from the PCB Symbol toolbar), 
each pad has three pieces of information 

• The ‘S‘ character on pad 1 (if the pad was the first item to be added to the new 
symbol) 

• The pad name marker N1 which denotes the location of the pad name once used in 
the Component. The pad name N1 will only be fulfilled once the component is used 
in the PCB design, until then you only see the name position marker. 

• The Pad Number 1. This is the pad number used in the design. This can be moved 
or renamed in the symbol editor but cannot be moved once placed in the design 
when used in a component. 

 

One other vital piece of information for the pad is its layer. The pad will be placed on [All] 
layers by default, indicating that it is a through-hole pad spanning all layers. This can be 
changed to [Top] or [Bottom] to make it surface mounted by selecting the pad and choosing 
Change Layer from the context menu (this is covered later on). 
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���� Adding mounting holes to your symbol 

If your symbol requires additional pads to be added for use as mounting holes (lie on a D-type 
connector for example), you should use the Add Pad option from the PCB Symbol toolbar. 

Although these pads will be sequenced along with the symbol pads, it does make it much 
easier if they exist outside the main pad sequence so they can be ignored. You can have a 
different number of PCB pads to Schematic symbol terminals. The mapping of terminals and 
pads will be covered in the next section on Creating Components. 

���� Changing Pad Styles 

Pad styles are easy to change. 

1. Select the pad. 

2. From the context menu choose Change Style (shortcut key ‘S’). 

3. From the Pad Style dialog, choose the new style required from the list. 

4. You can also create your own style form here and give it a name.  

5. As a tip on changing pad styles, before you add all your pads to the symbol, decide on 
the style you need before you start. 

6. Create the style you require up-front and add it to the Pad Styles dialog. 

7. Add the first pad using the Add Pad option. 

8. Select this pad and use Change Style, change it to the style required. Use Change Layer 
to make it through-hole [All] or surface mounted [Top]. 

9. With the first pad still selected, add another pad. Because the first pad is selected, the 
second pad will pick up this style. 

���� Adding extra shape information 

Shapes can be added to other layers, some for documentation purposes and some to decorate 
the footprint, like silkscreen shapes for example. 

1. Use the Add Shape options from the PCB Symbol toolbar. 

 

2. When adding the shape or editing it afterwards, there are various options on the context 
menu to select from. 

3. You will mostly use Change Style and Change Layer. 

���� Changing layers of items  

1. To change the shape layer, select the shape, or right click while adding it. 

2. From the context menu select Change Layer (shortcut ‘L’). 
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3. From the drop down list, select the layer required. The Old Layer is displayed to show 
you your original reference layer. 

 

Creating Surface Mounted Footprints 

Before moving onto the design of Components, one final consideration needs to be made for 
surface mounted pads of the PCB Symbol. 

The only consideration needs to be for the side that the pads reside on. For normal pads, this 
would be the [All] layer. This means that the pad occupies all of the layers in the design. 
Whereas a surface mounted (SM) pad would only occupy one of the outer layers [Top] or 
[Bottom].   

���� Changing the layer of a pad 

1. During the addition of a pad or once the pad has been added, the layer can be changed. 
You may also find that you need to change the pad style as well. 

2. Select the pad(s) and from the context menu select Change Layer. 

3. From the dialog, select the New Layer from the drop down list. The Old Layer: box 
will display the previous layer used. The example below shows a through-hole pad on 
[All] layers which is to be changed to [Top]. 

 

4. Click OK to make the layer change. 

5. For SM pads you should make the pad side the [Top] layer. Once the footprint is used in 
the design, it can be mirrored to the other side of the board where the pads will also flip 
to the other side as well. 

6. You can also use the Pad Properties dialog to change the pad layer. 
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7. The Layer: drop down list will contain legal layers. 

8. When changing a pad from [All] to [Top] layers, you may also need to change the pad 
style as well. Use the Change Style option or Pad Properties dialog to do this. 

���� Saving the symbol 

1. From the File menu, select Save To Library. 

2. The Save To Library dialog opens. 

 

3. Choose the appropriate library from the drop down list. 

4. In Symbol Name: type the name of the footprint that you wish to use and click OK.  
You have now saved the footprint in the Library.  

Creating Components 

This tutorial uses the Schematic Symbol and PCB Symbol (Footprint) created in the previous 
tutorials, but equally applies to creating a Component using other existing Schematic Symbols 
and PCB Symbols.   

���� To open the Component editor 

1. Click the Libraries icon on the File toolbar.  

 

2. From the Library Manager select the Components tab. 
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3. Click the New Lib button. 

4. In File Name, type in Demolib and click Save.  

5. From the list of libraries available, this will now show Demolib and an empty library. 

6. We need to create a new component so click the New Item button. 

7. The New Component dialog opens.  

 

8. There are 5 main items of information required. 

• Component: is the name of the Component. This is the name used in the Schematic and 
PCB designs to call the relevant Symbols from their respective libraries. 

• Package: this identifies the package type; multiple package types can be used for 
selecting alternative footprints.  

• Default Reference: this is the name stem used in the design, e.g. U, IC. Type U into the 
list box. 

• Schematic Symbol Name. 

• PCB Symbol Name. 

9. For the Component name, type 74AC11000D 

10. For Description: type a suitable name, type 74AC Series 

11. Type SOIC for the Package name 

12. In Default Reference: type U 
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13. For Schematic Symbol, select the library Discrete from the drop down list. 

14. From the Name list, select your Schematic symbol previously created 2InputNAND. 
The number of Pins: will show 3. 

15. For Gates: type in 4. Your component should contain 4x 3-pin gates plus a power gate. 

16. For PCB Symbol, select the library Ic from the drop down list. 

17. Select your PCB symbol Name: previously created 16-Pin SOIC. 

18. Ensure the Pins box shows 16 to verify that your PCB symbol is correct. 

19. Your dialog will be complete and should look like the one below. 

 

20. Once it does, click OK to continue. 

21. The Component Editor shows the items added from the New Component dialog. 
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���� Adding an extra gate 

1. A power gate is required for this component. This is added before allocating pins to the 
device. 

2. Click on the Gates tab at the bottom of the Component Editor page. 

 

3. The power gate should be added to the bottom of this gates list. 

4. Select gate d: in the list so it is highlighted blue. 

5. Press the Add button. 
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6. Using the Discrete library, choose the POWER GATE symbol from the Name: list and 
click Add. Ensure that you only have 1 (Gates) selected in the Add Gates box. 

7. The power gate name will appear at the bottom of the gates list. A preview of the symbol 
can also be seen in the gate symbols window to the right of the dialog. 

 

8. Now what we need to do is add more detail to the component and to ‘map’ the pins 
between the Schematic symbol and the PCB symbol. 

���� Mapping pins to pads 

For a Component to work, it needs to know how the pins used on the Schematic symbols 
relate to the pads used in the PCB symbol and to the component when used in the design. 
These pin assignments are entered into the grid presented. 

There are three methods of assigning pins: 
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• You can directly type the PCB pad numbers for the respective gates 

• You can use the Assign Pins mode that lets you click on the Schematic symbol pin first 
and then the equivalent PCB pad. 

• You can use the Assign Pins 1-1 option to automatically assign all your pins for you. 
This is useful for devices such as BGAs and connectors where the pins are a straight 1-1 
relationship. 

1. For our tutorial, we will use the Assign Pins option. 

2. Click on the Assign Pins button on the Component toolbar or select it from the Edit 
menu. 

 

3. Select Pin 1 on the Schematic symbol. 

4. Note, you can zoom in or out of the symbol preview windows using the shortcut keys 
<Z> and <U>. 

5. Now select Pad 1 on the PCB symbol. 

6. The grid above the symbols will display the pin numbers in the PCB Symbol Pad 
Number cell and the Component Pin Name/Number cell. 

7. The illustration below shows how selecting the output pin of the symbol (pin 3) and the 
pad 2 of the PCB symbol when in Assign Pins mode, will put the pin number 2 into the 
Pad Number and Component Pin cells. 

8. It also shows how this has been completed to number 3. 
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9. Back when you created your symbols, you would have added the pins and they would 
have displayed a pin number. It is this ‘real’ pin number which you now see in the 
component editor. 

10. You can see that the pin number order doesn’t matter because you can map them easily 
in this editor. If they are numbered logically when creating the symbols, it makes life 
easier now for you though. 

 

11. You should complete all pin to pad mapping so that looks like this: 

 

���� The Assign Pins 1-1 option 

When mapping pins, if the pins and pads do not have a 1:1 relationship then you cannot use 
this option. The Assign Pins 1-1 option is particularly useful when there are hundreds of 
pins! 

For example, if we had used this option on our tutorial, the pin mapping would look like this 
below. As you can see, it is not suitable. 

 

If the mapping is not at a 1:1 ratio, you can edit the grid boxes to assign the corresponding 
pins to pads. 



310   Library Creation 

���� Assigning pins manually 

To assign pin manually, you should not be in any ‘mode’.  

You should edit the component grid directly by double-clicking in the PCB Symbol Pad 

Number cell and then typing in the pin number required. This will map the SCH Terminal 

Number in the grey cell to the PCB symbol Pad Number that you just typed in. If you make 
a mistake, double-click again and retype it or press the delete key on the keyboard to clear the 
cell. When editing the grid, the corresponding pins on the symbols will be highlighted to 
guide you. 

���� Assigning pins alphanumeric pin names 

By manually assigning pin numbers, you can also use this method to give the pins 
alphanumeric pin numbers as well. This is useful for devices such as BGAs or Connectors 
which may require this.  

 

As you can se in the above example, you can also mix pin numbers with alpha and numeric, 
and alphanumeric numbers. 

���� Using Apply Increment to Selected Cells to create alphanumeric names 

The Apply Increment to Selected Cells option is available on the context menu on a selected 
cell(s) for Pin Name/Number cells in the Component Editor. This can be used to name one 
cell and create an incremental sequence from it to each subsequently selected cell.  

 

���� To use Apply Increment to Selected Cells 

1. Name the first cell, A1 for example. 

2. Select the first cell and the next 14 cells by dragging the mouse over them. 
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3. Select Apply Increment to Selected Cells option from the context menu. 

 

4. The Name/Number range will now show A1, A2, A3, A4, A5 etc. in the selected cells. 
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���� Using Copy/Paste in the Component Editor 

It is possible also to Copy and Paste data between the Component Editor grid and external 
applications such as Microsoft Excel and vice versa. A single cell or a range of cells can be 
selected for copying or pasting. It is also possible to paste the same value in to a range of 
cells.   

 

Using Copy and Paste To Edit Values 

The values in the Pin Assignments grid can be manipulated using the normal Copy and Paste 
techniques associated with spreadsheet applications such as Microsoft Excel. This includes 
the ability to copy and paste multiple rows and/or columns of data. One possible use would be 
to copy the pin data into an external spreadsheet to take advantage of advanced features such 
as sorting and filtering, then paste the modified data back in to the Part Editor. When pasting 
from an external source it is important to ensure that the data is arranged in the same order as 
the cells in the grid. 

The Copy and Paste commands are available from the context menu. Alternatively, the 
defined shortcut keys, by default <Ctrl-C> and <Ctrl-V> may be used. 

Selecting cells to copy or paste 

A single grid cell or a range of grid rows and/or columns may be selected for copy or pasting. 
Clicking on a single cell will select just that cell. If, rather than clicking, the mouse is dragged 
while the left button is held down a range of cells may be selected, indicated by being shown 
in reverse highlight. This range of cells can now be copied or pasted as a whole.  If a single 
cell has already been selected by clicking, it is possible to extend this into a range of cells by 
clicking with the <shift> key held down. To quickly select an entire column, click in its 
header cell. 



 Library Creation   313 

Pasting Values into the Grid 

When data is pasted into grid the values are subject to the normal constraints of the column 
into which they are being inserted and are checked in the same manner as when values are 
typed in. For example, a value pasted into the Sch Symbol Name column will be checked to 
ensure that it is a valid name of a symbol defined in the library.  

The Gate Name and Sch Symbol Terminal Name columns are read only and as such may 
not have values pasted into them although they may be selected and copied.  

If, when pasting a range of values, a single cell is selected in the grid, the cells affected will 
match the range of the paste values subject to the constraints of the rows and columns 
affected.  

By copying a single value then selecting a range of cells, it is possible to paste the same value 
into multiple cells. All cells in the selected range of cells will be set to the pasted value, 
subject to the column constraints.  

All paste operations may be reversed using the standard Undo facility. 

���� Saving your Component  

1. From the File menu, select Save To Library.  

 

2. The Save To Library dialog opens. 

3. In Component Name: type 74AC11000D and click OK.  You have now saved the 
Component in the Library.  

���� Viewing the Component in the library 

It is always worth checking the component in the Library Manager before saving closing it. 
The Component Library Manager displays details of symbols and also previews this on 
selection of the component in the Contents list. 

1. Select the Libraries icon on the File toolbar. 

 

2. Check the Preview box. 

3. From the Library Contents: list select the 74AC11000D component that you created, it 
should look like the one below: 
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This completes the minimum amount of work required constructing a component for it to be 
successfully used in the Schematic editor and passed through into the PCB layout using the 
Translate To PCB option. 

Adding More Component Detail 

Adding Component Values 

Although your basic Component has been saved it can be enhanced further by the use of 
Values. Values are an important aspect of components. They are the means by which, for 
example, the value, rating, type or tolerance of a component (such as a resistor or capacitor) 
can be stored. These can be displayed in a Schematic or PCB design.  

A further and most important application is that values are the means by which part number 
and value information can be stored for inclusion in Parts lists. It is also the mechanism used 
for passing essential values to the Spice simulator. 

���� Adding Values to your Component 

1. In the Component editor you can add or edit values. Select the Values tab. 

2. Click the Add button to create a new value. 

 

3. From the Add dialog you can enter the Name and Value: 
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4. Click OK to confirm the selection. 

Adding and Removing Packages 

A component can contain more than one Package (footprint). This may well be the case if 
different technologies are to be used, e.g. DIL or SMD, and if SMD, then reflow or IR 
soldering or vapor-phase, all of which could have different pad sizes and hence package 
types. 

You can set the current package type used by the component using Package tab. 

���� Setting the Current packages 

The Packages tab is used to add or remove packages for your component. This is an 
important dialog as it allows you to manage your packages. 

Each package in the component can be selected as being the Default, the one added first to 
the design (you can swap to the alternative packages after the first package has been added). 
This is indicated with a ‘D’ on the Packages dialog. 

The second status it can contain in the component editor is whether it is Current or not. The 
‘Current’ status means that this is the package currently selected for being edited. Different 
values or alternative symbols for example, can be assigned to each package in a component. 
This provides you with a mechanism for being able to select it in the editor. This is indicated 
with a ‘C’ on the Packages dialog. 

 

To define a new package, use the Add option using the Add button. 
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For each Package you add you will need to provide it with a unique Package name. In the 
above example, we have used DIL to define the 16-TSSOP symbol used on our 
74AC11000D component. The preview allows you to make the correct choice. When each 
symbol is selected in the list, it Pin number is displayed, providing you with additional 
confirmation of your choice. 

Clicking the Add button will add it to your component. 

���� Component Properties 

The Component Properties tab is used to hold information about the component, such as the 
display fields for the component in the Schematic and PCB editors. 

 

Component tab 

Through this page, you can edit the component description. You should also provide a 
Default Reference, which is the default text added to the front of the name each instance of 
the component (for example U gives U1, U2, etc.).  
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There are two columns of check boxes which set the default for what names are shown when 
the component is used in a Schematic or PCB design. 

Predefining Terminal Names 

You can predefine a terminal name so that when used in the design editors they will be visible 
and instantly recognisable as to their function or logic. This is usually more applicable to 
symbols in a Schematic design. 

���� To define terminal names 

1. Use the Sch Symbol Terminal Name cell on the grid to edit in the name. 

2. Select the cell using a click and type in the name required. To move down to the next cell 
and to save the previous name, click the down arrow on the keyboard. You can also use 
<Enter> to move down to the cell below. 

3. The name is now displayed in the component grid under Sch Symbol Terminal Name 
and adjacent to the selected terminal number. 

 

Pre-assigning Net Names 

Net Names can be predefined in the component so that when used in the design, the pin 
automatically has a net name assigned to it. As well as ‘normal’ components, this method is 
also extensively used for components such as power and ground symbols. 

���� To define terminal names 

1. Use the Net (Class) Name cell on the grid to edit in the name. 

2. A Net Name typed into this cell will then be used on the terminal pin in the design. 

3. The pin in the Schematic design will be shown as assigned. 
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4. If you wish to assign a pin which can be used for multiple net names or where it can be 
assign using a choice (e.g. Vcc, +5V, +12V), then you can assign this a Net Class name 
in brackets ( ), for example (Power). 

 

5. When the component is used in the design, the Net Name and Net Class are checked. 

 

6. If more than one exists, all the names with that Net Class are displayed in a dialog for 
selection. 

 

7. You choose the net name and click OK. The component is added to the design. 

Mapping One Schematic Symbol Pin to Multiple PCB Pins 

Using the Component editor within the Library Manager, you can map one Schematic symbol 
pin to multiple PCB footprint pins.  
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This is best demonstrated with a real example. The example used here is the Fairchild 
FDC2512 part. The datasheet looks like this: 

 

The internal mapping of the PCB footprint means that pins 1, 2, 5 and 6 are common to the 
one schematic symbol pin. The schematic symbol contains 3 pins overall, the same as the 
PCB footprint. 

In the Library Manager the mapping is done using the PCB Symbol Pad Number column. 
Use a comma character to indicate multiple PCB pin numbers. In the example below, the 
Schematic symbol pin, pin 1, is mapped to PCB footprint pins 1, 2, 5 and 6.  You can also use 
pin name ranges, such as 1-5,7,9, to map 1,2,3,4,5,7,9. 

When this option is used, you must have a letter in the Component Pin Name/Number 
column for these corresponding pins. 

 

 

Pin Mapping and Connections 

There are two formats which can be used for denoting multiple mapped pins; you can use 
commas and the plus (+) sign.  

If a comma is used, the PCB pins will be mapped externally and Optimise will show 
connections to each of these pins, all of the designated pins will be on the same net. 

If a + sign is used, the connections are made internally and connections are not shown to each 
of the pins. However, they will still be connected to the same and with Optimise working in 
the normal way. 

Checking and Verifying Component Pin Assignments 

Visual and report-based verification is available during the assignment of pins in the 
Component Editor. This is more essential when handling large pin devices such as BGAs but 
will also help you with smaller pinned devices. 
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Pins Report  

From within the Component Editor, you can select the Pins Report on the View menu. This 
lists key information about the pin assignment in the current Component. This includes details 
of common pins, multiple mapped pins, and any pins that are not assigned.  

An example report looks like this: 

Component Pins Report 

--------------------- 

 

Report File:        C:\MicroLib\Rabbit (CML - Component Pins Report).txt 

Report Written:     Friday, July 15, 2022 

Design Path:        C:\MicroLib\Rabbit.cml 

Design Title:        

Created:            15-Jul-22 3:28:25 PM 

Last Saved:          

Editing Time:       0 min 

Units:              mm (precision 3) 

 

PCB SYMBOL PIN NAMES APPEARING MORE THAN ONCE 

============================================= 

None 

COMPONENT PIN NAMES APPEARING MORE THAN ONCE 

============================================ 

None 

GATE A 

====== 

Symbol: 101-1006_A 

Pins: 64 

GATE B 

====== 

Symbol: 101-1006_B 

Pins: 64 

End Of Report. 

 

Highlight Creation Issues in Component Editor 

Within the Component Editor, grid cells include small coloured bars at their left edge to 
highlight issues. These will highlight items such as unassigned, multiple mapped, and 
common pins. The bar is shown in the left hand side of the cell to which it represents. 

Below is an example of the unassigned pins using a red ‘bar’: 

 

Below is an example of the multiple mapped pins using a light blue ‘bar’: 
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Below is an example of the multiple mapped pins using a double, purple/blue ‘bar’: 

 

Once the issue has been corrected, the bars are removed dynamically. There is no manual user 
update to make this process is automatic. 

Library Manager Styles Editor 

On the Schematic Symbols and PCB Symbols page of the Library Manager dialog, there is 
a Styles Tool button.  

 

When selected, you are presented with the Manage Library Styles dialog: 

 

Buttons on this dialog allow you to manage different style styles and Layer Line styles. Each 
dialog will display which styles are used and the ability to rename them or merge them with 
other styles. 
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Where a style matches by its value, the style name will be displayed in the Equivalent cell 
next to it.  

In the example above, style name Dimensions, [Errors], [Pin Names], [Pin Numbers], 
[Symbol Names] all use the same width. This is perfectly acceptable if your wish to 
differentiate between different items using the same style value or thickness but where 
common items use different names, you may wish to consolidate them. 

Where style names exist but the name is meaningless, for example, Style1 or 4, you can select 
the style name and press the Rename button. Type in the new name, this might be Pins 
Names for example. To consolidate names, you select the cell of the style name you wish to 
keep. If we wish to keep Normal, and make Line 5 the Normal named style, you would select 
Normal from the list and press the Make Same button. 
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Chapter 12. Managing Libraries 

Managing Libraries 

The Library Manager 

The Library Manager is used to manage your libraries. Other than for backing up libraries 
for security purposes, you must always use the Library Manger for maintenance tasks, tasks 
such as copying and merging libraries. 

Creating Libraries 

From the Library Manager, you can create new libraries by selecting the New Lib dialog and 
providing a name in the dialog. The file extension will be supplied in the current library 
format. The current library selected is displayed in the Library: drop down list. You can use 
this list to swap to another library. 

 

Managing Library Items 

Use the navigation buttons in the centre of each of the dialogs to Add File, Create New Item, 
Edit, Find, Delete, Copy, Move and Rename library items. 

Use the Copy To button to make copies of existing library items into other libraries or to the 
same library but under a different name. Once copied, use the Delete button to remove the 
original library item. This is more secure than providing a Move button as it always retains a 
copy of the original item. 
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Adding and Merging Libraries 

Libraries may be combined using the Add button in the Library Manager dialog, you may 
add one library to another. Besides copying to alternative libraries, this function has an 
important second function; components can have many different package types, each one 
corresponding to an alternative PCB footprint. When components are added together, their 
package types merge. This means that an extra package type for a component can be built and 
tested using a working library, then only added to a main library after checking. 

When two libraries are merged, you are always prompted before a component is changed. 
You should be aware of components (with the same name) using similar symbols from 
different libraries as it is easy to inadvertently associate the wrong symbol definition with a 
component. 

Importing Libraries From Designs 

New libraries can also be created from designs with the importer ignoring any design 
information. This means even if you don’t have the library used to create an old design or a 
design from someone else which requires library modifications, you can still get the library 
back. Each design contains enough library information for which to fully rebuild the 
component library and appropriate symbol library; Schematic design to Schematic symbols 
and PCB design to PCB symbols. 

If using this procedure, you should always rebuild the symbols first, followed by the 
component library data. 

���� To import designs as libraries 

Use the Add button on the Library Manager dialog to import the files as libraries. Simply 
select the design and click Open to start the import. The Library Contents: list will update 
with just the library information; all design information will be ignored. 

Library Databook Tool 

You can produce professional style documentation for your libraries using the Databook 
option. This provides you with template driven automatic generation of datasheets on-the-fly 
to keep up-to-date documentation of your library contents.  

The Databook option is located on File menu. The Databook opens as a separate ‘top level’ 
window, separate from the application window. The shortcut key <F12> toggles back and 
forth between Databook and the main window. 
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The Databook window is divided into two sections; on the left-hand side is a ‘tree’ view of 
the libraries and their contents, whilst the right-hand side is used to display the datasheet for 
the currently selected item.  

The picture below shows a component library selected in the left-hand view, and the names of 
all the items in the library arranged in the right-hand view. 

 

Navigation and management of the Databook items can be done using the toolbar to the left 
side of the window. 

Items found in the Databook can be added to the design using the Item to Design button on 
the Add menu (shortcut <Alt-F8>). 

More detailed information about this feature can be found in the online help by pressing the 
<F1> key. 
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Chapter 13. Libraries 

Standard Supplied Libraries 

The standard library contains a selection of different components from a range of 
manufacturers. Supporting these components are their associated Schematic symbols and 
PCB symbols (footprints). The components cover a broad range to which you can edit or add 
your own components and symbols.  

A word of caution, we strongly recommend that no alterations or additions be made to the 
standard libraries. If you create new libraries of your own, and especially if you modify the 
standard libraries, copy the Component, Footprints and Symbols from the standard library to 
your own library. You can do this on a Component by Component basis or do sets of libraries 
as you require. 

Always ensure you backup your libraries as part of your standard operating routings and 
processes. By retaining the standard libraries as originals, you can always reinstall these if lost 
for some reason. Your own created libraries are more precious of course.  

Errors and Omissions 

We have taken great care in the preparation and checking of our libraries, but it is possible 
that there may be the odd undiscovered error. Please check your work carefully before 
releasing it for production. The inclusion of a device in this library does not imply that it is 
available, that it is suitable for new designs, or that all footprints or packages included are 
available. We cannot accept any responsibility for any loss or damage resulting from the use 
of any of our libraries. 

Please let us know if you do find a problem, or if you have reason to suspect the accuracy of 
any components. 

Using the Standard Library Components 

Please note that components in the standard SCHEMA library are Schematic only, and will 
not translate to PCB. Similarly, components in the PCB library are PCB only, and will give an 
error if an attempt is made to import them into the Schematic editor.  

Although there are no reasons why very large libraries cannot be handled, experience has 
shown that it is more efficient, and easier to manage a number of smaller ones instead. 

Adding Your Own Components 

Any of the supplied symbols may be used in your own components. It is always advisable to 
record the symbols were used where, and, if creating your own symbols, the dimensions used.  
It is also a good idea to use styles with meaningful names when creating symbols, as it makes 
it easier to change them if required in a design and if possible reuse existing styles. 

Library Definitions 

Component Definitions (*.cml) 

Each of the sections below is headed Library: followed by the library name and a general 
description of its contents.  Each of the library names assumes the file extension of .cml  
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PCB library symbols (*.psl) 

These libraries contain the PCB symbols that are used within each of the component libraries.  

Schematic library symbols (*.ssl) 

These libraries contain the Schematic symbols that are used within each of the component 
libraries.  

Associated Parts Libraries (*.apl) 

These libraries contain Associated Parts that can be optionally ‘attached’ to components 
within the component libraries. These items add extra detail to a component and are used 
when the Bill of Materials (BOM) is created.  

3D Packages (*.pkg) 

These libraries contain the 3D packages used in the 3D Viewer option from within the PCB 
design editor.  

Library Finder 

Details of all our standard libraries and their contents can be found on our web site 
www.numberone.com\libfinder.asp  You can also use the Library Finder which will allow 
you to search a database of all the library parts to find the part you require. It will also inform 
you of the appropriate library that the part can be located in.  

SnapEDA Component Browser 

As well as the standard and packaged libraries available, a built-in SnapEDA Component 
Search bar is provided. This allows you to search for Parts from inside Easy-PC and 
download them to the end of cursor in the design for insertion. This item is also saved to your 
libraries at the same time for use later on. Please see the online help for further information. 

Availability 

The SnapEDA Component Search bar is always only available for the current major version 
of the product. 

Component Search Engine Web Site 

You must register to use the SnapEDA Component Search bar using the web site: 

http://www.snapeda.com  

Once registered, you will be able to search and retrieve live components without logging in 
again. The setting is saved inside the option within Easy-PC. 
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